




Advance Praise for Head First C#

“Head First C# is a great book, both for brand new developers and developers like myself  coming from 
a Java background. No assumptions are made as to the reader’s proficiency yet the material builds up 
quickly enough for those who are not complete newbies—a hard balance to strike. This book got me up 
to speed in no time for my first large scale C# development project at work—I highly recommend it.”

— Shalewa Odusanya, Technical Account Manager, Google

“Head First C# is an excellent, simple, and fun way of  learning C#. It’s the best piece for C# beginners 
I’ve ever seen—the samples are clear, the topics are concise and well written. The mini-games that guide 
you through the different programming challenges will definitely stick the knowledge to your brain. A 
great learn-by-doing book!”

— Johnny Halife, Chief  Architect, Mural.ly

“Head First C# is a comprehensive guide to learning C# that reads like a conversation with a friend. The 
many coding challenges keep it fun, even when the concepts are tough.”

— Rebeca Duhn-Krahn, founding partner at Semphore Solutions

“I’ve never read a computer book cover to cover, but this one held my interest from the first page to the 
last. If  you want to learn C# in depth and have fun doing it, this is THE book for you.”

— Andy Parker, fledgling C# programmer

“It’s hard to really learn a programming language without good engaging examples, and this book is full 
of  them! Head First C# will guide beginners of  all sorts to a long and productive relationship with C# 
and the .NET Framework.”

—Chris Burrows, developer for Microsoft’s C# Compiler team

“With Head First C#, Andrew and Jenny have presented an excellent tutorial on learning C#. It is very 
approachable while covering a great amount of  detail in a unique style. If  you’ve been turned off  by 
more conventional books on C#, you’ll love this one.”

—Jay Hilyard, software developer, co-author of  C# 3.0 Cookbook

“I’d reccomend this book to anyone looking for a great introduction into the world of  programming and 
C#. From the first page onwards, the authors walks the reader through some of  the more challenging 
concepts of  C# in a simple, easy-to-follow way. At the end of  some of  the larger projects/labs, the 
reader can look back at their programs and stand in awe of  what they’ve accomplished.”

—David Sterling, developer for Microsoft’s Visual C# Compiler team

“Head First C# is a highly enjoyable tutorial, full of  memorable examples and entertaining exercises. Its 
lively style is sure to captivate readers—from the humorously annotated examples, to the Fireside Chats, 
where the abstract class and interface butt heads in a heated argument! For anyone new to programming, 
there’s no better way to dive in.”

—�Joseph Albahari, C# Design Architect at Egton Medical Information Systems, 
the UK’s largest primary healthcare software supplier,  
co-author of  C# 3.0 in a Nutshell



Praise for other Head First books

“[Head First C#] was an easy book to read and understand. I will recommend this book to any developer 
wanting to jump into the C# waters. I will recommend it to the advanced developer that wants to 
understand better what is happening with their code. [I will recommend it to developers who] want to 
find a better way to explain how C# works to their less-seasoned developer friends.”

—Giuseppe Turitto, C# and ASP.NET developer for Cornwall Consulting Group

“Andrew and Jenny have crafted another stimulating Head First learning experience. Grab a pencil, a 
computer, and enjoy the ride as you engage your left brain, right brain, and funny bone.”

—Bill Mietelski, software engineer

“Going through this Head First C# book was a great experience. I have not come across a book series 
which actually teaches you so well.…This is a book I would definitely recommend to people wanting to 
learn C#”

—Krishna Pala, MCP

“I feel like a thousand pounds of  books have just been lifted off  of  my head.”

—Ward Cunningham, inventor of  the Wiki and founder of  the Hillside Group

“Just the right tone for the geeked-out, casual-cool guru coder in all of  us. The right reference for 
practical development strategies—gets my brain going without having to slog through a bunch of  tired 
stale professor-speak.”

—�Travis Kalanick, Founder of  Scour and Red Swoosh 
Member of  the MIT TR100

“There are books you buy, books you keep, books you keep on your desk, and thanks to O’Reilly and the 
Head First crew, there is the penultimate category, Head First books. They’re the ones that are dog-
eared, mangled, and carried everywhere. Head First SQL is at the top of  my stack. Heck, even the PDF I 
have for review is tattered and torn.”

— �Bill Sawyer, ATG Curriculum Manager, Oracle

“This book’s admirable clarity, humor and substantial doses of  clever make it the sort of  book that helps 
even non-programmers think well about problem-solving.”

— �Cory Doctorow, co-editor of  Boing Boing  
Author, Down and Out in the Magic Kingdom 
and Someone Comes to Town, Someone Leaves Town



Praise for other Head First books

“I received the book yesterday and started to read it…and I couldn’t stop. This is definitely très ‘cool.’ It 
is fun, but they cover a lot of  ground and they are right to the point. I’m really impressed.”

— �Erich Gamma, IBM Distinguished Engineer, and co-author of   
Design Patterns

“One of  the funniest and smartest books on software design I’ve ever read.”

— �Aaron LaBerge, VP Technology, ESPN.com

“What used to be a long trial and error learning process has now been reduced neatly into an engaging 
paperback.”

— �Mike Davidson, CEO, Newsvine, Inc.

“Elegant design is at the core of  every chapter here, each concept conveyed with equal doses of  
pragmatism and wit.”

— �Ken Goldstein, Executive Vice President, Disney Online

“Usually when reading through a book or article on design patterns, I’d have to occasionally stick myself  
in the eye with something just to make sure I was paying attention. Not with this book. Odd as it may 
sound, this book makes learning about design patterns fun. 
 

“While other books on design patterns are saying ‘Bueller… Bueller… Bueller…’ this book is on the float 
belting out ‘Shake it up, baby!’”

— �Eric Wuehler

“I literally love this book. In fact, I kissed this book in front of  my wife.”

— �Satish Kumar
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Build something cool, fast!1 Want to build great apps really fast?� 
With C#, you’ve got a great programming language and a valuable tool at 

your fingertips. With the Visual Studio IDE, you’ll never have to spend hours 

writing obscure code to get a button working again. Even better, you’ll be able to 

build really cool software, rather than remembering which bit of code was for 

the name of a button, and which one was for its label. Sound appealing? Turn 

the page, and let’s get programming.

start building with C#

Why you should learn C#						     2

C# and the Visual Studio IDE make lots of  things easy			   3

What you do in Visual Studio…					     4

What Visual Studio does for you…					     4

Aliens attack!							       8

Only you can help save the Earth					     9

Here’s what you’re going to build					     10

Start with a blank application					     12

Set up the grid for your page					     18

Add controls to your grid						      20

Use properties to change how the controls look			   22

Controls make the game work					     24

You’ve set the stage for the game					     29

What you’ll do next						      30

Add a method that does something					     31

Fill in the code for your method					     32

Finish the method and run your program				    34

Here’s what you’ve done so far					     36

Add timers to manage the gameplay					    38

Make the Start button work					     40

Run the program to see your progress				    41

Add code to make your controls interact with the player			   42

Dragging humans onto enemies ends the game			   44

Your game is now playable					     45

Make your enemies look like aliens					     46

Add a splash screen and a tile					     47

Publish your app						      48

Use the Remote Debugger to sideload your app			   49

Start remote debugging						      50
?!

Uh oh! Aliens 
are beaming up 
humans. Not good!
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Under the hood

You’re a programmer, not just an IDE user.� 
You can get a lot of work done using the IDE. But there’s only so far it 

can take you. Sure, there are a lot of repetitive tasks that you do when 

you build an application. And the IDE is great at doing those things for 

you. But working with the IDE is only the beginning. You can get your 

programs to do so much more—and writing C# code is how you do it. 

Once you get the hang of coding, there’s nothing your programs can’t do.

it’s all just code

2
When you’re doing this…					     54

…the IDE does this					     55

Where programs come from				    56

The IDE helps you code					     58

Anatomy of  a program					     60

Two classes can be in the same namespace			   65

Your programs use variables to work with data			  66

C# uses familiar math symbols				    68

Use the debugger to see your variables change			  69

Loops perform an action over and over			   71

if/else statements make decisions				    72

Build an app from the ground up				    73

Make each button do something				    75

Set up conditions and see if  they’re true			   76

Windows Desktop apps are easy to build			   87

Rebuild your app for Windows Desktop			   88

Your desktop app knows where to start			   92

You can change your program’s entry point			   94

When you change things in the IDE,  
you’re also changing your code				    96

Namespace
Class

Method 1 
statement 
statement

Method 2 
statement 
statement

Every time you make a new program, you define a namespace for it so that its code is separate from the .NET Framework and Windows Store API classes.

A class has one or more methods. Your methods always have to live 
inside a class. And methods are 
made up of statements—like the 
ones you’ve already seen.

A class contains a piece of your  
program (although some very small 
programs can have just one class). 
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3 Making Code Make Sense

Every program you write solves a problem.� 
When you’re building a program, it’s always a good idea to start by thinking about what 

problem your program’s supposed to solve. That’s why objects are really useful. They 

let you structure your code based on the problem it’s solving, so that you can spend your 

time thinking about the problem you need to work on rather than getting bogged down in 

the mechanics of writing code. When you use objects right, you end up with code that’s 

intuitive to write, and easy to read and change.

objects: get oriented!

new Navigator()

new
 Na

vig
ato

r()

new Navigator()

How Mike thinks about his problems			   102

How Mike’s car navigation system thinks about his problems	 103

Mike’s Navigator class has methods to set and modify routes	 104

Use what you’ve learned to build a program that uses a class	 105

Mike gets an idea					     107

Mike can use objects to solve his problem			   108

You use a class to build an object				    109

When you create a new object from a class,  
it’s called an instance of  that class				    110

A better solution…brought to you by objects!			   111

An instance uses fields to keep track of  things			   116

Let’s create some instances!				    117

Thanks for the memory					     118

What’s on your program’s mind				    119

You can use class and method names to make your code intuitive	 120

Give your classes a natural structure				   122

Class diagrams help you organize your classes so they make sense	 124

Build a class to work with some guys				   128

Create a project for your guys				    129

Build a form to interact with the guys			   130

There’s an easier way to initialize objects			   133

Navigator

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()
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4 It’s 10:00. Do you know where your data is?

Data type, database, Lieutenant Commander Data…
it’s all important stuff. �Without data, your programs are useless. You 

need information from your users, and you use that to look up or produce new 

information to give back to them. In fact, almost everything you do in programming 

involves working with data in one way or another. In this chapter, you’ll learn the 

ins and outs of C#’s data types, see how to work with data in your program, and 

even figure out a few dirty secrets about objects (pssst…objects are data, too). 

types and references

The variable’s type determines what kind of  data it can store		  142

A variable is like a data to-go cup					     144

10 pounds of  data in a 5-pound bag					    145

Even when a number is the right size, you can’t just assign it to any variable	 146

When you cast a value that’s too big, C# will adjust it automatically	 147

C# does some casting automatically					    148

When you call a method, the arguments must be compatible  
with the types of  the parameters					     149

Debug the mileage calculator					     153

Combining = with an operator 					     154

Objects use variables, too						      155

Refer to your objects with reference variables				    156

References are like labels for your object				    157

If  there aren’t any more references, your object gets garbage-collected	 158

Multiple references and their side effects				    160

Two references means TWO ways to change an object’s data		  165

A special case: arrays						      166

Arrays can contain a bunch of  reference variables, too			   167

Welcome to Sloppy Joe’s Budget House o’ Discount Sandwiches!		  168

Objects use references to talk to each other				    170

Where no object has gone before					     171

Build a typing game						      176

Controls are objects, just like any other object				    180
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y
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Joe, Bob, and Al love going to the track, but they’re 
tired of losing all their money. They need you to build a 
simulator for them so they can figure out winners before 
they lay their money down. And, if you do a good job, 
they’ll cut you in on their profits.

C# Lab 1
A Day at the Races

The spec: build a racetrack simulator				    188

The Finished Product					     196
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5 Keep your privates… private

Ever wished for a little more privacy?� 
Sometimes your objects feel the same way. Just like you don’t want anybody you 

don’t trust reading your journal or paging through your bank statements, good objects 

don’t let other objects go poking around their fields. In this chapter, you’re going to 

learn about the power of encapsulation. You’ll make your object’s data private, and 

add methods to protect how that data is accessed.

encapsulation

Kathleen is an event planner					     198

What does the estimator do?					     199

You’re going to build a program for Kathleen				    200

Kathleen’s test drive						      206

Each option should be calculated individually				    208

It’s easy to accidentally misuse your objects				    210

Encapsulation means keeping some of  the data in a class private		  211

Use encapsulation to control access to your class’s methods and fields	 212

But is the RealName field REALLY protected?			   213

Private fields and methods can only be accessed from inside the class 	 214

Encapsulation keeps your data pristine				    222

Properties make encapsulation easier				    223

Build an application to test the Farmer class				    224

Use automatic properties to finish the class				    225

What if  we want to change the feed multiplier?			   226

Use a constructor to initialize private fields				    227
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6 Your object’s family tree

Sometimes you DO want to be just like your parents.
Ever run across an object that almost does exactly what you want your object to do? 

Found yourself wishing that if you could just change a few things, that object would 

be perfect? Well, that’s just one reason that inheritance is one of the most powerful 

concepts and techniques in the C# language. Before you’re through with this chapter, 

you’ll learn how to subclass an object to get its behavior, but keep the flexibility to 

make changes to that behavior. You’ll avoid duplicate code, model the real world 

more closely, and end up with code that’s easier to maintain. 

inheritance

Kathleen does birthday parties, too					     238

We need a BirthdayParty class					     239

Build the Party Planner version 2.0					     240

One more thing…can you add a $100 fee for parties over 12?		  247

When your classes use inheritance, you only need to write your code once	 248

Build up your class model by starting general and getting more specific	 249

How would you design a zoo simulator?				    250

Use inheritance to avoid duplicate code in subclasses			   251

Different animals make different noises				    252

Think about how to group the animals				    253

Create the class hierarchy						      254

Every subclass extends its base class					     255

Use a colon to inherit from a base class				    256

We know that inheritance adds the base class fields, properties,  
and methods to the subclass…					     259

A subclass can override methods to change or replace methods it inherited	 260

Any place where you can use a base class,  
you can use one of  its subclasses instead				    261

A subclass can hide methods in the superclass				    268

Use the override and virtual keywords to inherit behavior		  270

A subclass can access its base class using the base keyword		  272

When a base class has a constructor, your subclass needs one, too		  273

Now you’re ready to finish the job for Kathleen!			   274

Build a beehive management system					    279

How you’ll build the beehive management system			   280

Canine

Eat()
Sleep()

Dog

MakeNoise()Wolf

MakeNoise()
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7 Making classes keep their promises

Actions speak louder than words.� 
Sometimes you need to group your objects together based on the things they can 

do rather than the classes they inherit from. That’s where interfaces come in—they 

let you work with any class that can do the job. But with great power comes great 

responsibility, and any class that implements an interface must promise to fulfill all of 

its obligations…or the compiler will break their kneecaps, see?

interfaces and abstract classes

Let’s get back to bee-sics						      294

We can use inheritance to create classes for different types of  bees		  295

An interface tells a class that it must implement  
certain methods and properties					     296

Use the interface keyword to define an interface			   297

Now you can create an instance of  NectarStinger that does both jobs	 298

Classes that implement interfaces have to include  
ALL of  the interface’s methods 					     299

Get a little practice using interfaces					     300

You can’t instantiate an interface, but you can reference an interface	 302

Interface references work just like object references			   303

You can find out if  a class implements a certain interface with “is”		 304

Interfaces can inherit from other interfaces				    305

The RoboBee 4000 can do a worker bee’s job without using valuable honey	 306

A CoffeeMaker is also an Appliance					    308

Upcasting works with both objects and interfaces			   309

Downcasting lets you turn your appliance back into a coffee maker	 310

Upcasting and downcasting work with interfaces, too			   311

There’s more than just public and private				    315

Access modifiers change visibility					     316

Some classes should never be instantiated				    319

An abstract class is like a cross between a class and an interface		  320

Like we said, some classes should never be instantiated			   322

An abstract method doesn’t have a body				    323

The Deadly Diamond of  Death!					     328

Polymorphism means that one object can take many different forms	 331

Location
Name
Exits
Description

Room
decoration: 
private string 
field

Outside
hot: private 
bool field
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8 Storing lots of data

When it rains, it pours.� 
In the real world, you don’t get to handle your data in tiny little bits and pieces. 

No, your data’s going to come at you in loads, piles, and bunches. You’ll need 

some pretty powerful tools to organize all of it, and that’s where collections 

come in. They let you store, sort, and manage all the data that your programs 

need to pore through. That way, you can think about writing programs to work 

with your data, and let the collections worry about keeping track of it for you.

enums and collections

Strings don’t always work for storing categories of  data			   352

Enums let you work with a set of  valid values				    353

Enums let you represent numbers with names				    354

Arrays are hard to work with					     358

Lists make it easy to store collections of…anything			   359

Lists are more flexible than arrays					     360

Lists shrink and grow dynamically					     363

Generics can store any type					     364

Collection initializers are similar to object initializers			   368

Lists are easy, but SORTING can be tricky				    370

IComparable<Duck> helps your list sort its ducks			   371

Use IComparer to tell your List how to sort				    372

Create an instance of  your comparer object				    373

IComparer can do complex comparisons				    374

Overriding a ToString() method lets an object describe itself 		  377

Update your foreach loops to let your Ducks and Cards print themselves	 378

When you write a foreach loop, you’re using IEnumerable<T>		  379

You can upcast an entire list using IEnumerable			   380

You can build your own overloaded methods				    381

Use a dictionary to store keys and values				    387

The dictionary functionality rundown				    388

Build a program that uses a dictionary				    389

And yet MORE collection types…					     401

A queue is FIFO—First In, First Out				    402

A stack is LIFO—Last In, First Out					     403

poof!



table of contents

xix

9 Save the last byte for me!

Sometimes it pays to be a little persistent.� 
So far, all of your programs have been pretty short-lived. They fire up, run for 

a while, and shut down. But that’s not always enough, especially when you’re 

dealing with important information. You need to be able to save your work. In 

this chapter, we’ll look at how to write data to a file, and then how to read that 

information back in from a file. You’ll learn about the .NET stream classes, 

and also take a look at the mysteries of hexadecimal and binary.

reading and writing files

69 117 114 101 107 97 33

.NET uses streams to read and write data				    410

Different streams read and write different things			   411

A FileStream reads and writes bytes to a file				    412

Write text to a file in three simple steps				    413

The Swindler launches another diabolical plan			   414

Reading and writing using two objects				    417

Data can go through more than one stream				    418

Use built-in objects to pop up standard dialog boxes			   421

Dialog boxes are just another WinForms control			   422

Use the built-in File and Directory classes to work with files and directories	 424

Use file dialogs to open and save files (all with just a few lines of  code)	 427

IDisposable makes sure your objects are disposed of  properly		  429

Avoid filesystem errors with using statements				    430

Use a switch statement to choose the right option			   437

Add an overloaded Deck() constructor that reads a deck of  cards  
in from a file							       439

When an object is serialized, all of  the objects it refers to get serialized, too…443

Serialization lets you read or write a whole object graph all at once	 444

.NET uses Unicode to store characters and text			   449

C# can use byte arrays to move data around				    450

Use a BinaryWriter to write binary data				    451

You can read and write serialized files manually, too			   453

Find where the files differ, and use that information to alter them		  454

Working with binary files can be tricky				    455

Use file streams to build a hex dumper				    456

Use Stream.Read() to read bytes from a stream			   458
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C# Lab 2
The Quest

Your job is to build an adventure game where a mighty 
adventurer is on a quest to defeat level after level of 
deadly enemies. You’ll build a turn-based system, which 
means the player makes one move and then the enemies 
make one move. The player can move or attack, and then 
each enemy gets a chance to move and attack. The game 
keeps going until the player either defeats all the enemies 
on all seven levels or dies.

The spec: build an adventure game				    466

The fun’s just beginning!					     486
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The grid is made up of  20-pixel 
squares called units.

Each unit is broken down 
into 5-pixel sub-units

10 Taking your apps to the next level

You’re ready for a whole new world of  app development.� 
Using WinForms to build Windows Desktop apps is a great way to learn important C# 

concepts, but there’s so much more you can do with your programs. In this chapter, 

you’ll use XAML to design your Windows Store apps, you’ll learn how to build pages 

to fit any device, integrate your data into your pages with data binding, and use 

Visual Studio to cut through the mystery of XAML pages by exploring the objects 

created by your XAML code.

designing windows store apps with xaml

Brian’s running Windows 8				    488

Windows Forms use an object graph set up by the IDE		  494

Use the IDE to explore the object graph			   497

Windows Store apps use XAML to create UI objects		  498

Redesign the Go Fish! form as a Windows Store app page	 500

Page layout starts with controls				    502

Rows and columns can resize to match the page size		  504

Use the grid system to lay out app pages			   506

Data binding connects your XAML pages to your classes	 512

XAML controls can contain text...and more			   514

Use data binding to build Sloppy Joe a better menu		  516

Use static resources to declare your objects in XAML		  522

Use a data template to display objects			   524

INotifyPropertyChanged lets bound objects send updates	 526

Modify MenuMaker to notify you when the  
GeneratedDate property changes				    527

ListBox objec
t ObservableCo
lle

ct
io

nBinding
ItemsSource="{Binding}"
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11 Writing files right

xaml, file i/o, and data contract serialization

Nobody likes to be kept waiting...especially not users.� 
Computers are good at doing lots of things at once, so there’s no reason your apps 

shouldn’t be able to as well. In this chapter, you’ll learn how to keep your apps responsive 

by building asynchronous methods. You’ll also learn how to use the built-in file 

pickers and message dialogs and asynchronous file input and output without 

freezing up your apps. Combine this with data contract serialization, and you’ve got the 

makings of a thoroughly modern app.
Brian runs into file trouble						     536

Windows Store apps use await to be more responsive			   538

Use the FileIO class to read and write files				    540

Build a slightly less simple text editor				    542

A data contract is an abstract definition of  your object’s data		  547

Use async methods to find and open files				    548

KnownFolders helps you access high-profile folders			   550

The whole object graph is serialized to XML				    551

Stream some Guy objects to your app’s local folder			   552

Take your Guy Serializer for a test drive				    556

Use a Task to call one async method from another			   557

Build Brian a new Excuse Manager app				    558

Separate the page, excuse, and Excuse Manager			   559

Create the main page for the Excuse Manager				   560

Add the app bar to the main page					     561

Build the ExcuseManager class					     562

Add the code-behind for the page					     564
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12 Putting out fires gets old

exception handling

Programmers aren’t meant to be firefighters.� 
You’ve worked your tail off, waded through technical manuals and a few engaging 

Head First books, and you’ve reached the pinnacle of your profession. But you’re 

still getting panicked phone calls in the middle of the night from work because your 

program crashes, or doesn’t behave like it’s supposed to. Nothing pulls you 

out of the programming groove like having to fix a strange bug...but with exception 

handling, you can write code to deal with problems that come up. Better yet, you 

can even react to those problems, and keep things running.
Brian needs his excuses to be mobile				    570

When your program throws an exception,  
.NET generates an Exception object				    574

Brian’s code did something unexpected				   576

All exception objects inherit from Exception			   578

The debugger helps you track down  
and prevent exceptions in your code				    579

Use the IDE’s debugger to ferret out exactly  
what went wrong in the Excuse Manager	 		  580

Uh oh—the code’s still got problems...	 			   583

Handle exceptions with try and catch	 			   585

What happens when a method you want to call is risky?		  586

Use the debugger to follow the try/catch flow			   588

If  you have code that ALWAYS should run, use a finally block	 590

Use the Exception object to get information about the problem	 595

Use more than one catch block to handle  
multiple types of  exceptions					     596

One class throws an exception that a method  
in another class can catch					     597

An easy way to avoid a lot of  problems:  
using gives you try and finally for free				    601

Exception avoidance: implement IDisposable to do your own cleanup	602

The worst catch block EVER: catch-all plus comments		  604

A few simple ideas for exception handling		  	 606Exception obj
ec

t

 
int[] anArray = {3, 4, 1, 11}; 
int aValue = anArray[15]; 

your class, now with 
exception handlinguser

now your program’s more robust!

public class Data {

  public void   

  Process(Input i) { 

    try { 

     if (i.IsBad()) { 

       explode(); 

    } catch { 

      HandleIt(); 

    } 

     } 

  }

Wow, this program’s really stable!

Uh oh! what 
the heck 

happened?

An object
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13 Your last chance to DO something…your object’s finalizer			   618

When EXACTLY does a finalizer run?					     619

Dispose() works with using; finalizers work with garbage collection			  620

Finalizers can’t depend on stability						      622

Make an object serialize itself  in its Dispose()					     623

A struct looks like an object…						      627

…but isn’t an object							       627

Values get copied; references get assigned					     628

Structs are value types; objects are reference types				    629

The stack vs. the heap: more on memory					     631

Use out parameters to make a method return more than one value			  634

Pass by reference using the ref  modifier					     635

Use optional parameters to set default values					     636

Use nullable types when you need nonexistent values				    637

Nullable types help you make your programs more robust			   638

“Captain” Amazing…not so much						      641

Extension methods add new behavior to EXISTING classes			   642

Extending a fundamental type: string					     644

CAPTAIN AMAZING
THE DEATH 

OF THE OBJECT
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14 Get control of your data

querying data and building apps with LINQ

It’s a data-driven world…it’s good to know how to live in it.� 
Gone are the days when you could program for days, even weeks, without dealing 

with loads of data. Today, everything is about data. And that’s where LINQ comes in. 

LINQ not only lets you query data in a simple, intuitive way, but it lets you group data 

and merge data from different data sources. And once you’ve wrangled your data 

into manageable chunks, your Windows Store apps have controls for navigating 

data that let your users navigate, explore, and even zoom into the details.

Jimmy’s a Captain Amazing super-fan...			   650

…but his collection’s all over the place			   651

LINQ can pull data from multiple sources			   652

.NET collections are already set up for LINQ			   653

LINQ makes queries easy					    654

LINQ is simple, but your queries don’t have to be		  655

Jimmy could use some help				    658

Start building Jimmy an app				    660

Use the new keyword to create anonymous types 		  663

LINQ is versatile					     666

Add the new queries to Jimmy’s app				   668

LINQ can combine your results into groups			   673

Combine Jimmy’s values into groups				   674

Use join to combine two collections into one sequence		  677

Jimmy saved a bunch of  dough				    678

Use semantic zoom to navigate your data			   684

Add semantic zoom to Jimmy’s app				    686

You made Jimmy’s day					     691

The IDE’s Split App template helps you build apps  
for navigating data					     692
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Fan object

Pitcher object

Umpire object

BallEventArgs

~
BallInPlay event

15 What your code does when you’re not looking

events and delegates

Ever wish your objects could think for themselves?		  702

But how does an object KNOW to respond?			   702

When an EVENT occurs…objects listen			   703

One object raises its event, others listen for it…		  704

Then, the other objects handle the event			   705

Connecting the dots					     706

The IDE generates event handlers for you automatically		 710

Generic EventHandlers let you define your own event types	 716

Windows Forms use many different events			   717

One event, multiple handlers				    718

Windows Store apps use events for 
process lifetime management				    720

Add process lifetime management to Jimmy’s comics		  721

XAML controls use routed events				    724

Create an app to explore routed events			   725

Connecting event senders with event listeners			   730

A delegate STANDS IN for an actual method			   731

Delegates in action					     732

An object can subscribe to an event…			   735

Use a callback to control who’s listening			   736

A callback is just a way to use delegates			   738

You can use callbacks with MessageDialog commands		  740

Use delegates to use the Windows settings charm		  742

Your objects are starting to think for themselves.� 
You can’t always control what your objects are doing. Sometimes things…happen. And 

when they do, you want your objects to be smart enough to respond to anything that 

pops up. And that’s what events are all about. One object publishes an event, other 

objects subscribe, and everyone works together to keep things moving. Which is great, 

until you want your object to take control over who can listen. That’s when callbacks will 

come in handy.
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The Head First Basketball Conference needs an app		  746

But can they agree on how to build it?			   747

Do you design for binding or for working with data?		  748

MVVM lets you design for binding and data			   749

Use the MVVM pattern to start building 
the basketball roster app					     750

User controls let you create your own controls			  753

The ref  needs a stopwatch					    761

MVVM means thinking about the state of  the app		  762

Start building the stopwatch app’s Model			   763

Events alert the rest of  the app to state changes		  764

Build the view for a simple stopwatch			   765

Add the stopwatch ViewModel				    766

Converters automatically convert values for binding		  770

Converters can work with many different types		  772

Visual states make controls respond to changes		  778

Use DoubleAnimation to animate double values		  779

Use object animations to animate object values		  780

Build an analog stopwatch using the same ViewModel		  781

UI controls can be instantiated with C# code, too		  786

C# can build “real” animations, too				   788

Create a user control to animate a picture			   789

Make your bees fly around a page				    790

Use ItemsPanelTemplate to bind controls to a Canvas		  793

Congratulations! (But you’re not done yet...)			   806

16 Great apps on the inside and outside

architecting apps with the mvvm pattern

Your apps need to be more than just visually stunning.� 
When you think of design, what comes to mind? An example of great building architecture? 

A beautifully-laid-out page? A product that’s as aesthetically pleasing as it is well 

engineered? Those same principles apply to your apps. In this chapter you’ll learn about 

the Model-View-ViewModel pattern and how you can use it to build well-architected, 

loosely coupled apps. Along the way you’ll learn about animation and control templates 

for your apps’ visual design, how to use converters to make data binding easier, and how 

to pull it all together to lay a solid C# foundation to build any app you want.

VIEW
MODE

L
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C# Lab 3
Invaders

In this lab you’ll pay homage to one of the most popular, 
revered and replicated icons in video game history, a 
game that needs no further introduction. It’s time to 
build Invaders.

The grandfather of  video games				    808

And yet there’s more to do…					     829
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17Build a Windows Phone app

bonus project!

You’re already able to write Windows Phone apps.� 
Classes, objects, XAML, encapsulation, inheritance, polymorphism, LINQ, MVVM…

you’ve got all of the tools you need to build great Windows Store apps and desktop 

apps. But did you know that you can use these same tools to build apps for 

Windows Phone? It’s true! In this bonus project, we’ll walk you through creating a 

game for Windows Phone. And if you don’t have a Windows Phone, don’t worry—

you’ll still be able to use the Windows Phone emulator to play it. Let’s get started!

Bee Attack!					     832

Before you begin...				    833
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i The top 11 things we wanted to include 
in this book

appendix: leftovers

#1. There’s so much more to Windows Store				    846

#2. The Basics							       848

#3. Namespaces and assemblies					     854

#4. Use BackgroundWorker to make your WinForms responsive		  858

#5. The Type class and GetType()					     861

#6. Equality, IEquatable, and Equals()				    862

#7. Using yield return to create enumerable objects			   865

#8. Refactoring							      868

#9. Anonymous types, anonymous methods, and lambda expressions	 870

#10. LINQ to XML						      872

#11. Windows Presentation Foundation				    874

Did you know that C# and the .NET Framework can…			  875

The fun’s just beginning!� 
We’ve shown you a lot of great tools to build some really powerful software with C#. But 

there’s no way that we could include every single tool, technology, or technique in this 

book—there just aren’t enough pages. We had to make some really tough choices about 

what to include and what to leave out. Here are some of the topics that didn’t make the 

cut. But even though we couldn’t get to them, we still think that they’re important and 

useful, and we wanted to give you a small head start with them.
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how to use this book

Intro

I can’t believe 
they put that in a 
C# programming 

book!

In this section, we answer the burning question:  

“So why DID they put that in a C# programming book?”
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how to use this book

1

2

3

Who is this book for?

Who should probably back away from this book?

If  you can answer “yes” to all of  these:

If  you can answer “yes” to any of  these:

this book is for you.

this book is not for you.

[Note from marketing: this book is for anyone with a credit card.]

Do you want to learn C#?

Do you like to tinker—do you learn by doing, rather than 
just reading?

Do you prefer stimulating dinner party conversation 
to dry, dull, academic lectures?

1

2

3

Does the idea of writing a lot of code make you bored 
and a little twitchy?

Are you a kick-butt C++ or Java programmer looking for 
a reference book?

Are you afraid to try something different? Would 
you rather have a root canal than mix stripes with 
plaid? Do you believe that a technical book can’t be 
serious if C# concepts are anthropomorphized?

Do you know another 
programming language, 
and now you need to ramp 
up on C#?

Are you already a good C# 
developer, but you want to 
learn more about XAML, 
Model-View-ViewModel 
(MVVM), or Windows Store 
app development?

Do you want to get 
practice writing lots of 
code?

If so, then lots of people 
just like you have used 
this book to do exactly 
those things!

No programming experience 
is required to use this book...
just curiosity and interest! 
Thousands of beginners with 
no programming experience 
have already used Head First 
C# to learn to code. That 
could be you!
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Great. Only 
700 more dull, 

dry, boring 
pages.

We know what you’re thinking.

And we know what your brain is thinking.

“How can this be a serious C# programming book?”

“What’s with all the graphics?”

“Can I actually learn it this way?”

Your brain craves novelty. It’s always searching, scanning, waiting for 
something unusual. It was built that way, and it helps you stay alive. 

So what does your brain do with all the routine, ordinary, normal things 
you encounter? Everything it can to stop them from interfering with 
the brain’s real job—recording things that matter. It doesn’t bother 
saving the boring things; they never make it past the “this is obviously 
not important” filter.

How does your brain know what’s important? Suppose you’re out for 
a day hike and a tiger jumps in front of  you, what happens inside your 
head and body? 

Neurons fire. Emotions crank up. Chemicals surge. 

And that’s how your brain knows…

This must be important! Don’t forget it!

But imagine you’re at home, or in a library. It’s a safe, warm, tiger‑free zone. 
You’re studying. Getting ready for an exam. Or trying to learn some 
tough technical topic your boss thinks will take a week, ten days at 
the most.

Just one problem. Your brain’s trying to do you a big favor. It’s trying 
to make sure that this obviously non-important content doesn’t clutter 
up scarce resources. Resources that are better spent storing the really 
big things. Like tigers. Like the danger of  fire. Like how you should 
never have posted those “party” photos on your Facebook page.

And there’s no simple way to tell your brain, “Hey brain, thank you 
very much, but no matter how dull this book is, and how little I’m 
registering on the emotional Richter scale right now, I really do want 
you to keep this stuff  around.”

Your brain thinks THIS is important.

Your brain t
hinks 

THIS isn’t worth 
saving.
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how to use this book

We think of a “Head First” reader as a learner.

So what does it take to learn something? First, you have to get it, then make sure 

you don’t forget it.  It’s not about pushing facts into your head. Based on the 

latest research in cognitive science, neurobiology, and educational psychology, 

learning takes a lot more than text on a page. We know what turns your brain on.

Some of the Head First learning principles:

Make it visual. Images are far more memorable than words alone, and 

make learning much more effective (up to 89% improvement in recall and 

transfer studies). It also makes things more understandable.  Put the 

words within or near the graphics they relate to, rather than on 

the bottom or on another page, and learners will be up to twice as likely to 

solve problems related to the content.

Use a conversational and personalized style. In recent studies, 

students performed up to 40% better on post-learning tests if the content spoke 

directly to the reader, using a first-person, conversational style rather than 

taking a formal tone. Tell stories instead of lecturing. Use casual language. 

Don’t take yourself too seriously. Which would you pay more attention to: a 

stimulating dinner party companion, or a lecture?

Get the learner to think more deeply. In other words, unless you 

actively flex your neurons, nothing much happens in your head.  A reader 

has to be motivated, engaged, curious, and inspired to solve problems, draw 

conclusions, and generate new knowledge. And for that, you need challenges, 

exercises, and thought-provoking questions, and activities that involve both 

sides of the brain and multiple senses.

Get—and keep—the reader’s attention. We’ve all had the “I really want to learn this but 

I can’t stay awake past page one” experience. Your brain pays attention to things that are out of 

the ordinary, interesting, strange, eye-catching, unexpected. Learning a new, tough, 

technical topic doesn’t have to be boring. Your brain will learn much more quickly if 

it’s not.

Touch their emotions. We now know that your ability to remember 

something is largely dependent on its emotional content.  You remember what 

you care about.  You remember when you feel something. No, we’re not talking 

heart‑wrenching stories about a boy and his dog. We’re talking emotions like 

surprise, curiosity, fun, “what the…?” , and the feeling of “I Rule!” that comes when 

you solve a puzzle, learn something everybody else thinks is hard, or realize you 

know something that “I’m more technical than thou” Bob from engineering doesn’t.
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If  you really want to learn, and you want to learn more quickly and more deeply, 
pay attention to how you pay attention. Think about how you think. Learn how you 
learn.

Most of  us did not take courses on metacognition or learning theory when we were 
growing up. We were expected to learn, but rarely taught to learn.

But we assume that if  you’re holding this book, you really want to learn how to 
build programs in C#. And you probably don’t want to spend a lot of  time. If  you 
want to use what you read in this book, you need to remember what you read. And 
for that, you’ve got to understand it. To get the most from this book, or any book or 
learning experience, take responsibility for your brain. Your brain on this content. 

The trick is to get your brain to see the new material you’re learning 
as Really Important. Crucial to your well-being. As important as a 
tiger. Otherwise, you’re in for a constant battle, with your brain doing 
its best to keep the new content from sticking.

Metacognition: thinking about thinking

I wonder 
how I can trick 

my brain into 
remembering 
this stuff…

So just how DO you get your brain to treat C# like 
it was a hungry tiger?

There’s the slow, tedious way, or the faster, more effective 
way. The slow way is about sheer repetition. You obviously 
know that you are able to learn and remember even the dullest 
of  topics if  you keep pounding the same thing into your brain. With 
enough repetition, your brain says, “This doesn’t feel important to him, but he 
keeps looking at the same thing over and over and over, so I suppose it must be.”

The faster way is to do anything that increases brain activity, especially different 
types of  brain activity. The things on the previous page are a big part of  the solution, 
and they’re all things that have been proven to help your brain work in your favor. For 
example, studies show that putting words within the pictures they describe (as opposed to 
somewhere else in the page, like a caption or in the body text) causes your brain to try to 
makes sense of  how the words and picture relate, and this causes more neurons to fire. 
More neurons firing = more chances for your brain to get that this is something worth 
paying attention to, and possibly recording.

A conversational style helps because people tend to pay more attention when they 
perceive that they’re in a conversation, since they’re expected to follow along and hold up 
their end. The amazing thing is, your brain doesn’t necessarily care that the “conversation” 
is between you and a book! On the other hand, if  the writing style is formal and dry, your 
brain perceives it the same way you experience being lectured to while sitting in a roomful 
of  passive attendees. No need to stay awake.

But pictures and conversational style are just the beginning.
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Here’s what WE did:
We used pictures, because your brain is tuned for visuals, not text. As far as your 
brain’s concerned, a picture really is worth a thousand words. And when text and 
pictures work together, we embedded the text in the pictures because your brain 
works more effectively when the text is within the thing the text refers to, as opposed 
to in a caption or buried in the text somewhere.

We used redundancy, saying the same thing in different ways and with different media types, 
and multiple senses, to increase the chance that the content gets coded into more than one area 
of  your brain. 

We used concepts and pictures in unexpected ways because your brain is tuned for novelty, 
and we used pictures and ideas with at least some emotional content, because your brain 
is tuned to pay attention to the biochemistry of  emotions. That which causes you to feel 
something is more likely to be remembered, even if  that feeling is nothing more than a little 
humor, surprise, or interest.

We used a personalized, conversational style, because your brain is tuned to pay more 
attention when it believes you’re in a conversation than if  it thinks you’re passively listening 
to a presentation. Your brain does this even when you’re reading.

We included dozens of  activities, because your brain is tuned to learn and remember more 
when you do things than when you read about things. And we made the paper puzzles and 
code exercises challenging-yet-do-able, because that’s what most people prefer.

We used multiple learning styles, because you might prefer step-by-step procedures, 
while someone else wants to understand the big picture first, and someone else just 
wants to see an example. But regardless of  your own learning preference, everyone 
benefits from seeing the same content represented in multiple ways.

We include content for both sides of  your brain, because the more of  your brain you 
engage, the more likely you are to learn and remember, and the longer you can stay focused. 
Since working one side of  the brain often means giving the other side a chance to rest, you 
can be more productive at learning for a longer period of  time. 

And we included stories and exercises that present more than one point of  view, 
because your brain is tuned to learn more deeply when it’s forced to make evaluations and 
judgments. 

We included challenges, with exercises, and by asking questions that don’t always have 
a straight answer, because your brain is tuned to learn and remember when it has to work at 
something. Think about it—you can’t get your body in shape just by watching people at the 
gym. But we did our best to make sure that when you’re working hard, it’s on the right things. 
That you’re not spending one extra dendrite processing a hard-to-understand example, 
or parsing difficult, jargon-laden, or overly terse text.

We used people. In stories, examples, pictures, etc., because, well, because you’re a person. 
And your brain pays more attention to people than it does to things. 

When you define a class, you define 
its methods, just like a blueprint 
defines the layout of the house.

You can use one blueprint to 
make any number of houses, 
and you can use one class to 
make any number of objects.
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So, we did our part. The rest is up to you. These tips are a 
starting point; listen to your brain and figure out what works 
for you and what doesn’t. Try new things.

1

3

4

5 Drink water. Lots of it.

Your brain works best in a nice bath of  fluid. 
Dehydration (which can happen before you ever 
feel thirsty) decreases cognitive function. 

Make this the last thing you read before 
bed. Or at least the last challenging thing.

6

7

9 Write a lot of software!

There’s only one way to learn to program: writing 
a lot of  code. And that’s what you’re going to do 
throughout this book. Coding is a skill, and the only 
way to get good at it is to practice. We’re going to 
give you a lot of  practice: every chapter has exercises 
that pose a problem for you to solve. Don’t just skip 
over them—a lot of  the learning happens when 
you solve the exercises. We included a solution to 
each exercise—don’t be afraid to peek at the 
solution if  you get stuck! (It’s easy to get snagged on 
something small.) But try to solve the problem before 
you look at the solution. And definitely get it working 
before you move on to the next part of  the book.

Listen to your brain.

8 Feel something.

Your brain needs to know that this matters. Get 
involved with the stories. Make up your own 
captions for the photos. Groaning over a bad joke 
is still better than feeling nothing at all.

Pay attention to whether your brain is getting 
overloaded. If  you find yourself  starting to skim 
the surface or forget what you just read, it’s time 
for a break. Once you go past a certain point, you 
won’t learn faster by trying to shove more in, and 
you might even hurt the process.

Talk about it. Out loud.

Speaking activates a different part of  the brain. 
If  you’re trying to understand something, or 
increase your chance of  remembering it later, say 
it out loud. Better still, try to explain it out loud 
to someone else. You’ll learn more quickly, and 
you might uncover ideas you hadn’t known were 
there when you were reading about it.

Part of  the learning (especially the transfer to 
long-term memory) happens after you put the 
book down. Your brain needs time on its own, to 
do more processing. If  you put in something new 
during that processing time, some of  what you 
just learned will be lost. 

Read the “There are No Dumb Questions”

That means all of  them. They’re not optional 
sidebars—they’re part of  the core content! 
Don’t skip them.

Slow down. The more you understand, 
the less you have to memorize.

Don’t just read. Stop and think. When the 
book asks you a question, don’t just skip to the 
answer. Imagine that someone really is asking 
the question. The more deeply you force your 
brain to think, the better chance you have of  
learning and remembering.

Cut this out and stick it on your refrigerator.

Here’s what YOU can do to					        bend 
your brain into submission

2 Do the exercises. Write your own notes.

We put them in, but if  we did them for you, 
that would be like having someone else do 
your workouts for you. And don’t just look at 
the exercises. Use a pencil. There’s plenty of  
evidence that physical activity while learning 
can increase the learning. 
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how to use this book

We wrote this book using Visual Studio Express 2012 for Windows 8 and Visual Studio Express 2012 for 
Windows Desktop. All of  the screenshots that you see throughout the book were taken from those two editions 
of  Visual Studio, so we recommend that you use them. You can also use Visual Studio 2012 Professional, Premium, 
Ultimate or Test Professional editions, but you’ll see some small differences (but nothing that will cause problems with 
the coding exercises throughout the book).

 SETTING UP VISUAL STUDIO 2012 EXPRESS EDITIONS 

¥	 You can download Visual Studio Express 2012 for Windows 8 for free from Microsoft’s website. It installs cleanly alongside 
other editions, as well as previous versions: http://www.microsoft.com/visualstudio/eng/downloads

¥	 Once you’ve got it installed, you’ll need to do the same thing for Visual Studio Express 2012 for Windows Desktop.

What you need for this book:

What to do if you don’t have Windows 8 or can’t run Visual Studio 2012
Many of  the coding exercises in this book require Windows 8. But we definitely understand that some of  our readers 
may not be running it—for example, a lot of  professional programmers have office computers that are running 
operating systems as old as Windows 2003, or only have Visual Studio 2010 installed and cannot upgrade it. If  you’re 
one of  these readers, don’t worry—you can still do almost every exercise in this book. Here’s how:

≥≥ The exercises in chapters 3 through 9 the first two labs do not require Windows 8 at all. You’ll even be able to 
do them using Visual Studio 2010 (and even 2008), although the screenshots may differ a bit from what you see. 

≥≥ For the rest of  the book, you’ll need to build Windows Presentation Foundation (WPF) desktop 
apps instead of  Windows 8 apps. We’ve put together a PDF that you can download from the Head First Labs 
website (http://headfirstlabs.com/hfcsharp) to help you out with this. Flip to leftover #11 in the appendix to learn more.

Click the “Install 
Now” link to launch 
the web installer, 
which automatically 
downloads and 
installs Visual Studio. 

You’ll also need to 
generate a product key, 
which is free for the 
Express editions (but 
requires you to create a 
Microsoft.com account).

The screenshots in this book match Visual Studio 
2012 Express Edition, the latest free version 

available at the time of  this printing. We’ll keep future 
printings up to date, but Microsoft typically makes 

older versions available for download.
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Read me
This is a learning experience, not a reference book. We deliberately stripped out 
everything that might get in the way of  learning whatever it is we’re working on at 
that point in the book. And the first time through, you need to begin at the beginning, 
because the book makes assumptions about what you’ve already seen and learned.

The activities are NOT optional. 

The puzzles and activities are not add-ons; they’re part of  the core content of  the book. 
Some of  them are to help with memory, some for understanding, and some to help you 
apply what you’ve learned. Don’t skip the written problems. The pool puzzles are 
the only things you don’t have to do, but they’re good for giving your brain a chance to 
think about twisty little logic puzzles.

The redundancy is intentional and important. 

One distinct difference in a Head First book is that we want you to really get it. And we 
want you to finish the book remembering what you’ve learned. Most reference books 
don’t have retention and recall as a goal, but this book is about learning, so you’ll see 
some of  the same concepts come up more than once. 

Do all the exercises!

The one big assumption that we made when we wrote this book is that you want to 
learn how to program in C#. So we know you want to get your hands dirty right away, 
and dig right into the code. We gave you a lot of  opportunities to sharpen your skills 
by putting exercises in every chapter. We’ve labeled some of  them “Do this!”—when 
you see that, it means that we’ll walk you through all of  the steps to solve a particular 
problem. But when you see the Exercise logo with the running shoes, then we’ve left 
a big portion of  the problem up to you to solve, and we gave you the solution that we 
came up with. Don’t be afraid to peek at the solution—it’s not cheating! But you’ll 
learn the most if  you try to solve the problem first.

We’ve also placed all the exercise solutions’ source code on the web so you can download 
it. You’ll find it at http://www.headfirstlabs.com/books/hfcsharp/

The “Brain Power” questions don’t have answers.

For some of  them, there is no right answer, and for others, part of  the learning 
experience of  the Brain Power activities is for you to decide if  and when your answers 
are right.  In some of  the Brain Power questions you will find hints to point you in the 
right direction.

We use a lot of diagrams to 
make tough concepts easier 
to understand.

You should do ALL of the 
“Sharpen your pencil” activities

Activities marked with the Exercise (running shoe) logo are really important! Don’t skip them if you’re serious about learning C#.

If you see the Pool Puzzle logo, 
the activity is optional, and if 
you don’t like twisty logic, you 
won’t like these either.

  mi5Agent

  ciaAgent


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The technical review team

the review team

Lisa Kellner

Technical Reviewers:

The book you’re reading has very few errors in it, and give a lot of  credit for its high quality to some great technical 
reviewers. We’re really grateful for the work that they did for this book—we would have gone to press with errors 
(including one or two big ones) had it not been for the most kick-ass review team EVER.…

First of  all, we really want to thank Lisa Kellner—this is our ninth (!) book that she’s reviewed for us, and she made a 
huge difference in the readability of  the final product. Thanks, Lisa! And special thanks to Chris Burrows, Rebeca 
Dunn-Krahn, and David Sterling for their enormous amount of  technical guidance, and to Joe Albahari and Jon 
Skeet for their really careful and thoughtful review of  the first edition, and Nick Paladino who did the same for the 
second edition.

Chris Burrows is a developer at Microsoft on the C# Compiler team who focused on design and implementation of  
language features in C# 4.0, most notably dynamic.

Rebeca Dunn-Krahn is a founding partner at Semaphore Solutions, a custom software shop in Victoria, Canada, 
that specializes in .NET applications. She lives in Victoria with her husband Tobias, her children, Sophia and Sebastian, 
a cat, and three chickens.

David Sterling has worked on the Visual C# Compiler team for nearly three years.

Johnny Halife is a Chief  Architect & Co-Founder of  Mural.ly (http://murally.com), a web start-up that allows people 
to create murals: collecting any content inside them and organizing it in a flexible and organic way in one big space. 
Johnny’s a specialist on cloud and high-scalability solutions. He’s also a passionate runner and sports fan.

Not pictured (but just 
as awesome are the 
reviewers from previous 
editions): Joe Albahari, 
Jay Hilyard, Aayam 
Singh, Theodore, Peter 
Ritchie, Bill Meitelski 
Andy Parker, Wayne 
Bradney, Dave Murdoch, 
Bridgette Julie 
Landers, Nick Paldino, 
David Sterling. Special 
thanks to reader Alan 
Ouellette and our other 
readers who let us 
know about issues that 
slipped through QC for 
the first and second 
editions.

David SterlingJohnny Halife

Chris Burrows

Rebeca Dunn-Krahn
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Safari Books Online is an on-demand digital library that lets you easily search over 7,500 
technology and creative reference books and videos to find the answers you need quickly.

With a subscription, you can read any page and watch any video from our library online. Read books on your cell 
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I’m ready for a 
wild ride!

start building with c#1

Build something cool, fast!

Want to build great apps really fast?� 
With C#, you’ve got a great programming language and a valuable tool at 

your fingertips. With the Visual Studio IDE, you’ll never have to spend hours 

writing obscure code to get a button working again. Even better, you’ll be able 

to build really cool software, rather than remembering which bit of code was 

for the name of a button, and which one was for its label. Sound appealing? 

Turn the page, and let’s get programming.



2    Chapter 1

Why you should learn C#
C# and the Visual Studio IDE make it easy for you to get to the business 
of  writing code, and writing it fast. When you’re working with C#, the 
IDE is your best friend and constant companion.

c# makes it easy

What you get with Visual Studio and C#…
With a language like C#, tuned for Windows 
programming, and the Visual Studio IDE, you can focus 
on what your program is supposed to do immediately:

Here’s what the IDE automates for you…
Every time you want to get started writing a program, or 
just putting a button on a page, your program needs a 
whole bunch of  repetitive code.

using System;
 

using System.
Collections.G

eneric; 

using System.
Windows.Forms

;

namespace A_N
ew_Program

{
    static cl

ass Program

    {
        /// <

summary> 

        /// T
he main entry

 point for th
e application

. 

        /// <
/summary> 

        [STAT
hread] 

        stati
c void Main()

        {
            A

pplication.En
ableVisualSty

les();

            A
pplication.Se

tCompatibleTe
xtRenderingDe

fault(false);

            A
pplication.Ru

n(new Form1()
);

        }
    }
}

private void InitializeComponent(){
  this.button1 = new System.Windows.Forms.Button();
  this.SuspendLayout();  // 
  // button1
  // 
  this.button1.Location = new System.Drawing.Point(105, 56);
  this.button1.Name = "button1";  this.button1.Size = new System.Drawing.Size(75, 23);
  this.button1.TabIndex = 0;  this.button1.Text = "button1";  this.button1.UseVisualStyleBackColor = true;
  this.button1.Click += new System.EventHandler(this.button1_Click);

  // 
  // Form1
  // 
  this.AutoScaleDimensions = new System.Drawing.SizeF(8F, 16F);

  this.AutoScaleMode = System.Windows.Forms.AutoScaleMode.Font;

  this.ClientSize = new System.Drawing.Size(292, 267);
  this.Controls.Add(this.button1);  this.Name = "Form1";  this.Text = "Form1";  this.ResumeLayout(false);}

It takes all this code just to draw a button in a window. Adding a bunch of visual elements to a page could take 10 times as much code.

Data access

C#, the .NET Framework, 

and the Visual Studio IDE 
have prebuilt structures 
that handle the tedious 
code that’s part of most 
programming tasks.

.NET Framework 
solutions

The result is a better-looking app that takes less time to write.

Visual obje
ct

s

The IDE—or Visual Studio Integrated 
Development Environment—is an 
important part of working in C#. It’s a 
program that helps you edit your code, 
manage your files, and submit your apps 
to the Windows Store.
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 Build an application, FAST. Creating programs in C# is a snap. The 
language is flexible and easy to learn, and the Visual Studio IDE does a lot of  
work for you automatically. You can leave mundane coding tasks to the IDE 
and focus on what your code should accomplish.

1

 Build visually stunning programs. When you combine C# with 
XAML, the visual markup language for designing user interfaces, you’re 
using one of  the most effective tools around for creating visual programs... 
and you’ll use it to build software that looks as great as it acts. 

3

 Design a great-looking user interface. The Visual Designer in the 
Visual Studio IDE  is one of  the easiest-to-use design tools out there. It 
does so much for you that you’ll find that creating user interfaces for your 
programs is one of  the most satisfying parts of  developing a C# application. 
You can build full-featured professional programs without having to spend 
hours writing a graphical user interface entirely from scratch.

2

 Focus on solving your REAL problems. The IDE does a lot for you, but you 
are still in control of  what you build with C#. The IDE lets you just focus on your 
program, your work (or fun!), and your users. It handles all the grunt work for you:

≥≥ Keeping track of  all your projects

≥≥ Making it easy to edit your project’s code

≥≥ Keeping track of  your project’s graphics, audio, icons, and other resources

≥≥ Helping you manage and interact with your data

All this means you’ll have all the time you would’ve spent doing this routine 
programming to put into building and sharing killer apps.

4

When you use C# and Visual Studio, you get all of  
these great features, without having to do any extra 
work. Together, they let you:

You’re going to see exactly 
what we mean next.

C# and the Visual Studio IDE make 
lots of things easy

apps

you are here 4
3

5
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let’s get started

App.xaml.csMainPage.xaml

This file contains the C# code that’s run when the app is launched or resumed.

This file contains the XAML 
code that defines the user 
interface of the main page.

What you do in Visual Studio…
Go ahead and start up Visual Studio for Windows 8, if  you haven’t already. Skip over the start page and select New 
Project from the File menu. There are several project types to choose from. Expand Visual C# and Windows 
Store, and select Blank App (XAML). The IDE will create a folder called Visual Studio 2012 in your Documents folder, 
and put your applications in a Projects folder under it (you can use the Location box to change this).

MainPage.Xaml.cs

The C# code that 
controls the main 
page’s behavior 
lives here.

What Visual Studio does for you…
As soon as you save the project, the IDE creates a bunch of  files, including  
MainPage.xaml, MainPage.Xaml.cs, and App.xaml.cs, when you create a new 
project. It adds these to the Solution Explorer window, and by default, puts 
those files in the Projects\App1\App1 folder.

Visual Studio creates all three of 
these files automatically. It creates 
several other files as well! You can see 
them in the Solution Explorer window.

	        Things may 
look a bit 
different in 
your IDE.

This is what the New 
Project window looks 
like in Visual Studio for 
Windows 8 Express 
Edition. If you’re using 
the Professional or Team 
Foundation edition, it 
might be a bit different. But 
don’t worry, everything still 
works exactly the same.

Make sure that you save your project 
as soon as you create it by selecting 
Save All from the File menu—that’ll 
save all of the project files out to 
the folder. If you select Save, it just 
saves the one you’re working on.

If you don’t see this option, you might be running 
Visual Studio 2012 for Windows Desktop. You’ll 
need to exit that IDE and launch Visual Studio 
Express 2012 for Windows 8.
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v Just a couple more steps and your screen will match the picture below. First, make sure you open 
the Toolbox and Error List windows by choosing them from the View menu. Next, select the Light 
color theme from the Options menu.  You should be able to figure out the purpose of many of 
these windows and files based on what you already know. Then, in each of the blanks, try to fill in 
an annotation saying what that part of the IDE does. We’ve done one to get you started. See if you 
can guess what all of these things are for.

This toolbar has buttons that 
apply to what 
you’re currently doing in the IDE.

We’ve blown up this 
window below so you 
have more room.

If you don’t see the Error List or 
Toolbox, choose them from the View menu.

We switched to the Light color 
theme because it’s easier 
to see light screenshots in 
a book. If  you like it, pick 

“Options...” from the Tools 
menu, expand Environment, 

and click on General to change 
it (feel free to change back).

The designer lets you edit 
the user interface by 
dragging controls onto it.

The screenshot on page 4 is 
in the Dark color theme.
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v

If you don’t see the Error List or 
Toolbox, choose them from the View menu.

We’ve filled in the annotations about the different sections of the Visual 
Studio C# IDE. You may have some different things written down, but you 
should have been able to figure out the basics of what each window and 
section of the IDE is used for.

This toolbar has buttons that apply to what you’re currently doing in the IDE.

know your ide

This window 
shows properties 
of whatever is 
currently selected 
in your designer.

This is the 
toolbox. It 
has a bunch of 
visual controls 
that you can 
drag onto your 
page.

This Error List window shows 

you when there are errors in 

your code. This pane will show 

lots of diagnostic info about 

your app.

The XAML and C# files that the IDE created for you when you added the new project appear in the Solution Explorer, along with any other files in your solution.

You can switch between files using the Solution Explorer in the IDE.

See this little 
pushpin icon? 
If you click it, 
you can turn 
auto-hide on or 
off. The Toolbox 
window has 
auto-hide turned 
on by default.

The designer lets you edit 
the user interface by 
dragging controls onto it.

Solution
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Q: So if the IDE writes all this code 
for me, is learning C# just a matter of 
learning how to use the IDE?

A: No. The IDE is great at automatically 
generating some code for you, but it can 
only do so much. There are some things it’s 
really good at, like setting up good starting 
points for you, and automatically changing 
properties of controls on your forms. But 
the hard part of programming—figuring out 
what your program needs to do and making 
it do it—is something that no IDE can do 
for you. Even though the Visual Studio IDE 
is one of the most advanced development 
environments out there, it can only go so far. 
It’s you—not the IDE—who writes the code 
that actually does the work.

Q: What if the IDE creates code I don’t 
want in my project?

A: You can change it. The IDE is set up to 
create code based on the way the element 
you dragged or added is most commonly 
used. But sometimes that’s not exactly what 
you wanted. Everything the IDE does for 
you—every line of code it creates, every file 
it adds—can be changed, either manually by 
editing the files directly or through an easy-
to-use interface in the IDE.

Q: Is it OK that I downloaded and 
installed Visual Studio Express? Or do 
I need to use one of the versions of 
Visual Studio that isn’t free in order to do 
everything in this book?

A: There’s nothing in this book that you 
can’t do with the free version of Visual Studio 
(which you can download from Microsoft’s 
website). The main differences between 
Express and the other editions aren’t going 
to get in the way of writing C# and creating 
fully functional, complete applications. 

Q: You said something about 
combining C# and XAML. What is XAML, 
and how does it combine with C#?

A: XAML (the X is pronounced like Z, and 
it rhymes with “camel”) is a markup language 
that you’ll use to build your user interfaces for 
your full-page Windows Store apps. XAML is 
based on XML (which you’ll also learn about 
later in the book), so if you’ve ever worked 
with HTML you have a head start. Here’s an 
example of a XAML tag to draw a gray ellipse: 
 
<Ellipse Fill="Gray" 
Height="100" Width="75" 
/> 
 
You can tell that that’s a tag because it starts 
with a < followed by a word (“Ellipse”), 
which makes it a start tag. This particular 
Ellipse tag has three properties: one to 
set its fill color to gray, and two to set its height 
and width. This tag ends with />, but some 
XAML tags can contain other tags. We can 
turn this tag into a container tag by replacing 
/> with a >, adding other tags (which can 
also contain additional tags), and closing it 
with an end tag that looks like this:  
</Ellipse>. You’ll learn a lot more 
about how XAML works and the different XAML 
tags throughout the book.

Q: I’m looking at the IDE right now, 
but my screen doesn’t look like yours! It’s 
missing some of the windows, and others 
are in the wrong place. What gives?

A: If you click on the Reset Window 
Layout command under the Window menu, 
the IDE will restore the default window layout 
for you. Then you can use the View→Other 
Windows menu to make your screen look 
just like the ones in this chapter.

Visual Studio will 
generate code 
you can use as a 
starting point for 
your applications.

Making sure the 
app does what 
it’s supposed to 
do is entirely up 
to you.
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Well, there’s a surprise: vicious aliens have launched a full-scale attack 
on planet Earth, abducting humans for their nefarious and unspeakable 
gastronomical experiments. Didn’t see that coming!

Aliens attack!

if only humans weren’t so delicous

Uh oh! Aliens 
are beaming up 
humans. Not good!

Mmm, 
tasty humans!

?!
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Only you can help save the Earth
The last hopes of  humanity rest on your shoulders! The 
people of  planet Earth need you to build an awesome C# 
app to coordinate their escape from the alien menace. Are 
you up to the challenge?

Drag the human into the 
target before the timer at the 
bottom of the page runs out.

More and more evil aliens 
will fill up the screen. If 
you drag your human into 
one, “Game over, man!”

Don’t drag 
your human 
too quickly or 
you’ll lose him.

Our greatest human scientific 
minds have invented protective 

interdimensional diamond-shaped 
portals to protect the human race.

It’s up to YOU to SAVE THE 
HUMANS by guiding them safely 

to their target portals.
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here’s your goal

Ellip
se

XAML Main Page 
and Containers Windows UI 

Controls

Here’s what you’re going to build

You’ll be building 
an app that has 

a main 

page with a bunch of vi
sual controls on i

t.
The app uses controls to provide gameplay for the player.

You’re going to need an application with a graphical user 
interface, objects to make the game work, and an executable to 
run. It sounds like a lot of  work, but you’ll build all of  this over 
the rest of  the chapter, and by the end you’ll have a pretty good 
handle on how to use the IDE to design a page and add C# code.

Here’s the structure of  the app we’re going to create:

You’ll lay out the main page 

using a grid. The gameplay will 

take place in the center ce
ll 

of the grid—we’ll use a Canvas 

for that.

Main p
ag

e

Grid

Canvas

Rectangl
e

Sta
ck

P
an

e
l

Rectangl
e

ProgressB
ar

Each human that 
the player has 
to save is drawn 
using a StackPanel, 
which contains 
an ellipse and a 
rectangle.

The app uses these controls 
to draw the target the 
human is dragged to and the countdown timer display.

The Target 
timer checks the 
ProgressBar’s 
properties to 
see if the player 
ran out of time.

Grab a cup of 
coffee and settle in! 

You’re about to really put 
the IDE through its paces, 
and build a pretty cool 

project.

By the end of this 
chapter, you’ll know your 
way around the IDE, 
and have a good head 
start on writing code.
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.png

Splash 
screen

StartGame()

AddEnemy()

AnimateEnemy()

EndTheGame()

C# Code Deployment 
Package

.exe

Program 
file

You’ll write C# code that manipulates the controls and makes the game work.

After your app is working, you can package it up so it can be uploaded to the Windows Store, Microsoft’s online marketplace for selling and distributing apps.

.xml

App 
manifest

Target ti
m

er

Enemy tim
er

Tick event handler

Tick event handler

Click event handler

Start b
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You’ll use two 
timers to add 
enemies and end the 
game if the player 
runs out of time.

You’ll be building an app with two different 
kinds of code. First you’ll design the 
user interface using XAML (Extensible 
Application Markup Language), a really 
flexible design language. Then you’ll 
add C# code to make the game actually 
work. You’ll learn a lot more about XAML 
throughout the second half of the book.

		�  No Windows 8? No problem.

The first two chapters and the last 
half  of  this book have many projects 
that are built with Visual Studio 2012 

for Windows 8, but many readers aren’t running Windows 
8 yet. Luckily, most of  the Windows Store apps in this 
book can also be built using Windows Presentation 
Foundation (WPF), which is compatible with earlier 
operating systems. You can download a free PDF with 
details and instructions from http://www.headfirstlabs.com/
hfcsharp...flip to leftover #11 in the appendix for 
more information.

It’s not unusual for computers in an office to be running an operating system as old as Windows 2003. With this PDF, you can still do the projects in the book.
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fill in the blanks

Start with a blank applicat ion
Every great app starts with a new project. Choose New Project from the File 
menu. Make sure you have Visual C#→Window Store selected and choose 
Blank App (XAML) as the project type. Type Save the Humans as 
the project name.

If your code filenames don’t end in “.cs” 
you may have accidentally created a 
JavaScript, Visual Basic, or Visual C++ 
program. You can fix this by closing the 
solution and starting over. If you want 
to keep the project name “Save the 
Humans,” then you’ll need to delete the 
previous project folder.

 Your starting point is the Designer window. Double-click on MainPage.xaml in the Solution 
Explorer to bring it up. Find the zoom drop-down in the lower-left corner of  the designer and 
choose “Fit all” to zoom it out.

1

Use these three buttons to turn on the 
grid lines, turn on snapping (which 
automatically lines up your controls to 
each other), and turn on snapping to grid 
lines (which aligns them with the grid).

The designer shows 
you a preview of 
the page that 
you’re working 
on. It looks like a 
blank page with 
a default black 
background.
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 The bottom half  of  the Designer window shows you the XAML 
code. It turns out your “blank” page isn’t blank at all—it contains 
a XAML grid. The grid works a lot like a table in an HTML 
page or Word document. We’ll use it to lay out our pages in a way 
that lets them grow or shrink to different screen sizes and shapes.

You can see the XAML code 
for the blank grid that the IDE 
generated for you. Keep your eyes 
on it—we’ll add some columns and 
rows in a minute.

This part of the project has steps numbered 1  to 5 .

Flip the page to keep going! 

These are the opening and closing tags for a grid that 
contains controls. When you add rows, columns, and controls 
to the grid, the code for them will go between these opening 
and closing tags.
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You are here!

Looking to learn WPF? Look no further!
Most of the Windows Store apps in this book can be built with WPF (Windows 
Presentation Foundation), which is compatible with Windows 7 and earlier operating 
systems.  Download the free WPF guide to Head First C# PDF from our website: 
http://headfirstlabs.com/hfcsharp (see leftover #11 in the appendix for more details)
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get a running start

 Your page is going to need a title, right? And it’ll need margins, too. You 
can do this all by hand with XAML, but there’s an easier way to get your 
app to look like a normal Windows Store app.

Go to the Solution Explorer window and find . Right-
click on it and choose Delete to delete the MainPage.xaml page:

2

When you start 
a Windows Store 
app, you’ll often 
replace the main 
page with one 
of the templates 
that Visual 
Studio provides.

 Now you’ll need to replace the main page. Go back to the Solution Explorer and 
right-click on  (it should be the second item in the 
Solution Explorer) to select the project. Then choose Add→New Item... from 
the menu:

3

If you chose a different name when you 
created your project, you’ll see that 
name instead of “Save the Humans” in 
the Solution Explorer.

Over the next few pages 
you’ll explore a lot of  
different features in 

the Visual Studio IDE, 
because we’ll be using 
the IDE as a powerful 
tool for learning and 

teaching. You’ll use the 
IDE throughout the book 

to explore C#. That’s a 
really effective way to 
get it into your brain!

If you don’t see the 
Solution Explorer, you can 
use the View menu to open 
it. You can also reset the 
IDE’s window layout using 
the Window menu.
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The IDE will pop up the Add New Item window for your project. Choose Basic Page and give it the name 
MainPage.xaml. Then click the Add button to add the replacement page to your project.

The IDE will prompt you to add missing files—choose Yes to add them. Wait for the designer to finish loading. It 
might display either  or . Choose Rebuild Solution from the 
Build menu to bring the IDE’s Designer window up to date. Now you’re ready to roll!

Let’s explore your newly added MainPage.xaml file. Scroll through the XAML pane in the designer window until you 
find this XAML code. This is the grid you’ll use as the basis for your program:

Choose Basic Page to 
add a new page to your 
projcet based on the 
Basic Page template.

Make sure you name it MainPage.xaml, because it needs 
the same name as the page that you deleted.

Notice how there’s a whole separate grid, 
with its own starting <Grid> and ending 
</Grid> tags? That’s the page header 
that displays the app name. This grid is 
also contained inside the root grid that 
you’ll be adding controls to.

You’ll use the IDE to lay out 
your app by modifying this grid.

When you replace 
MainPage.xaml with 
the new Basic Page 
item, the IDE needs 
to add additional 
files. Rebuilding 
the solution brings 
everything up to 
date so it can 
display the page in 
the designer.

Your page should 
be displayed in 
the designer. 
If it isn’t, 
double-click on 
MainPage.xaml 
in the Solution 
Explorer.
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Q:But it looks like I already have many rows and 
and columns in the grid. What are those gray lines?

A: The gray lines were just Visual Studio giving you a 
grid of guidelines to help you lay your controls out evenly 
on the page. You can turn them on and off with the  
button. None of the lines you see in the designer show up 
when you run the app outside of Visual Studio. But when 
you clicked and created a new row, you actually altered 
the XAML, which will change the way the app behaves 
when it’s compiled and executed.

Q: Wait a minute. I wanted to learn about C#. Why 
am I spending all this time learning about XAML?

A: Because Windows Store apps built in C# almost 
always start with a user interface that’s designed in XAML. 
That’s also why Visual Studio has such a good XAML 
editor—to give you the tools you need to build stunning 
user interfaces. Throughout this book, you’ll learn how 
to build two other types of programs with C#, desktop 
applications and console applications, neither of which 
use XAML. Seeing all three of these will give you a deeper 
understanding of programming with C#.

not so blank after all

 Your app will be a grid with two rows and three columns (plus the 
header row that came with the blank page template), with one big cell 
in the middle that will contain the play area. Start defining rows by 
hovering over the border until a line and triangle appear:

4

If you don’t see 
the numbers 140 
and 1* along 
the border of 
your page, click 
outside the page.

...then click to 
create a bottom 
row in the grid.

Hover over the 
border of the grid 
until an orange 
triangle and line 
appear...

After the row is added, 
the line will change 
to blue and you’ll see 
the row height in the 
border. The height 
of the center row will 
change from 1* to a 
larger number followed 
by a star. 

Windows Store 
apps need to 
look right on 
any screen, 
from tablets 
to laptops to 
giant monitors, 
in portrait or 
landscape. 

Laying out the page using a 
grid’s columns and rows allows 
your app to automatically 
adjust to the display.
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 Do the same thing along the top border of  the page—except this time create two columns, a small one 
on the lefthand side and another small one on the righthand side. Don’t worry about the row heights 
or column widths—they’ll vary depending on where you click. We’ll fix them in a minute.

5

When you’re done, look in the XAML window and go back to the same grid from the previous page. 
Now the column widths and row heights match the numbers on the top and side of  your page.

Here’s the width of the left column 
you created in step 5—the width 
matches the width that you saw in 
the designer. That’s because the IDE 
generated this XAML code for you.

Don’t worry if your 
row heights or column 
widths are different; 
you’ll fix them on the 
next page.

Your grid rows and columns are now added!
XAML grids are container controls, which means they hold other 
controls. Grids consist of  rows and columns that define cells, and 
each cell can hold other XAML controls that show buttons, text, and 
shapes. A grid is a great way to lay out a page, because you can set its 
rows and columns to resize themselves based on the size of  the screen.

The humans are 
preparing. We don’t like 

the looks of this.
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let’s size up the competition

 Set the width of the left column.  
Hover over the number above the first column until a drop-
down menu appears. Choose Pixel to change the star to a 
lock, then click on the number to change it to 160. Your 
column’s number should now look like this: 

 

1

Set up the grid for your page
Your app needs to be able to work on a wide range of  devices, and using 
a grid is a great way to do that. You can set the rows and columns of  
a grid to a specific pixel height. But you can also use the Star setting, 
which keeps them the same size proportionally—to each other and also 
to the page—no matter how big the display or what its orientation is.

 Repeat for the right column and 
the bottom row.  
Make the right column and the bottom row 160 by 
choosing Pixel and typing 160 into the box.

2

		�  It’s OK if  you’re not 
a pro at app 
design...yet.

We’ll talk a lot more 
about what goes into designing a good 
app later on. For now, we’ll walk you 
through building this game. By the end of  
the book, you’ll understand exactly what 
all of  these things do!

When you change this 
number, you modify 
the grid—and its 
XAML code.

Set your columns or rows to 
Pixel to give them a fixed 
width or height. The Star 
setting lets a row or column 
grow or shrink proportionally 
to the rest of the grid. Use 
this setting in the designer 
to alter the Width or Height 
property in the XAML. If 
you remove the Width or 
Height property, it’s the same 
as setting the property to 1*.
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 Make the center column and center row the 
default size 1* (if they aren’t already).  
Click on the number above the center column and enter 1. Don’t use 
the drop-down (leave it Star) so it looks like the picture below. Then 
make sure to look back at the other columns to make sure the IDE 
didn’t resize them. If  it did, just change them back to 160.

3

 Look at your XAML code! 
Click on the grid to make sure it’s selected, then look in the XAML window to see the code that you built.

4

You used the column and row 
drop-downs to set the Width 
and Height properties.

This is how a column is defined for a XAML 
grid. You added three columns and three rows, 
so there are three ColumnDefinition tags and 
three RowDefinition tags.

In a minute, you’ll be adding controls 
to your grid, which will show up here, 
after the row and column definitions. 

The <Grid .. > line at the top 
means everything that comes 
after it is part of the grid.

When you enter 1* into the box, 
the IDE sets the column to its 
default width. It might adjust 
the other columns. If it does, just 
reset them back to 160 pixels.

This top row with a height of 140 pixels is part of the Basic Page template you added.

XAML and C# are 
case sensitive! Make 
sure your uppercase 
and lowercase letters 
match example code.
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take control of your program

Add controls to your grid
Ever notice how apps are full of  buttons, text, pictures, progress bars, sliders, 
drop-downs, and menus? Those are called controls, and it’s time to add some 
of  them to your app—inside the cells defined by your grid’s rows and columns.

Drag a  into the lower-right cell of  the grid. Your XAML will look something like this. 
See if  you can figure out how it determines which row and column the controls are placed in.

2

Expand the  section of  the toolbox and 
drag a  into the bottom-left cell of  the grid.

Then look at the bottom of  the Designer window and have 
a look at the XAML tag that the IDE generated for you. 
You’ll see something like this—your margin numbers will be 
different depending on where in the cell you dragged it, and the 
properties might be in a different order. 

1

The XAML for the button starts 
here, with the opening tag.

These are properties. Each 
property has a name, followed by 
an equals sign, followed by its value.

If you don’t see 
the toolbox, try 
clicking on the 
word “Toolbox” 
that shows up 
in the upper-left 
corner of the 
IDE. If it’s not 
there, select 
Toolbox from 
the View menu 
to make it 
appear.

We added line breaks to make the XAML easier to 
read. You can add line breaks too. Give it a try!

Click on Pointer in the toolbox, then click on the TextBlock and move it around and watch the IDE update the Margin property in the XAML.

If you don’t see the 
toolbox in the IDE, you 
can open it using the View menu. Use the pushpin to 
keep it from collapsing.
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When you drag a 
control out of the 
toolbox and onto 
your page, the 
IDE automatically 
generates XAML 
to put it where you 
dragged it.

Next, expand the  section of  the toolbox. Drag a  
into the bottom-center cell, a  into the bottom-right cell (make sure it’s 
below the TextBlock you already put in that cell), and a  into the center cell. 
Your page should now have controls on it (don’t worry if  they’re placed differently than 
the picture below; we’ll fix that in a minute):

3

You’ve got the Canvas control currently selected, since you just added it. (If  not, use 
the pointer to select it again.) Look in the XAML window:

...

It’s showing you the XAML tag for the Canvas control. It starts with <Canvas and 
ends with />, and between them it has properties like Grid.Column="1" (to put 
the Canvas in the center column) and Grid.Row="1" (to put it in the center row). 
Try clicking in both the grid and the XAML window to select different controls.

4

Here’s the TextBlock 
control you added in 
step 2. You dragged 
a ContentControl 
into the same cell.

You just added 
this ProgressBar.

When you add the 
Canvas control, it 
looks like an empty 
box. We’ll fix that 
shortly.

Here’s the ContentControl. 
What do you think it does?

Try clicking this button. 
It brings up the Document 
Outline window. Can you 
figure out how to use it? 
You’ll learn more about it 
in a few pages.

Here’s the 
button you 
added in step 1.
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your app’s property value is going up

Use propert ies to change how the controls look
The Visual Studio IDE gives you fine control over your controls. The Properties window 
in the IDE lets you change the look and even the behavior of  the controls on your page.

 Use the Properties window to modify the button.  
Make sure the button is selected in the IDE, then look at the 
Properties window in the lower-right corner of  the IDE. Use 
it to change the name of  the control to startButton and 
center the control in the cell. Once you’ve got the button looking 
right, right-click on it and choose View Source to jump 
straight to the <Button> tag in the XAML window.

2

 Change the text of the button.  
Right-click on the button control that you dragged onto the grid and choose Edit Text 
from the menu. Change the text to: Start! and see what you did to the button’s XAML:

...

1

When you edit the text in the button, the IDE 
updates the Content property in the XAML.

Use the Name box to change the 
name of the control to startButton.

When you used “Edit Text” on the right-click menu to change 
the button’s text, the IDE updated the Content property.

Use the  and  buttons to set the 
HorizontalAlignment and VerticalAlignment properties 

to “Center” and center the button in the cell.

These little squares tell you if the property has been set. A filled square means it’s been set; an empty square means it’s been left with a default value.

When you dragged the button onto the page, the IDE 
used the Margin property to place it in an exact position 
in the cell. Click on the square  and choose Reset from 

the menu to reset the margins to 0.
Go back to the 
XAML window in 
the IDE and have a 
look at the XAML 
that you updated!

You might 
need to 
expand the 
Common 
and Layout 
sections.

When you’re editing text, use the Escape key to finish. This works for other things in the IDE, too.

The properties may be in a different order. That’s OK!
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 Change the page header text.  
Right-click on the page header (“My Application”) and choose View Source to jump to the XAML for the 
text block. Scroll in the XAML window until you find the Text property:

Wait a minute! That’s not text that says “My Application”—what’s going on here?

The Blank Page template uses a static resource called AppName for the name that it displays at the top 
of  the page. Scroll to the top of  the XAML code until you find a <Page.Resources> section that has 
this XAML code in it:

Replace “My Application” with the name of  your application:

Now you should see the correct text at the top of  the page:

3

 Use a StackPanel to group the TextBlock and ContentControl. 
Make sure that the TextBlock is near the top of  the cell, and the ContentControl is near 
the bottom. Click and drag to select both the TextBlock and ContentControl, 
and then right-click. Choose  from the pop-up menu, then choose 

. This adds a new control to your form: a StackPanel control. You can 
select the StackPanel by clicking between the two controls. 

The StackPanel is a lot like the Grid and Canvas: its job is to hold other controls 
(it’s called a “container”), so it’s not visible on the form. But since you dragged the 
TextBlock to the top of  the cell and the ContentControl to the bottom, the IDE created 
the StackPanel so it fills up most of  the cell. Click in the middle of  the StackPanel 
to select it, then right-click and choose  and  to quickly reset its 
properties, which will set its vertical and horizontal alignment to Stretch. Finally, right-
click on the TextBox and ContentControl to reset their layouts as well. While you have 
the ContentControl selected, set its vertical and horizontal alignments to Center.

5

You are here!
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 Update the TextBlock to change its text and its style.  
Use the Edit Text right-mouse menu option to change the TextBlock so it says 
Avoid These (hit Escape to finish editing the text). Then right-click on it, choose 
the  menu item, and then choose the  submenu and 
select SubheaderTextStyle to make its text bigger.

4

Don’t worry about that back 
button. You’ll learn all about how to use it in Chapter 14. You’ll 
also learn about static resources.

Your TextBlock and 
ContentControl are 
in the lower-right cell 
of the grid.

Right-click and 
reset the layout 
of the StackPanel, 
TextBlock, and 
ContentControl.

A box appears around 
the StackPanel if you 
hover over it.

You can use Edit→Undo (or Ctrl-Z) to undo 
the last change. Do it several times to undo 

the last few changes. If  you selected the 
wrong thing, you can choose Select None 

from the Edit menu to deselect. You can also 
hit Escape to deselect the control. If  it’s 

living inside a container like a StackPanel or 
Grid, hitting Escape will select the container, 

so you may need to hit it a few times.
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you want your game to work, right?

Controls make the game work
Controls aren’t just for decorative touches like titles and captions. They’re central to the way your game works. 
Let’s add the controls that players will interact with when they play your game. Here’s what you’ll build next:

 Update the ProgressBar.  
Right-click on the ProgressBar in the bottom-center cell of  the grid, choose the Reset 
Layout menu option, and then choose All to reset all of  the properties to their default 
values. Use the Height box in the Layout section of  the Properties window to set the 
Height to 20. The IDE stripped all of  the layout-related properties from the XAML, 
and then added the new Height:

1

 Turn the Canvas control into the gameplay area.  
Remember that Canvas control that you dragged into the center square? It’s hard 
to see it right now because a Canvas control is invisible when you first drag it out of  

the toolbox, but there’s an easy way to find it. Click the very small  button above 
the XAML window to bring up the Document Outline. Click on  to 
select the Canvas control. 

Make sure the Canvas control is selected, then use the Name box in the 
Properties window to set the name to playArea.

2

After you’ve named the Canvas control, you can close the 
Document Outline window. Then use the  and  buttons 
in the Properties window to set its vertical and horizontal 
alignments to Stretch, reset the margins, and click both  
buttons to set the Width and Height to Auto. Then set its 
Column to 0, and its ColumnSpan (next to Column) to 3.

Finally, open the Brush section of  the Properties window and 
use the  button to give it a gradient. Choose the starting 
and ending colors for the gradient by clicking each of  the tabs 
at the bottom of  the color editor and then clicking on a color.

Click on the lefthand 
tab, then on the 
starting color for the 
gradient. Then click on 
the righthand tab and 
choose the ending color.

Once you change the name, it’ll show up as playArea instead of [Canvas] in the Document Outline window.

You can also open the Document Outline by 
clicking the tab on the side of the IDE.

You can also get to the Document Outline by choosing the View→Other Windows menu.

...and you’ll work on the 
bottom row. You’ll make the ProgressBar 

as wide as its column...
...and you’ll use a 
template to make your 
enemy look like this.

You’ll create a play area with a 
gradient background...
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You’re almost done laying out the form! Flip the page for the last steps... 

 Use the Document Outline to modify the StackPanel and TextBlock controls.  
Go back to the Document Outline (if  you see  at the top of  the Document 
Outline window, just click  to get back to the Page outline). Select the StackPanel control, make sure its 
vertical and horizontal alignments are set to center, and clear the margins. Then do the same for the TextBlock.

5

 Create the enemy template.  
Your game will have a lot of  enemies bouncing around the screen, and you’re going to want them to all look the 
same. Luckily, XAML gives us templates, which are an easy way to make a bunch of  controls look alike. 

Next, right-click on the ContentControl in the Document Outline window. Choose Edit Template, then choose 
Create Empty... from the menu. Name it EnemyTemplate. The IDE will add the template to the XAML.

Your newly created template is currently selected in the IDE. Collapse the Document Outline window so it doesn’t 
overlap the Toolbox. Your template is still invisible, but you’ll change that in the next step. If  you accidentally click out of  
the control template, you can always get back to it by opening the Document Outline, right-clicking on the Content Control, 
and choosing Edit Template→Edit Current.

3

You’re “flying blind” for this 
next bit—the designer won’t 
display anything for the 
template until you add a control 
and set its height and width so 
it shows up. Don’t worry; you 
can always undo and try again if 
something goes wrong.

You can also use the 
Document Outline 
window to select 
the grid if it gets 
deselected.

 Edit the enemy template.  
Add a red circle to the template:

≥≥ Double-click on  in the toolbox to add an ellipse.

≥≥ Set the ellipse’s Height and Width properties to 100, 
which will cause the ellipse to be displayed in the cell.

≥≥ Reset the HorizontalAlignment, 
VerticalAlignment, and Margin properties by 
clicking on their squares and choosing Reset.

≥≥ Go to the Brush section of  the Properties window and click 
on  to select a solid-color brush.

≥≥ Color your ellipse red by clicking in the color bar and 
dragging to the top, then clicking in the color sector and 
dragging to the upper-right corner.

The XAML for your ContentControl now looks like this:

4

Click in this color 
selector and drag 
to the upper-right 
corner.

Scroll around your page’s XAML window and see if you can find where the 
EnemyTemplate is defined. It should be right below the AppName resource.

Make sure you don’t click anywhere else in the designer until 
you see the ellipse. That will keep the template selected.
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check out the page you built

 Add the human to the Canvas. 

You’ve got two options for adding the human. The first option is to follow the next three paragraphs. The second, quicker 
option is to just type the four lines of  XAML into the IDE. It’s your choice!

Select the Canvas control, then open the All XAML Controls section of  the toolbox and double-click 
on Ellipse to add an Ellipse control to the Canvas. Select the Canvas control again and double-click on 
Rectangle. The Rectangle will be added right on top of  the Ellipse, so drag the Rectangle below it.

Hold down the Shift key and click on the Ellipse so both controls are selected. Right-click on the Ellipse, 
choose Group Into, and then StackPanel. Select the Ellipse, use the solid brush property to change its 
color to white, and set its Width and Height properties to 10. Then select the Rectangle, make it white as 
well, and change its Width to 10 and its Height to 25. 

Use the Document Outline window to select the Stack Panel (make sure you see  at the top of  
the Properties window). Click both  buttons to set the Width and Height to Auto. Then use the Name 
box at the top of  the window to set its name to human. Here’s the XAML you generated:

Go back to the Document Outline window to see how your new controls appear:

6

 Add the Game Over text. 
When your player’s game is over, the game will need to display a Game 
Over message. You’ll do it by adding a TextBlock, setting its font, and 
giving it a name:

≥≥ Select the Canvas, then drag a TextBlock out of  the toolbox and 
onto it.

≥≥ Use the Name box in the Properties window to change the 
TextBlock’s name to gameOverText. 

≥≥ Use the Text section of  the Properties window to change the font to 
Arial Black, change the size to 100 px, and make it Bold and Italic. 

≥≥ Click on the TextBlock and drag it to the middle of  the Canvas.

≥≥ Edit the text so it says Game Over.

7

If you choose to type this into the XAML 
window of the IDE, make sure you do it directly 
above the </Canvas> tag. That’s how you indicate 
that the human is contained in the Canvas.

When you drag 
a control around 
a Canvas, its 
Left and Top 
properties are 
changed to set 
its position. If 
you change the 
Left and Top 
properties, you 
move the control.

Your XAML may also set a Stroke 
property for 

the shapes that add 
an outline. Can you figure 

out how to add or remove it?
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 Add the target portal that the player will drag the human onto. 
There’s one last control to add to the Canvas: the target portal that your player will drag the human 
into. (It doesn’t matter where in the Canvas you drag it.) 

Select the Canvas control, then drag a Rectangle control onto it. Use the  button in the Brushes 
section of  the Properties window to give it a gradient. Set its Height and Width properties to 50.

Turn your rectangle into a diamond by rotating it 45 degrees. Open the Transform section of  the 
Properties window to rotate the Rectangle 45 degrees by clicking on  and setting the angle to 45.

Finally, use the Name box in the Properties window to give it the name target.

Congratulations—you’ve finished building the main page for your app!

8
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Now that you’ve built a user interface, you should have a sense of  what some of  the controls do, and you’ve used 
a lot of  different properties to customize them. See if  you can work out which property does what, and where in 
the Properties window in the IDE you find it.

Content

Height

Rotation

Fill

x:Name

XAML property

Determines how tall the 
control should be

Sets the angle that the 
control is turned

You use this in your C# 
code to manipulate a 
specific control

The color of  the control

Use this when you want 
to change text displayed 
inside your control

What it does
Where to find it 

in the Properties 
window in the IDE

At the top

Here’s a hint: you can use the Search box in the 
Properties window to find properties—but some of 

these properties aren’t on every type of control.

Solution on page 37
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You’ve set the stage for the game
Your page is now all set for coding. You set up the grid that will 
serve as the basis of  your page, and you added controls that will 
make up the elements of  the game.

Visual Studio gave you useful tools for laying 
out your page, but all it really did was help you 
create XAML code. You’re the one in charge!

The first step you did was to create the project and set up the grid.

Then you added controls to your page. The next step is to write code that uses them.
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keep your stub for re-entry

What you’l l do next
Now comes the fun part: adding the code that makes your game 
work. You’ll do it in three stages: first you’ll animate your enemies, 
then you’ll let your player interact with the game, and finally 
you’ll add polish to make the game look better.

...then you’ll add the gameplay...

...and finally, you’ll 
make it look good.

First you’ll animate the enemies...

The first thing you’ll do 
is add C# code that 
causes enemies to shoot 
out across the play 
area every time you 
click the Start button.

To make the game 
work, you’ll need the 
progress bar to count 
down, the human to 
move, and the game 
to end when the 
enemy gets him or 
time runs out.

You used a template 
to make the enemies 
look like red circles. 
Now you’ll update 
the template to make 
them look like evil 
alien heads.

A lot of  programmers build their code in small 
increments, making sure one piece works before 
moving on to the next one. That’s how you’ll build 
the rest of  this program. You’ll start by creating 

a method called AddEnemy() that adds an 
animated enemy to the Canvas control. First 

you’ll hook it up to the Start button so you can fill 
your page up with bouncing enemies. That will lay 
the groundwork to build out the rest of  the game.
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Add a method that does something
It’s time to start writing some C# code, and the first thing you’ll do is 
add a method—and the IDE can give you a great starting point by 
generating code. 

When you’re editing a page in the IDE, double-clicking on any of  the 
controls on the page causes the IDE to automatically add code to your 
project. Make sure you’ve got the page designer showing in the IDE, 
and then double-click on the Start button. The IDE will add code to 
your project that gets run any time a user clicks on the button. You 
should see some code pop up that looks like this:

Q: What’s a method?

A: A method is just a named block of code. 
We’ll talk a lot more about methods in Chapter 2.

Q: And the IDE generated it for me?

A: Yes...for now. A method is one of the basic 
building blocks of programs—you’ll write a lot of 
them, and you’ll get used to writing them by hand.

When you double-clicked on the Button control, the 
IDE created this method. It will run when a user 
clicks the “Start!” button in the running application.

Use the IDE to create your own method
Click between the { } brackets and type this, including the parentheses and semicolon:

Notice the red squiggly line underneath the text you just typed? That’s the IDE telling you that something’s 
wrong. If  you click on the squiggly line, a blue box appears, which is the IDE’s way of  telling you that it 
might be able to help you fix the error. 

Hover over the blue box and click the  icon that pops up. You’ll see a box asking you to generate a 
method stub. What do you think will happen if  you click it? Go ahead and click it to find out!

The red squiggly line is the IDE telling you 
there’s a problem, and the blue box is the 
IDE telling you that it might have a solution.

The IDE also added 
this to the XAML. See 
if you can find it. You’ll 
learn more about what 
this is in Chapter 2.
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Fil l in the code for your method
It’s time to make your program do something, and 
you’ve got a good starting point. The IDE generated a 
method stub for you: the starting point for a method that 
you can fill in with code.

Select this and delete it. You’ll learn 
about exceptions in Chapter 12.

Delete the contents of  the method stub that the IDE 
generated for you.

1

Start adding code. Type the word Content into the method body. The IDE will pop up a window 
called an IntelliSense Window with suggestions. Choose ContentControl from the list.

2

Finish adding the first line of  code. You’ll get another IntelliSense window after you type new.3

	        C# code must be 
added exactly as 
you see it here.

It’s really easy to throw 
off your code. When 

you’re adding C# code to your 
program, the capitalization has to 
be exactly right, and make sure you 
get all of the parentheses, commas, 
and semicolons. If you miss one, 
your program won’t work!

This line creates a new ContentControl object. You’ll learn about objects and the new keyword in Chapter 3, and reference variables like enemy in Chapter 4.
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Before you fill in the AddEnemy() method, you’ll need to add a line of  code near the top of  the file. 
Find the line that starts with public sealed partial class MainPage and add this line 
after the bracket ({):

4

This is called a field. You’ll learn more about how it works in Chapter 4.

Flip the page to see your program run!

Finish adding the method. You’ll see some squiggly red underlines. The ones 
under AnimateEnemy() will go away when you generate its method stub.

5 Do you see a squiggly underline 
under playArea? Go back to the 
XAML editor and sure you set 
the name of the Canvas control 
to playArea.

This line adds your 
new enemy control 
to a collection called 
Children. You’ll learn 
about collections in 
Chapter 8.

If you need to switch between the XAML and C# 
code, use the tabs at the top of the window.

Use the blue box and the  button to generate a method stub for AnimateEnemy(), just like you 
did for AddEnemy(). This time it added four parameters called enemy, p1, p2, and p3. Edit the 
top line of  the method to change the last three parameters. Change the parameter p1 to from, the 
parameter p2 to to, and the parameter p3 to propertyToAnimate. Then change any int types to 
double.

6

You’ll learn 
about methods and parameters in Chapter 2.

Flip the page to see your program run!
The IDE may generate the method stub 
with “int” types. Change them to “double”. 
You’ll learn about types in Chapter 4.
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Finish the method and run your program
Your program is almost ready to run! All you need to do is finish your 
AnimateEnemy() method. Don’t panic if  things don’t quite work 
yet. You may have missed a comma or some parentheses—when you’re 
programming, you need to be really careful about those things!

 Add a using statement to the top of the file. 
Scroll all the way to the top of  the file. The IDE generated several 
lines that start with using. Add one more to the bottom of  the list:

1

You’ll need this line to make the next bit of code work. You can use the IntelliSense window to get it right—and don’t forget the semicolon at the end.

You’ll learn about 
object initializers 
like this in 
Chapter 4.

And you’ll learn 
about animation 
in Chapter 16.

 Add code that creates an enemy bouncing animation. 
You generated the method stub for the AnimateEnemy() method on the 
previous page. Now you’ll add its code. It makes an enemy start bouncing across 
the screen.

2

		  Still seeing red? 
The IDE helps 
you track down 
problems.

If  you still have some of  those red 
squiggly lines, don’t worry! You 
probably just need to track down 
a typo or two. If  you’re still seeing 
squiggly red underlines, it just means 
you didn’t type in some of  the code 
correctly. We’ve tested this chapter 
with a lot of  different people, and we 
didn’t leave anything out. All of  the 
code you need to get your program 
working is in these pages.

 Look over your code. 
You shouldn’t see any errors, and your Error List window should be 
empty. If  not, double-click on the error in the Error List. The IDE will 
jump your cursor to the right place to help you track down the problem.

3

If you can’t see the Error List window, choose Error List from the View menu to show it. You’ll learn more about using the error window and debugging your code in Chapter 2.

Statements 
like these let 
you use code 
from .NET 
libraries that 
come with 
C#. You’ll 
learn more 
about them in 
Chapter 2.

This using statement lets you use animation code from the .NET Framework in your program to move the enemies on your screen. 

This code makes the enemy you created move across playArea. If you change 4 and 6, you can make the enemies move slower or faster.
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 Start your program. 
Find the  button at the top of  the IDE. This starts your program running.

4

 Now your program is running! 
First, a big  X will be displayed for a few seconds, and then your main page will be displayed. Click 
the “Start!” button a few times. Each time you click it, a circle is launched across your canvas.

5

This button starts your program.

 Stop your program. 
Press Alt-Tab to switch back to the IDE. The  button in the toolbar has been replaced with  to 
break, stop, and restart your program. Click the square to stop the program running.

6

This big X is the splash 
screen. You’ll make your 
own splash screen at the 
end of the chapter.

You built something cool! And it didn’t take 

long, just like we promised. But there’s more 

to do to get it right.

Here’s a hint: if  you move too many windows 
around your IDE, you can always reset by choosing 

Reset Window Layout from the Window menu.

If the enemies aren’t bouncing, 
or if they leave the play area, 
double-check the code. You may 
be missing parentheses or keywords.
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what you’ve done, where you’re going

Here’s what you’ve done so far
Congratulations! You’ve built a program that actually does 
something. It’s not quite a playable game, but it’s definitely a start. 
Let’s look back and see what you built.

Visual Studio can generate code for you, but you 
need to know what you want to build BEFORE 
you start building it. It won’t do that for you!

We’ve gotten a good start by building the user interface...

…but we still need 
the rest of the C# 
code to make the app 
actually work.

This step is where we write C# code that makes the gameplay run.
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Now that you’ve built a user interface, you should have a sense of  what some of  the controls do, and you’ve used 
a lot of  different properties to customize them. See if  you can work out which property does what, and where in 
the Properties window in the IDE you find it.

Content

Height

Rotation

Fill

x:Name

XAML property

Determines how tall the 
control should be

Sets the angle that the 
control is turned

You use this in your C# 
code to manipulate a 
specific control

The color of  the control

Use this when you want 
text or graphics in your 
control

What it does
Where to find it 

in the Properties 
window in the IDE

At the top

solution

Remember how you set the Name of the 
Canvas control to “playArea”? That set its 
“x:Name” property in the XAML, which will 
come in handy in a minute when you write C# 
code to work with the Canvas.

Here’s the solution for the “Who Does What” exercise on page 28. 
We’ll give you the anwers to the pencil-and-paper puzzles and 

exercises, but they won’t always be on the next page.
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Add t imers to manage the gameplay
Let’s build on that great start by adding working gameplay elements. This game adds 
more and more enemies, and the progress bar slowly fills up while the player drags the 
human to the target. You’ll use timers to manage both of  those things.

 Add more lines to the top of your C# code. 
Go up to the top of  the file where you added that Random line. Add three more lines:

1

The MainPage.Xaml.cs file you’ve been editing 
contains the code for a class called MainPage. 
You’ll learn about classes in Chapter 3.

Add these three lines 
below the one you added 
before. These are fields, 
and you’ll learn about 
them in Chapter 4. Add a method for one of your timers.  

Find this code that the IDE generated:

Put your cursor right after the semicolon, hit Enter two times, and type 
enemyTimer. (including the period). As soon as you type the dot, an IntelliSense 
window will pop up. Choose Tick from the IntelliSense window and type the 
following text. As soon as you enter +=  the IDE pops up a box:

       

Press the Tab key. The IDE will pop up another box:

      

Press Tab one more time. Here’s the code the IDE generated for you:

       

2

The IDE generated 
a method for you 
called an event 
handler. You’ll learn 
about event handlers 
in Chapter 15.

TickTick
Tick

Timers “tick” 
every time 
interval by 
calling methods 
over and over 
again. You’ll use 
one timer to add 
enemies every 
few seconds, and 
the other to end 
the game when 
time expires.
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 Add the EndTheGame() method. 
Go to the new targetTimer_Tick() method, delete the line that the IDE generated, and add 
the following code. The IntelliSense window might not seem quite right:

Notice how progressBar has an error? That’s OK. We did this on purpose (and we’re not even 
sorry about it!) to show you what it looks like when you try to use a control that doesn’t have a 
name, or has a typo in the name. Go back to the XAML code (it’s in the other tab in the IDE), find 
the ProgressBar control that you added to the bottom row, and change its name to progressBar.

Next, go back to the code window and generate a method stub for EndTheGame(), just like you 
did a few pages ago for AddEnemy(). Here’s the code for the new method:

4

 Finish the MainPage() method.  
You’ll add another Tick event handler for the other timer, and you’ll add 
two more lines of  code. Here’s what your finished MainPage() method 
and the two methods the IDE generated for you should look like:

3

It’s normal to add parentheses () 
when writing about a method.

If you closed the Designer tab that had the XAML code, double-click on MainPage.xaml in the Solution Explorer window to bring it up.

If gameOverText comes up as an error, it means you didn’t set the name of the “Game Over” TextBlock. Go back and do it now.

Right now your Start button 
adds bouncing enemies to the 
play area. What do you think 
you’ll need to do to make it 
start the game instead?

This method ends the 
game by stopping the 

timers, making the 
Start button visible 
again, and adding 

the GAME OVER text 
to the play area.

The IDE generated these lines as placeholders when you pressed Tab to add the Tick event handlers. You’ll replace them with code that gets run every time the timers tick.

Try changing these 
numbers once your 
game is finished. How 
does that change the 
gameplay?

Did the IDE 
keep trying 
to capitalize 
the P in 
progressBar? 
That’s because 
there was no 
lowercase-P 
progressBar, 
and the 
closest match 
it could 
find was the 
type of the 
control.
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so close i can taste it

Make the Start button work
Remember how you made the Start button fire circles into the Canvas? Now  
you’ll fix it so it actually starts the game.

 Make the Start button start the game. 
Find the code you added earlier to make the Start button add an 
enemy. Change it so it looks like this:

1

 Add the StartGame() method. 
Generate a method stub for the StartGame() method. Here’s the 
code to fill into the stub method that the IDE added:

2

 Make the enemy timer add the enemies. 
Find the enemyTimer_Tick() method that the IDE added for 
you and replace its contents with this:

3

Did you forget to set the names of 
the target Rectangle or the human 
StackPanel? You can look a few pages 
back to make sure you set the right 
names for all of the controls.

When you change this line, you make the Start button start the game instead of just adding an enemy to the playArea Canvas.

Ready Bake 
Code

We’re giving you a lot of code to 
type in.

By the end of the book, you’ll know 
what all of this code does—in fact, 
you’ll be able to write code just like it 
on your own.

For now, your job is to make sure 
you enter each line accurately, and 
to follow the instructions exactly. This 
will get you used to entering code, 
and will help give you a feel for the 
ins and outs of the IDE.

If you get stuck, you can download 
working versions of MainPage.xaml 
and MainPage.Xaml.cs or copy and 
paste XAML or C# code for each 
individual method: 
http://www.headfirstlabs.com/hfcsharp.

Once you’re used to working with code, you’ll be good at spotting those missing parentheses, semicolons, etc.

Are you seeing errors in the Error List window that don’t make 
sense? One misplaced comma or semicolon can cause two, 
three, four, or more errors to show up. Don’t waste your time 
trying to track down every typo! Just go to the Head First Labs 
web page—we made it really easy for you to copy and paste all 
of the code in this program.

http://www.headfirstlabs.com/hfcsharp/

You’ll learn about 
IsHitTestVisible in 
Chapter 15.
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What do you think you’ll need to do to get the rest 
of your game working?

Alert! Our spies 
have reported that the 
humans are building up 

their defenses!When you press the “Start!” button, 
it disappears, clears the enemies, and 
starts the progress bar filling up.

When the progress bar at the bottom fills up, the game ends and the Game Over text is displayed.

The play area slowly starts to fill up 
with bouncing enemies.

Flip the page to find out! 

Run the program to see your progress
Your game is coming along. Run it again to see how it’s shaping up.

The target timer should fill up slowly, and the enemies should appear every two seconds. If the timing is off, make sure you added all of the lines to the MainPage() method.
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Go to the XAML designer and use the Document Outline window to select human 
(remember, it’s the StackPanel that contains a Circle and a Rectangle). Then go to the 
Properties window and press the  button to switch it to show event handlers. Find 
the PointerPressed row and double-click in the empty box.

Now go back and check out what the IDE added to your XAML for the StackPanel:

It also generated a method stub for you. Right-click on human_PointerPressed in 
the XAML and choose “Navigate to Event Handler” to jump straight to the C# code:

1

Fill in the C# code:2

Add code to make your controls 
interact with the player
You’ve got a human that the player needs to drag to the target, and a 
target that has to sense when the human’s been dragged to it. It’s time 
to add code to make those things work. You’ll learn more 

about the event 
handlers in the 
Properties window 
in Chapter 4.

Double-click in this box.

If you go back to the designer and 
click on the StackPanel again, you’ll 
see that the IDE filled in the name 
of the new event handler method. 
You’ll be adding more event handler 
methods the same way.

You can use these 
buttons to switch 
between showing 
properties and 
event handlers 
in the Properites 
window.

Make sure you switch back 
to the IDE and stop the 
app before you make more 
changes to the code. 

The Document Outline 
may have collapsed [Grid], playArea, and other lines. If it did, just expand them to find the human control.
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Use the Document Outline window to select the Rectangle named target, 
then use the event handlers view of  the Properties window to add a 
PointerEntered event handler. Here’s the code for the method:

3

Make sure you add the right event handler! You added a PointerPressed event handler to the human, but now you’re adding a PointerEntered event handler to the target.

Now you’ll add two more event handlers, this time to the playArea Canvas control. You’ll need to find the 
right [Grid] in the Document Outline (there are two of  them—use the child grid that’s indented under 
the main grid for the page) and set its name to grid. Then you can add these event handlers to playArea:

4

You’ll need to switch your Properties window back 
to show properties instead of event handlers.

That’s a lot of parentheses! 
Be really careful and get 
them right.

These two vertical 
bars are a logical 
operator. You’ll 
learn about them 
in Chapter 2.

Make sure you put the right code 
in the correct event handler! 
Don’t accidentally swap them.

You can make the 
game more or 

less sensitive by 
changing these 
3s to a lower or 
higher number.

When the Properties 
window is in the mode 
where it displays event 

handlers, double-
clicking on an empty 

event handler box 
causes the IDE to add 

a method stub for it.
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you can’t save them all

Dragging humans onto enemies ends the game
When the player drags the human into an enemy, the game should end. Let’s add the code to do that. 
Go to your AddEnemy() method and add one more line of  code to the end. Use the IntelliSense 
window to fill in enemyPointer.PointerEntered from the list:

Choose PointerEntered from the list. (If  you choose the wrong one, don’t worry—just backspace 
over it to delete everything past the dot. Then enter the dot again to bring up the IntelliSense window.)

Next, add an event handler, just like you did before. Type += and then press Tab:

         

Then press Tab again to generate the stub for your event handler:

        

Now you can go to the new method that the IDE generated for you and fill in the code:

Here’s the last line of your 
AddEnemy() method. Put your 
cursor at the end of the line 
and hit Enter to add the 
new line of code.

Start typing this line of 
code. As soon as you enter 
the dot, an IntelliSense 
window will pop up. Keep 
typing “Pointer” to jump 
down to the entries in 
the list that start with 
“Pointer...”

You’ll learn all about 
how event handlers like 
this work in Chapter 15.
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Your game is now playable
Run your game—it’s almost done! When you click the Start button, your play 
area is cleared of  any enemies, and only the human and target remain. You 
have to get the human to the target before the progress bar fills up. Simple at 
first, but it gets harder as the screen fills with dangerous alien enemies!

Drag the human to safety!

...but drag too fast, and you’ll lose your human!

Get him to the target before time’s up...

The aliens only spend their time patrolling for moving humans, so the game only ends if you drag a human onto an enemy. Once you 
release the human, he’s 
temporarily safe from aliens.

Look through the code and find where you set the IsHitTestVisible property on the human. When it’s on, the human intercepts the PointerEntered event because the human’s StackPanel control is sitting between the enemy and the pointer.
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 Drag one more Ellipse control out of  the toolbox on top of  the existing ellipse. Change its fill to 
Black, set its width to 25, and set its height to 35. Set the alignment and margins like this:

  
and add a skew like this:

4

bells whistles aliens

Make your enemies look like aliens
Red circles aren’t exactly menacing. Luckily, you used a template. 
All you need to do is update it.

Now your enemies 
look a lot more like 
human-eating aliens. 

 Go to the Document Outline, right-click on the ContentControl, 
choose Edit Template, and then Edit Current to edit the template. 
You’ll see the template in the XAML window. Edit the XAML code 
for the ellipse to set the width to 75 and the fill to Gray. Then add 

 to add a black outline, and reset its vertical and 
horizontal alignments. Here’s what it should look like (you can delete 
any additional properties that may have inadvertently been added 
while you worked on it):

1

 Drag another Ellipse control out of  the toolbox on top of  the existing ellipse. Change its Fill to 
black, set its width to 25, and its height to 35. Set the alignment and margins like this:

2

 Use the  button in the Transforms section of  the Properties window to add a Skew transform:3

	        Seeing events 
instead of 
properties?

You can toggle the 
Properties window 

between displaying properties or 
events for the selected 
control by clicking the 
wrench or lightning bolt icons. 

You can also “eyeball” it (excuse the pun) by using 
the mouse or arrow keys to drag the ellipse into 
place. Try using Copy and Paste in the Edit menu to 
copy the ellipse and paste another one on top of it.
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Add a splash screen and a t i le
That big X that appears when you start your program is a splash 
screen. And when you go back to the Windows Start page, there it 
is again in the tile. Let’s change these things.

Here’s the updated XAML for the 
new enemy template that you created.

Expand the  folder in the Solution Explorer window and 
you’ll see four files. Double-click each of  them to edit them in Paint. 
Edit SplashScreen.png to create a splash screen that’s displayed when 
the game starts. Logo.png and SmallLogo.png are displayed in the Start 
screen. And when your app is displayed in the search results (or in the 
Windows Store!), it displays StoreLogo.png.

Some editions 
of Visual 
Studio use 
their own 
graphics 
editors 
instead of 
MS Paint.

There’s just One more thing you need to do...

Play your game!
And don’t forget to step back and really 
appreciate what you built. Good job! 

See if you can get creative and change the way the human, target, play area, and enemies look.

Don’t feel like making your own splash 
screen or logos? You can download ours:  
http://www.headfirstlabs.com/hfcsharp
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your app becomes everyone’s app You are here!
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Publish your app
You should be pretty pleased with your app! Now 
it’s time to deploy it. When you publish your app 
to the Windows Store, you make it available to 
millions of  potential users. The IDE can help 
guide you through the steps to publish your app to 
the Windows Store.

Here’s what it takes to get your app out there:

1 Open a Windows Store 
developer account.

2 Choose your app’s name, set an 
age rating, write a description, 
and choose a business model to 
determine if  your app is free, 
ad-supported, or has a price.

3 Test your app using the 
Windows App Certification Kit 
to identify and fix any problems.

You can learn more about how to publish apps to the Windows Store here:
http://msdn.microsoft.com/en-us/library/windows/apps/jj657972.aspx

Throughout the book we’ll show you where to find 
more information from MSDN, the Microsoft 
Developer Network. This is a really valuable resource 
that helps you keep expanding your knowledge.

4 Submit your app to the 
Store! Once it’s accepted, 
millions of  people around the 
world can find and download it. The Store menu in the IDE has all of the 

tools you need to publish your app.

In some editions of Visual Studio, the 
Windows Store options appear under the 
Project menu instead of having their own 
top-level Store menu.
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Use the Remote Debugger to side load your app
Sometimes you want to run your app on a remote machine without publishing it to the 
Windows Store. When you install your app on a machine without going through the 
Windows Store it’s called sideloading, and one of  the easiest ways to do it is to install 
the Visual Studio Remote Debugger on another computer. 

If  you have an odd network setup, you may have trouble running the 
remote debugger. This MDSN page can help you get it set up:

http://msdn.microsoft.com/en-us/library/vstudio/bt727f1t.aspx

Here’s how to get your app loaded using the Remote Debugger:

≥≥ Make sure the remote machine is running Windows 8.

≥≥ Go to the Microsoft Download Center (http://www.microsoft.com/en-hk/download/default.aspx) on the 
remote machine and search for “Remote Tools for Visual Studio 2012.”

≥≥ Download the installer for your machine’s architecture (x86, x64, ARM) and run it to install the 
remote tools.

≥≥ Go to the Start page and launch the Remote Debugger. 
 

≥≥ If  your computer’s network configuration needs to change, it may pop up a wizard to help with that. 
Once it’s running, you’ll see the Visual Studio Remote Debugging Monitor window: 
 

≥≥ Your remote computer is now running the Visual Studio Remote Debugging Monitor and waiting 
for incoming connections from Visual Studio on your development machine.

At the time this is being written, you’ll find “Remote Tools for Visual Studio 2012 Update 2,” but you may find future updates.

This is running on a computer called MY-SURFACE. Take 
note of the machine name, because it will come in handy in 
a minute.

Flip to get your app up and running on the remote computer! 
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humans saved for now

Start remote debugging
Once you’ve got a remote computer running the remote debugging monitor, you 
can launch the app from Visual Studio to install and run it. This will automatically 
sideload your app on the computer, and you’ll be able to run it again from the Start 
page any time you want.

 Choose “Remote Machine” from the Debug drop-down. 
You can use the Debug drop-down to tell the IDE to run your program on a remote 
machine. Take a close look at the  button you’ve been using to run your 
program—you’ll see a drop-down ( ). Click it to show the drop-down and choose Remote 
Machine:

1

 Run your program on the remote machine. 
Now run your program by clicking the  button. The IDE will pop up a window asking for the 
machine to run on. If  it doesn’t detect it in your subnet, you can enter the machine name manually:

2

Don’t forget to change this 
back to Simulator when you’re 
ready to move on to the next 
chapter! You’ll be writing a bunch 
of programs, and you’ll need this 
button to run them.

Enter the name of the machine running 
the Remote Debugging Monitor.

If  you need to change the machine 
in the future, you can do it in the 
project settings. Right-click on 

the project name in the Solution 
Explorer and choose Properties, 

then choose the  tab. 
If  you clear the  field 
and restart the remote debugger, 

the Remote Debugger Connections 
window will pop up again.



you are here 4    51

start building with c#

 Enter your credentials. 
You’ll be prompted to enter the username and 
password of  the user on the remote machine. 
You can turn off  authentication in the Remote 
Debugging Monitor if  you want to avoid this (but 
that’s not a great idea, because then anyone can 
run programs on your machine remotely!).

3

 Get your developer license. 
You already obtained a free developer license from 
Microsoft when you installed Visual Studio. You need 
that license in order to sideload apps onto a machine. 
Luckily, the Remote Debugging Monitor will pop up a 
wizard to get it automatically.

4

 Now...save some humans! 
Once you get through that setup, your program will start running on the 
remote machine. Since it’s sideloaded, if  you want to run it again you can 
just run it from the Windows Start page. Congratulations, you’ve built your 
first Windows Store app and loaded it onto another computer!

5

Invasion force, full retreat! That’s 
an order! These Earthlings are no 

pushovers. We’ll need to regroup and 
replan our attack.

Congratulations! You’ve 
held off the alien 
invasion...for now. But we have a feeling that this 
isn’t the last we’ve heard of them.
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Under the hood

You’re a programmer, not just an IDE user.� 
You can get a lot of work done using the IDE. But there’s only so far it 

can take you. Sure, there are a lot of repetitive tasks that you do when 

you build an application. And the IDE is great at doing those things for 

you. But working with the IDE is only the beginning. You can get your 

programs to do so much more—and writing C# code is how you do it. 

Once you get the hang of coding, there’s nothing your programs can’t do.

One of these days 
I’ll figure out 
what’s going on 
under there…
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When you’re doing this…
The IDE is a powerful tool—but that’s all it is, a tool for you to use. Every time 
you change your project or drag and drop something in the IDE, it creates code 
automatically. It’s really good at writing boilerplate code, or code that can be 
reused easily without requiring much customization. 

Let’s look at what the IDE does in a typical application development, when you’re…

The Properties window in the IDE is a really easy way to edit a specific chunk of XAML code in MainPage.xaml automatically, and it can save you time. Use the Alt-Enter shortcut to open the Properties window if it’s closed.

at your service

Creating a Windows Store project
There are several kinds of  applications the IDE lets 
you build. We’ll be concentrating on Windows Store 
applications for now—you’ll learn about other kinds of  
applications in the next chapter.

1

Dragging a control out of the 
toolbox and onto your page, and 
then double-clicking it
Controls are how you make things happen in your page. 
In this chapter, we’ll use Button controls to explore 
various parts of  the C# language.

2

Setting a property on your page
The Properties window in the IDE is a really 
powerful tool that you can use to change attributes of  
just about everything in your program: all visual and 
functional properties for the controls on your page, 
and even options on your project itself.

3

All of these tasks have to 
do with standard actions 
and boilerplate code. Those 
are the things the IDE is 
great for helping with.

In Chapter 1, you created a blank Windows Store project—that told the IDE to create an empty page and add it to your new project.
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…the IDE does this

private void startButton_Click(object sender, RoutedEventArgs e) 
{ 
 
}

MainPage.xaml.cs

Save The Humans 
.csproj

MainPage.xaml.cs SplashScreen.png Properties

The IDE knows how to add an empty method 
to handle a button click. But it doesn’t know 
what to put inside it—that’s your job.

<Button x:Name="startButton" 

                Content="Start!" 

                HorizontalAlignment="Center" 

                VerticalAlignment="Center" Click="startButton_Click"/>

The IDE went into this file…

…and updated this XAML code.

These files are created from a predefined template that contains the basic code to create and display a page.

...the IDE opens the MainPage.xaml file 
and updates a line of XAML code.

3

...The IDE adds code to MainPage.xaml that adds a 
button, and then adds a method to MainPage.xaml.cs 
that gets run any time the button is clicked.

2

...the IDE creates the files and 
folders for the project.

1

Every time you make a change in the IDE, it makes a 
change to the code, which means it changes the files that 
contain that code. Sometimes it just modifies a few lines, 
but other times it adds entire files to your project.

MainPage.xaml

MainPage.xaml

MainPage.xaml
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Where programs come from
A C# program may start out as statements in a bunch of  
files, but it ends up as a program running in your computer. 
Here’s how it gets there. 

great, the “talk”

Every program starts out as source code f i les
You’ve already seen how to edit a program, and how the IDE saves your program to 
files in a folder. Those files are your program—you can copy them to a new folder 
and open them up, and everything will be there: pages, resources, code, and anything 
else you added to your project.

You can think of  the IDE as a kind of  fancy file editor. It automatically does the 
indenting for you, changes the colors of  the keywords, matches up brackets for you, 
and even suggests what words might come next. But in the end, all the IDE does is 
edit the files that contain your program.

The IDE bundles all of  the files for your program into a solution by creating a 
solution (.sln) file and a folder that contains all of  the other files for the program. The 
solution file has a list of  the project files (which end in .csproj) in the solution, and the 
project files contain lists of  all the other files associated with the program. In this 
book, you’ll be building solutions that only have one project in them, but you can 
easily add other projects to your solution using the IDE’s Solution Explorer.

Build the program to create an executable
When you select Build Solution from the Build menu, the IDE compiles 
your program. It does this by running the compiler, which is a tool that 
reads your program’s source code and turns it into an executable. The 
executable is a file on your disk that ends in .exe—that’s the actual program 
that Windows runs. When you build the program, it creates the executable 
inside the bin folder, which is inside the project folder. When you publish 
your solution, it copies the executable (and any other files necessary) into 
into a package that can be uploaded to the Windows Store or sideloaded.

When you select Start Debugging from the Debug menu, the IDE compiles 
your program and runs the executable. It’s got some more advanced tools 
for debugging your program, which just means running it and being able 
to pause (or “break”) it so you can figure out what’s going on.

There’s no reason you 
couldn’t build your 
programs in Notepad, 
but it’d be a lot 
more time-consuming.
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Your program runs inside the Common Language Runt ime
Every program in Windows 8 runs on an architecture called the Windows Runtime. But 
there’s an extra “layer” between the Windows Runtime and your program called the 
Common Language Runtime, or CLR. Once upon a time, not so long ago (but before 
C# was around), writing programs was harder, because you had to deal with hardware and 
low-level machine stuff. You never knew exactly how someone was going to configure his 
computer. The CLR—often referred to as a virtual machine—takes care of  all that for 
you by doing a sort of  “translation” between your program and the computer running it.

You’ll learn about all sorts of  things the CLR does for you. For example, it tightly manages 
your computer’s memory by figuring out when your program is finished with certain pieces 
of  data and getting rid of  them for you. That’s something programmers used to have to do 
themselves, and it’s something that you don’t have to be bothered with. You won’t know it 
at the time, but the CLR will make your job of  learning C# a whole lot easier.

You don’t really have to worry 
about the CLR much right 
now. It’s enough to know it’s 
there, and takes care of 
running your program for you 
automatically. You’ll learn more 
about it as you go.

You can see an overview of .NET for Windows Store apps here:
http://msdn.microsoft.com/en-us/library/windows/apps/br230302.aspx

The .NET Framework gives you the right tools for the job
C# is just a language—by itself, it can’t actually do anything. And that’s where the .NET 
Framework comes in. Those controls you dragged out of  the toolbox? Those are all part of  
a library of  tools, classes, methods, and other useful things. It’s got visual tools like the XAML 
toolbox controls you used, and other useful things like the DispatcherTimer that made your 
Save the Humans game work.

All of  the controls you used are part of  .NET for Windows Store apps, which contains 
an API with grids, buttons, pages, and other tools for building Windows Store apps. But for 
a few chapters starting with Chapter 3, you’ll learn all about writing desktop applications, 
which are built using tools from the .NET for Windows Desktop (which some people call 

“WinForms”). It’s got tools to build desktop applications from windows that hold forms with 
checkboxes, buttons, and lists. It can draw graphics, read and write files, manage collections 
of  things…all sorts of  tools for a lot of  jobs that programmers have to do every day. The 
funny thing is that Windows Store apps need to do those things, too! One of  the things 
you’ll learn by the end of  this book is how Windows Store and Windows Desktop apps do 
some of  those things differently. That’s the kind of  insight and understanding that helps good 
programmers become great programmers.

The tools in both the Windows Runtime and the .NET Framework are divided up into 
namespaces. You’ve seen these namespaces before, at the top of  your code in the “using” lines. 
One namespace is called Windows.UI.Xaml.Conrols—it’s where your buttons, checkboxes, 
and other controls come from. Whenever you create a new Windows Store project, the IDE will 
add the necessary files so that your project contains a page, and those files have the line “using 
Windows.UI.Xaml.Controls;” at the top. 

An API, or Application 
Programming Interface, is 
a collection of code tools 
that you use to access 
or control a system. 
Many systems have APIs, 
but they’re especially 
important for operating 
systems like Windows.



58    Chapter 2

The IDE helps you code
You’ve already seen many of  the things that the IDE can do. 
Let’s take a closer look at some of  the tools it gives you, to 
make sure you’re starting off  with all the tools you need.

The Solution Explorer shows you everything 
in your project
You’ll spend a lot of  time going back and forth between classes, and the easiest 
way to do that is to use the Solution Explorer. Here’s what the Solution Explorer 
looked like after creating a blank app called App1:

≥

Use the tabs to switch between open files
Since your program is split up into more than one file, you’ll usually have several 
code files open at once. When you do, each one will be in its own tab in the code 
editor. The IDE displays an asterisk (*) next to a filename if  it hasn’t been saved yet.

≥

When you’re working on a program, you’ll often have two 
tabs for it at the same time—one for the designer, and 
one to view the code. Use Control-Tab to switch between 
open windows quickly.

The Solution 
Explorer 
shows you the 
different files 
in the solution 
folder.

mother’s little helper
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The Error List helps you troubleshoot 
compiler errors
If  you haven’t already discovered how easy it is to make typos in a C# 
program, you’ll find out very soon! Luckily, the IDE gives you a great tool for 
troubleshooting them. When you build your solution, any problems that keep it 
from compiling will show up in the Error List window at the bottom of  the IDE:

Double-click on an error, and the IDE will jump to the problem in the code:

≥

The IDE helps you write code
Did you notice little windows popping up as you typed code into the IDE? That’s 
a feature called IntelliSense, and it’s really useful. One thing it does is show you 
possible ways to complete your current line of  code. If  you type random and then a 
period, it knows that there are three valid ways to complete that line:

If  you select Next and type (, the IDE’s IntelliSense will show you information 
about how you can complete the line.

The IDE knows that random 
has methods Next, NextBytes, 
NextDouble, and four others. If you type N, it selects Next. Type “(” 
or space, Tab, or Enter to tell the 
IDE to fill it in for you. That can 
be a real timesaver if you’re typing 
a lot of really long method names.

This means that there are 3 different ways that 
you can call the Random.Next() method.

When you use the debugger to 
run your program inside the IDE, 
the first thing it does is build 
your program. If it compiles, 
then your program runs. If not, 
it won’t run, and will show you 
errors in the Error List.

The IDE will show a squiggly 
underscore to show you that 
there’s an error. Hover over it 
to see the same error message 
that appears in the Error List.

A missing 
semicolon at 
the end of a 
statement is 
one of the most 
common errors 
that keeps your 
program from 
building.

≥
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Anatomy of a program

Namespace
Class

Method 1 
statement 
statement

Method 2 
statement 
statement

Every time you make a new program, you define a namespace for it so that its code is separate from the .NET Framework and Windows Store API classes.

A class has one or more methods. Your methods always have to live 
inside a class. And methods are 
made up of statements—like the 
ones you’ve already seen.

A class contains a piece of your  
program (although some very small 
programs can have just one class). 

The code file starts by using the .NET Framework tools 
You’ll find a set of  using lines at the top of  every program file. They tell C# which parts of  the 
.NET Framework or Windows Store API to use. If  you use other classes that are in other namespaces, 
then you’ll add using lines for them, too. Since apps often use a lot of  different tools from the .NET 
Framework and Windows Store API, the IDE automatically adds a bunch of  using lines when it 
creates a page (which isn’t quite as “blank” as it appeared) and adds it to your project.

1

Every C# program’s code is structured in exactly the 
same way. All programs use namespaces, classes, 
and methods to make your code easier to manage.

Let’s take a closer look at your code
Open up the code from your Save the Humans project’s 
MainPage.xaml.cs so we can have a closer look at it.

using System;
using System.Collections.Generic;
using System.IO;
using System.Linq;
using Windows.Foundation;
using Windows.Foundation.Collections;
using Windows.UI.Xaml;

These using lines are at the top of every code file. They tell C# to use all of those .NET Framework classes. Each one tells your program that the classes in this particular .cs file will use all of the classes in one specific .NET Framework (System) or Windows Store API namespace.

your program makes a statement

One thing to keep in mind: you don’t actually have to use a using statement. You can always use 
the fully qualified name. Back in your Save the Humans app, you added this line:

using Windows.UI.Xaml.Media.Animation;

Try commenting out that line by adding // in front of  it, then have a look at the errors that show 
up in the error list. You can make one of  them go away. Find a Storyboard that the IDE now tells 
you has an error, and change it to Windows.UI.Xaml.Media.Animation.Storyboard  (but you 
should undo the comment you added to make your program work again).

The order of the 
methods in the 
class file doesn’t 
matter—method 
2 can just as 
easily come 
before method 1.
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This is the method called StartGame() that gets 

called when the user clicks the Start button.

namespace Save_the_Humans

{

  public sealed partial class MainPage : Page

  {

        void startButton_Click(object sender, object e)

        {

            StartGame();

        }

C# programs are organized into classes 
Every C# program is organized into classes. A class can do anything, but most classes 
do one specific thing. When you created the new program, the IDE added a class called 
MainPage that displays the page.

2

Classes contain methods that perform actions 
When a class needs to do something, it uses a method. A method takes input, performs some 
action, and sometimes produces an output. The way you pass input into a method is by using 
parameters. Methods can behave differently depending on what input they’re given. Some 
methods produce output. When they do, it’s called a return value. If  you see the keyword 
void in front of  a method, that means it doesn’t return anything.

3

A statement performs one single action 
When you filled in the StartGame() method, you added a bunch of  statements. Every 
method is made up of  statements. When your program calls a method, it executes the first 
statement in the method, then the next, then the next, etc. When the method runs out of  
statements or hits a return statement, it ends, and the program resumes after the statement 
that originally called the method.

4

This is a class called MainPage. It contains all of the code to make the page work. The 
IDE created it when you told it to create a new blank C# Windows Store project.

This line calls a method named 
StartGame(), which the IDE 
helped you create when you 
asked it to add a method stub.

This method 
has two 
parameters 
called sender 
and e. 

Look for the 
matching pairs 
of brackets. 
Every { is 
eventually 
paired up with 
a }. Some 
pairs can be 
inside others.

When you called your program Save the Humans, the IDE created a namespace for it called Save_the_Humans (it converted the spaces to underscores because namespaces can’t have spaces) by adding the namespace keyword at the top of your code file. Everything inside its pair of curly brackets is part of the Save_the_Humans namespace.

        private void StartGame()
        {
            human.IsHitTestVisible = true;
            humanCaptured = false;
            progressBar.Value = 0;
            startButton.Visibility =
                         Visibility.Collapsed;
            playArea.Children.Clear();
            playArea.Children.Add(target);
            playArea.Children.Add(human);
            enemyTimer.Start();
            targetTimer.Start();
        }
      }

    }

The StartGame() method contains 
nine statements. Each statement 
ends with a semicolon.

Here’s the closing bracket at the very 
bottom of your MainPage.xaml.cs file.

It’s OK to add extra line breaks to make your statements more readable. They’re ignored when your program builds.
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get some answers

Q: What’s with all the curly brackets?

A:  C# uses curly brackets (or “braces”) to group statements 
together into blocks. Curly brackets always come in pairs. You’ll 
only see a closing curly bracket after you see an opening one. The 
IDE helps you match up curly brackets—just click on one, and you’ll 
see it and its match get shaded darker. 

Q: How come I get errors in the Error List window when I try 
to run my program? I thought that only happened when I did 

“Build Solution.”

A: Because the first thing that happens when you choose Start 
Debugging from the menu or press the toolbar button to start your 
program running is that it saves all the files in your solution and then 
tries to compile them. And when you compile your code—whether 
it’s when you run it, or when you build the solution—if there are 
errors, the IDE will display them in the Error List instead of running 
your program.

A lot of the errors that show up when you try to run your program also show up in the Error List window and as red squiggles under your code.

So the IDE can really 

help me out. It generates 

code, and it also helps me find 

problems in my code.

The IDE helps you build your code right.

A long time ago, programmers had to use simple text 
editors like Notepad to edit their code. (In fact, they would 
have been envious of  some of  the features of  Notepad, like 
search and replace or ^G for “go to line number.”) We had 
to use a lot of  complex command-line applications to build, 
run, debug, and deploy our code.

Over the years, Microsoft (and, let’s be fair, a lot of  other 
companies, and a lot of  individual developers) figured out 
a lot of  helpful things like error highlighting, IntelliSense, 
WYSIWYG click-and-drag page editing, automatic code 
generation, and many other features. 

After years of  evolution, Visual Studio is now one of  the 
most advanced code-editing tools ever built. And lucky for 
you, it’s also a great tool for learning and exploring C# and 
app development.
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Set properties for a TextBlock control

Match each of  these fragments of  code generated by the IDE to what it does. 
(Some of  these are new—take a guess and see if  you got it right!)

myGrid.Background = 
    new SolidColorBrush(Colors.Violet);

partial class Form1 
{   .   .   . 
  this.MaximizeBox = false;   .   .   . 
}

helloLabel.Text = "hi there";            
helloLabel.FontSize = 24;

public sealed partial class MainPage : Page 
{ 
  private void InitializeComponent() 
  {   .   .   .    } 
}

 // This loop gets executed three times

 /// <summary> 
 /// Bring up the picture of Rover when 
 /// the button is clicked 
 /// </summary>

Nothing—it’s a comment that the 
programmer added to explain the code 
to anyone who’s reading it

Disable the maximize icon (      ) in the 
title bar of  the Form1 window

A special kind of  comment that the IDE 
uses to explain what an entire block of  
code does

Change the background color of  a Grid 
control named myGrid

A method that executes whenever a 
program displays its main page
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Match each of  these fragments of  code generated by the IDE to what it does. 
(Some of  these are new—take a guess and see if  you got it right!)

exercise solution

Wait, a window? Not a page? 
You’ll start learning about 
desktop apps with windows and 
forms later in this chapter.

Set properties for a TextBlock controlmyGrid.Background = 
    new SolidColorBrush(Colors.Violet);

partial class Form1 
{   .   .   . 
  this.MaximizeBox = false;   .   .   . 
}

helloLabel.Text = "hi there";            
helloLabel.FontSize = 24;

public sealed partial class MainPage : Page 
{ 
  private void InitializeComponent() 
  {   .   .   .    } 
}

 // This loop gets executed three times

 /// <summary> 
 /// Bring up the picture of Rover when 
 /// the button is clicked 
 /// </summary>

Nothing—it’s a comment that the 
programmer added to explain the code 
to anyone who’s reading it

Disable the maximize icon (      ) in the 
title bar of  the Form1 window

A special kind of  comment that the IDE 
uses to explain what an entire block of  
code does

Change the background color of  a Grid 
control named myGrid

A method that executes whenever a 
program displays its main page
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namespace PetFiler2 {

 
  class Fish {

      public void Swim() { 
        // statements 
      }

   }

   partial class Cat {

      public void Purr() { 
         // statements 
      }

   } 
 }

MoreClasses.cs

SomeClasses.cs

namespace PetFiler2 {

 
   class Dog {

      public void Bark() { 
        // statements go here 
      }

   }

   partial class Cat {

      public void Meow() { 
         // more statements 
      }

   } 
}

Take a look at these two class files from a 
program called PetFiler2. They’ve got 
three classes: a Dog class, a Cat class, and 
a Fish class. Since they’re all in the same 
PetFiler2 namespace, statements in the 
Dog.Bark() method can call Cat.Meow() 
and Fish.Swim(). It doesn’t matter how 
the various namespaces and classes are divided 
up between files. They still act the same when 
they’re run. When a method is “public” 

it means every other 
class in the namespace 
can access its methods.

Two classes can be in the 
same namespace

You can only split a class up into different files 
if you use the “partial” keyword. You probably 
won’t do that in any of the code you write in 
this book, but the IDE used it to split your 
page up into two files so it could put the 
XAML code into MainPage.xaml and the C# 
code into MainPage.xaml.cs.

Since these classes are in the same namespace, 
they can all “see” each other—even though 
they’re in different files. A class can span 
multiple files too, but you need to use the 

“partial” keyword when you declare it.

There’s more to namespaces and class declarations, but you 
won’t need them for the work you’re doing right now. Flip to #3 
in the “Leftovers” appendix to read more.
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Declare your variables
Whenever you declare a variable, you tell your program its type and its name. 
Once C# knows your variable’s type, it’ll keep your program from compiling 
if  you make a mistake and try to do something that doesn’t make sense,  like 
subtract “Fido” from 48353.

			 

		  int maxWeight;

		  string message;

		  bool boxChecked;

These are the names of these variables.These are the var
iable types.

These names are for YOU. 
Like methods and classes, use 
names that make sense and 
describe the variable’s usage.

C# uses the variable type to define what data these variables can hold.

your mileage may vary

Your programs use variables to work with data
When you get right down to it, every program is basically a data cruncher. 
Sometimes the data is in the form of  a document, or an image in a 
video game, or an instant message. But it’s all just data. And that’s where 
variables come in. A variable is what your program uses to store data.

Variables vary
A variable is equal to different values at different times while your 
program runs. In other words, a variable’s value varies. (Which is 
why “variable” is such a good name.) This is really important, because 
that idea is at the core of  every program that you’ve written or will ever 
write. So if  your program sets the variable myHeight equal to 63:

  int myHeight = 63;

any time myHeight appears in the code, C# will replace it with its 
value, 63. Then, later on, if  you change its value to 12:

  myHeight = 12;

C# will replace myHeight with 12—but the variable is still called 
myHeight.

Whenever your 
program needs to 
work with numbers, 
text, true/false 
values, or any other 
kind of data, you’ll 
use variables to keep 
track of them.

	        Are you 
already 
familiar with 
another 
language?

If so, you might find that a 
few things in this chapter 
seem really familiar. Still, it’s 
worth taking the time to run 
through the exercises anyway, 
because there may be a few 
ways that C# is different from 
what you’re used to.
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var-i-a-ble, noun.  
an element or feature likely to change. 
Predicting the weather would be a whole lot 
easier if  meterologists didn’t have to take so 
many variables into account.

If you write code 
that uses a variable 
that hasn’t been 
assigned a value, 
your code won’t 
compile. It’s easy to 
avoid that error 
by combining your 
variable declaration 
and assignment into 
a single statement.

You have to assign values to variables 
before you use them
Try putting these statements into a C# program:

   string z; 
   string message = "The answer is " + z;

Go ahead, give it a shot. You’ll get an error, and the IDE will 
refuse to compile your code. That’s because the compiler 
checks each variable to make sure that you’ve assigned it a 
value before you use it. The easiest way to make sure you 
don’t forget to assign your variables values is to combine 
the statement that declares a variable with a statement that 
assigns its value:

	 int maxWeight = 25000;

	 string message = "Hi!";

	 bool boxChecked = true;

These values 
are assigned to 
the variables.

Each declaration has a type, 
exactly like before.

Once you’ve assigned a value to your variable, that value can change. So there’s no disadvantage to assigning a variable an initial value when you declare it.

A few useful types
Every variable has a type that tells C# what kind of  data it can 
hold. We’ll go into a lot of  detail about the many different types 
in C# in Chapter 4. In the meantime, we’ll concentrate on the 
three most popular types. int holds integers (or whole numbers), 
string holds text, and bool holds Boolean true/false values.
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int number = 15;

number = number + 10;

number = 36 * 15;

number = 12 - (42 / 7);

number += 10;

number *= 3;

number = 71 / 3;

int count = 0;

count ++;

count --;

string result = "hello";

result += " again " + result;

output.Text = result;

result = "the value is: " + count;

result = "";

bool yesNo = false;

bool anotherBool = true;

yesNo = !anotherBool;

operators are standing by

C# uses familiar math symbols
Once you’ve got some data stored in a variable, what can you 
do with it? Well, if  it’s a number, you’ll probably want to add, 
subtract, multiply, or divide it. And that’s where operators come 
in. You already know the basic ones. Let’s talk about a few more. 
Here’s a block of  code that uses operators to do some simple math:

We declared a new 
int variable called 
number and set it to 
15. Then we added 10 
to it. After the second 
statement, number is 
equal to 25.

The third statement changes the 
value of number, setting it equal to 
36 times 15, which is 540. Then it 
resets it again, setting it equal to 
12 - (42 / 7), which is 6.

This operator is a little different. 
+= means take the value of number 
and add 10 to it. Since number is 
currently equal to 6, adding 10 to it 
sets its value to 16.

The *= operator 
is similar to +=, 
except it multiplies 
the current value of 
number by 3, so it 
ends up set to 48.

You’ll use int a lot for counting, and when you do, the ++ 
and -- operators come in handy. ++ increments count 
by adding one to the value, and -- decrements count by 
subtracting one from it, so it ends up equal to zero.

		�  Don’t worry about 
memorizing these 
operators now.

You’ll get to know them 
because you’ll see ’em over and over again.

A bool stores true 
or false. The ! 
operator means NOT. 
It flips true to 
false, and vice versa.

When you use the + operator 
with a string, it just puts 
two strings together. It’ll 
automatically convert 
numbers to strings for you.

This sets the 
contents of a 
TextBlock control 
named output to 
“hello again hello”.

The “” is an empty string. 
It has no characters. 
(It’s kind of like a zero 
for adding strings.)

Normally, 71 divided by 3 is 23.666666.... But when you’re 
dividing two ints, you’ll always get an int result, so 23.666… 
gets truncated to 23.

To programmers, the 
word “string” almost 
always means a string of 
text, and “int” is almost 
always short for integer.
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Debug this!

Flip the page and keep going!

When you set a breakpoint on a line of code, the line turns red and a red dot appears in the margin of the code editor.

When you debug your code by running it inside the IDE, as soon as your program hits a breakpoint it’ll pause and let you inspect and change the values of all the variables. 

The debugger is a great tool for understanding how your programs 
work. You can use it to see the code on the previous page in action.

Use the debugger to see your variables change

Create a new Visual C# Windows Store Blank App (XAML) project.
Drag a TextBlock onto your page and give it the name output. Then add a Button and double-click it 
to add a method called Button_Click(). The IDE will automatically open that method in the code 
editor. Enter all of  the code on the previous page into the method.

1

Insert a breakpoint on the first line of code.
Right-click on the first line of  code (int number = 15;) and choose Insert Breakpoint from the 
Breakpoint menu. (You can also click on it and choose Debug→Toggle Breakpoint or press F9.)

2

Creating a new 
Blank App project 

will tell the IDE 
to create a new 

project with a blank 
page. You might 
want to name it 
something like 

UseTheDebugger 
(to match the 
header of  this 

page). You’ll be 
building a whole 
lot of  programs 
throughout the 

book, and you may 
want to go back to 

them later.

Comments (which 
either start with two 
or more slashes or are 
surrounded by /* and 
*/ marks) show up 
in the IDE as green 
text. You don’t have 
to worry about what 
you type in between 
those marks, because 
comments are always 
ignored by the compiler.
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stop bugging me!

Start debugging your program.
Run your program in the debugger by clicking the Start Debugging 
button (or by pressing F5, or by choosing Debug→Start Debugging from 
the menu). Your program should start up as usual and display the page.

3

Click on the button to trigger the breakpoint.
As soon as your program gets to the line of  code that has the breakpoint, 
the IDE automatically brings up the code editor and highlights the 
current line of  code in yellow.

4

Add a watch for the number variable.
Right-click on the number variable (any occurrence of  it will do!) and 
choose  from the menu. The Watch window should appear in 
the panel at the bottom of  the IDE:

5

Step through the code.
Press F10 to step through the code. (You can also choose Debug→Step Over from 
the menu, or click the Step Over button in the Debug toolbar.) The current line 
of  code will be executed, setting the value of  number to 15. The next line of  
code will then be highlighted in yellow, and the Watch window will be updated:

6

Adding a 
watch can help 
you keep track 
of the values of 
the variables in 
your program. 
This will really 
come in handy 
when your 
programs get 
more complex.

As soon as the number 
variable gets a new 
value (15), its watch is 
updated.

Continue running the program.
When you want to resume, just press F5 (or Debug→Continue), and the 
program will resume running as usual.

7

When you’re debugging a 
Windows Store app, you can 
return to the debugger by 
pressing the Windows logo 
key+D. If you’re using a touch 
screen, swipe from the left 
edge of the screen to the 
right. Then you can pause or 
stop the debugger using the 
Debug toolbar or menu items.

IDE Tip: +D

You can also hover over a 
variable while you’re debugging 
to see its value displayed in  
a tooltip…and you can pin  
it so it stays open!
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That’s a big part of why 
Booleans are so important. 
A loop uses a test to figure 
out if it should keep looping.

Here’s a peculiar thing about most large programs: they almost always 
involve doing certain things over and over again. And that’s what 
loops are for—they tell your program to keep executing a certain set 
of  statements as long as some condition is true (or false!).

while (x > 5)

{

    x = x - 3;

}

for (int i = 0; i < 8; i = i + 2)

{

    // Everything between these brackets 
    // is executed 4 times

}

Every for loop has three statements. The first sets 
up the loop. It will keep looping as long as the second 
statement is true. And the third statement gets 
executed after each time through the loop.

In a while loop, all of the 
statements inside the curly 
brackets get executed as 
long as the condition in the 
parentheses is true.

Use a code snippet to write simple for loops
You’ll be typing for loops in just a minute, and the IDE can help 
speed up your coding a little. Type for followed by two tabs, 
and the IDE will automatically insert code for you. If  you type 
a new variable, it’ll automatically update the rest of  the snippet. 
Press Tab again, and the cursor will jump to the length.

If you change the variable to 
something else, the snippet 
automatically changes the 
other two occurrences of it.

Press Tab to get the cursor to jump to the length. The number of times this loop runs is determined by whatever you set length to. You can change length to a number or a variable.

Loops perform an act ion over and over
If your brackets (or braces—either name 
will do) don’t match up, your program 
won’t build, which leads to frustrating 
bugs. Luckily, the IDE can help with this! 
Put your cursor on a bracket, and the 
IDE highlights its match:

IDE Tip: Brackets
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if/else statements make decisions
Use if/else statements to tell your program to do certain 
things only when the conditions you set up are (or aren’t) 
true. A lot of  if/else statements check if  two things are equal. 
That’s when you use the == operator. That’s different from the 
single equals sign (=) operator, which you use to set a value.

	        Don’t confuse the two equals sign operators!

You use one equals sign (=) to set a variable’s value, but two equals 
signs (==) to compare two variables. You won’t believe how many bugs in 
programs—even ones made by experienced programmers!—are caused 

by using = instead of ==. If you see the IDE complain that you “cannot implicitly 
convert type ‘int’ to ‘bool’, that’s probably what happened.

if (someValue == 24)

{

    // You can have as many statements 
    // as you want inside the brackets

    message = "The value was 24.";

} else {

    message = "The value wasn’t 24.";

}

string message = "";

if (someValue == 24)

{

    message = "The value was 24.";

}

Every if statement 
starts with a 
conditional test.

The statement inside 
the curly brackets is 
executed only if the 
test is true.

if/else statements are 
pretty straightforward. 
If the conditional 
test is true, the 
program executes the 
statements between the 
first set of brackets. 
Otherwise, it executes 
the statements between 
the second set.

Always use two equals signs to check if 

two things are equal to each othe
r.

on one condition
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Build an app from the ground up
The real work of  any program is in its statements. You’ve already seen how statements fit into 
a page. Now let’s really dig into a program so you can understand every line of  code. Start by 
creating a new Visual C# Windows Store Blank App project. This time, instead of  deleting 
the MainPage.xaml file created by the Blank App template, use the IDE to modify it by adding three 
rows and two columns to the grid, then adding four Button controls and a TextBlock to the cells. Build this page

You don’t see anything here, but there’s actually a 
TextBlock control. It doesn’t have any text, so it’s 
invisible. It’s centered and in the bottom row, with 
ColumnSpan set to 2 so it spans both columns.

The page has a grid with three rows 
and two columns. Each row definition 
has its height set to 1*,  which gives 

it a <RowDefinition/> without any 
properties. The column heights work the 

same way.

The page has four Button controls, one in 
each row. Use the Content property to 
set their text to Show a message, If/else, 

Another conditional test, and A loop.

Each button is centered in the cell. Use the 
Grid.Row and Grid.Column properties to set 
the row and column (they default to 0).

The bottom cell has a TextBlock control 
named myLabel. Use its Style property 

to set the style to BodyTextStyle.

Use the x:Name property to name the buttons 
button1, button2, button3, and button4. 
Once they’re named, double-click on each of  

them to add an event handler method.

When you see these sneakers, it 
means that it’s time for you to 
come up with code on your own.

If you need to use the Edit Style right-mouse menu to 
set this but you’re having trouble selecting the control, 
you can right-click on the TextBlock control in the 
Document Outline and choose Edit Style from there.

Make sure you choose a sensible name for this project, 
because you’ll refer back to it later in the book.
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ready, set, code!

Here’s our solution to the exercise. Does 
your solution look similar? Are the line 
breaks different, or the properties in a 
different order? If so, that’s OK!

Here are the row and 
column definitions: three 
rows and two columns.

This button is in the 
second column and 
second row, so these 
properties are set to 1.

When you double-clicked 
on each button, the IDE 
generated a method with 
the name of the button 
followed by _Click.

Why do you think the left column and top row are given the 
number 0, not 1? Why is it OK to leave out the Grid.Row 
and Grid.Column properties for the top-left cell?

Here’s the <Page> 
and <Grid> tags 
that the IDE 
generated for you 
when you created 
the blank app.

A lot of  programmers don’t use the 
IDE to create their XAML—they build 
it by hand. If  we asked you to type in 
the XAML by hand instead of  using 
the IDE, would you be able to do it?
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≥≥ Don’t forget that all your statements 
need to end in a semicolon: 
 
	 name = "Joe";

≥≥ You can add comments to your code 
by starting them with two slashes: 
 
	 // this text is ignored

≥≥ Variables are declared with a name 
and a type (there are plenty of types 
that you’ll learn about in Chapter 4): 
 
	 int weight; 
	// weight is an integer

≥≥ The code for a class or a method goes 
between curly braces: 
 
	 public void Go() { 
	   // your code here 
	}

≥≥ Most of the time, extra whitespace is 
fine: 
 
	 int j     =      1234  ; 
 
is the same as: 
 
	 int j = 1234;

private void button1_Click(object sender, RoutedEventArgs e)

{

    // this is a comment

    string name = "Quentin";

    int x = 3;

    x = x * 17;

    double d = Math.PI / 2;

    myLabel.Text = "name is " + name

        + "\nx is " + x

        + "\nd is " + d;

}

A few helpful tips

x is a variable. The “int” 
part tells C# that it’s 
an integer, and the rest 
of the statement sets 
its value to 3.

There’s a built-in class called Math, and it’s got a member called PI. Math lives in the System namespace, so the file this code came from needs to have a using System; line at the top.

The \n is an escape sequence 
to add a line break to the 
TextBlock text.

Make each button do something
Here’s how your program is going to work. Each time you press one 
of  the buttons, it will update the TextBlock at the bottom (which you 
named myLabel) with a different message. The way you’ll do it is 
by adding code to each of  the four event handler methods that you 
had the IDE generate for you. Let’s get started!

Luckily, the IDE generated the using line for you.

This line creates the output of the program: the updated text in the TextBlock named myLabel.

Make button1 update the label. 

Go to the code for the  button1_Click() method and fill in 
the code below. This is your chance to really understand what 
every statement does, and why the program will show this output:

Here’s the code for the button:

1

Flip the page to finish your program! 

Run your program and make 
sure the output matches the 
screenshot on this page.

Do this!
When you see a “Do this!”, pop 
open the IDE and follow along. 
We’ll tell you exactly what to 
do, and point out what to look 
for to get the most out of 
the example we show you.
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Set up condit ions and see if they’re true
Use if/else statements to tell your program to do certain 
things only when the conditions you set up are (or aren’t) true.

private void button2_Click(object sender, RoutedEventArgs e)
{
    int x = 5;
    if (x == 10)
    {
        myLabel.Text = "x must be 10";
    }
    else
    {
        myLabel.Text = "x isn’t 10";
    }
}

Here’s the output. See if you can tweak one line 
of code and get it to say “x must be 10” instead.

the things you can do

Make sure you stop your program before you do this—the IDE won’t let you edit the code while the program’s running. You can stop it by closing the window, using the stop button on the toolbar, or selecting Stop Debugging from the Debug menu.

Use logical operators to check condit ions
You’ve just looked at the == operator, which you use to test whether two 
variables are equal. There are a few other operators, too. Don’t worry about 
memorizing them right now—you’ll get to know them over the next few 
chapters.

≥≥ The != operator works a lot like ==, except it’s true if  the two things 
you’re comparing are not equal.

≥≥ You can use > and < to compare numbers and see if  one is bigger or 
smaller than the other. 

≥≥ The ==, !=, >, and < operators are called conditional operators. 
When you use them to test two variables or values, it’s called 
performing a conditional test.

≥≥ You can combine individual conditional tests into one long test using 
the && operator for AND and the || operator for OR. So to check if  
i equals 3 or j is less than 5, do (i == 3) || (j < 5).

When you use 
a conditional 
operator to 
compare two 
numbers, it’s 
called a 
conditional test.

First we set 
up a variable 
called x and 
make it equal 
to 5.  Then we check if it’s 
equal to 10.

Set a variable and then check its value. 

Here’s the code for the second button. It’s an if/else statement 
that checks an integer variable called x to see if  it’s equal to 10.

2



you are here 4    77

it’s all just code

private void button3_Click(object sender, RoutedEventArgs e)

{

    int someValue = 4;

    string name = "Bobbo Jr.";

    if ((someValue == 3) && (name == "Joe"))

    {

        myLabel.Text = "x is 3 and the name is Joe";

    }

    myLabel.Text = "this line runs no matter what";

}

This line checks someValue to 
see if it’s equal to 3, and then 
it checks to make sure name 
is “Joe”.

Before you click on the button, read through the code and try to figure out what the 
TextBlock will show. Then click the button and see if you were right!

private void button4_Click(object sender, RoutedEventArgs e)
{

    int count = 0;

    while (count < 10)
    {
        count = count + 1;
    }

    for (int i = 0; i < 5; i++)
    {
        count = count - 1;
    }

    myLabel.Text = "The answer is " + count;
}

The second part of the for statement is 
the test. It says “for as long as i is les

s than 

five, the loop should keep on going.” The 
test is run before the code block, and 

the 
block is executed only if the test is tr

ue.

This sets up the loop. 
It just assigns a 
value to the integer 
that’ll be used in it. 

This statement gets executed at 
the end of each loop. In this case, 
it adds one to i every time the 
loop executes. This is called the 
iterator, and it’s run immediately 
after all the statements in the 
code block.

This loop keeps 
repeating as long as 
the count variable 
is less than 10.

Add another conditional test. 

The third button makes this output. Then change it so someValue is set to 3 instead of  4. The TextBlock 
gets updated twice, but it happens so fast that you can’t see it. Put a breakpoint on the first statement and 
step through the method, using Alt-Tab to switch to the app and back to make sure the TextBlock gets 
updated.

3

Add loops to your program. 

Here’s the code for the last button. It’s got two loops. The first is a while loop, which 
repeats the statements inside the brackets as long as the condition is true—do something 
while this is true. The second one is a for loop. Take a look and see how it works.

4



78    Chapter 2

More about conditional tests
You can do simple conditional tests by checking the value of a variable using a comparison operator. Here’s how you compare two ints, x and y:
   x < y (less than) 
   x > y (greater than) 
   x == y (equals - and yes, with two equals signs)

These are the ones you’ll use most often.

int result = 0; // this variable will hold the final result

int x = 6; // declare a variable x and

while (x > 3) {

  // execute these statements as long as 

  result = result + x; // add x

  x = x - 1; // subtract

}

for (int z = 1; z < 3; z = z + 1) {

  // start the loop by

  // keep looping as long as

  // after each loop,

  result = result + z; //

}

// The next statement will update a TextBlock with text that says

//

myLabel.Text = "The result is " + result;

Let’s get a little more practice with conditional tests and loops. Take a 
look at the code below. Circle the conditional tests, and fill in the blanks 
so that the comments correctly describe the code that’s being run.

set it to 6
We filled in the 
first one for you.

over and over and over and…
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Wait up! There’s a flaw in your 
logic. What happens to my loop if I 

write a conditional test that never 
becomes false?

Then your loop runs forever!

Every time your program runs a conditional test, the result 
is either true or false. If  it’s true, then your program 
goes through the loop one more time. Every loop should 
have code that, if  it’s run enough times, should cause 
the conditional test to eventually return false. But if  it 
doesn’t, then the loop will keep running until you kill the 
program or turn the computer off !

Can you think of a reason that you’d want to write a 
loop that never stops running? 

Here are a few loops. Write down if each loop will repeat forever or 
eventually end. If it’s going to end, how many times will it loop?

Loop #1
int count = 5;

while (count > 0) {

   count = count * 3;

   count = count * -1;

}

Loop #2
int i = 0;

int count = 2;

while (i == 0) {

   count = count * 3;

   count = count * -1;

}

Loop #3
int j = 2;
for (int i = 1; i < 100;
     i = i * 2) 
{
    j = j - 1;
    while (j < 25)
    {
        j = j + 5;
    }
}

Loop #5
int p = 2;

for (int q = 2; q < 32;

     q = q * 2)

{

   while (p < q)

   {

      p = p * 2;

   }

   q = p - q;

}

Loop #4

while (true) { int i = 1;}

This is sometimes called an infinit
e loop, 

and there are actu
ally times when you’ll 

want to use one in y
our program.

Remember, a for loop always 
runs the conditional test at the 
beginning of the block, and the 
iterator at the end of the block.

Hint: p starts out equal to 2. Think about when the iterator “p = p * 2” is executed.

For Loop #3, how 
many times will this 
statement be executed?

For Loop #5, how 
many times will this 
statement be executed?
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int result = 0; // this variable will hold the final result

int x = 6; // declare a variable x and

while (x > 3) {

// execute these statements as long as

 
result = result + x; // add x

x = x - 1; // subtract

}

for (int z = 1; z < 3; z = z + 1) {

// start the loop by

// keep looping as long as

// after each loop,

result = result + z; //

}

// The next statement will update a TextBlock with text that says

//

myLabel.Text = "The result is " + result;

set it to 6

x is greater than 3

to the result variable

1 from the value of x

declaring a variable z and setting it to 1
z is less than 3

add 1 to z

The result is 18

add the value of z to result

Let’s get a little more practice with conditional tests and loops. Take a 
look at the code below. Circle the conditional tests, and fill in the blanks 
so that the comments correctly describe the code that’s being run.

Here are a few loops. Write down if each loop will repeat forever or 
eventually end. If it’s going to end, how many times will it loop?

Loop #1 
This loop executes once

Loop #2 
This loop runs forever

Loop #3 
This loop executes 7 times

Loop #4 
Another infinite loop

Loop #5 
This loop 
executes 8 times

if only, but only if

This loop runs twice—first with z set to 1, and 
then a second time with z set to 2. Once it hits 
3, it’s no longer less than 3, so the loop stops.

Take the time to really figure this one out. Here’s a perfect opportunity to try out the debugger on your own! Set a 
breakpoint on the statement q = p - q;. Add watches for the variables p and q and step through the loop.
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Q: Is every statement always in a class?

A: Yes. Any time a C# program does something, it’s because 
statements were executed. Those statements are a part of classes, 
and those classes are a part of namespaces. Even when it looks 
like something is not a statement in a class—like when you use 
the designer to set a property on a control on your page—if you 
search through your code you’ll find that the IDE added or changed 
statements inside a class somewhere.

Q: Are there any namespaces I’m not allowed to use? Are 
there any I have to use?

A: Yes, there are a few namespaces that will technically work, but 
which you should avoid. Notice how all of the using lines at the 
top of your C# class files always said System? That’s because 
there’s a System namespace that’s used by the Windows Store 
API and the .NET Framework. It’s where you find all of your important 
tools to add power to your programs, like System.Linq, which 
lets you manipulate sequences of data, and System.IO, which 
lets you work with files and data streams. But for the most part, you 
can choose any name you want for a namespace (as long as it only 
has letters, numbers, and underscores). When you create a new 
program, the IDE will automatically choose a namespace for you based 
on the program’s name.

Q: I still don’t get why I need this partial class stuff.

A: Partial classes are how you can spread the code for one class 
between more than one file. The IDE does that when it creates 
a page—it keeps the code you edit in one file (like MainPage.
xaml), and the code it modifies automatically for you in another file 
(MainPage.xaml.cs). You don’t need to do that with a namespace, 
though. One namespace can span two, three, or a dozen or more 
files. Just put the namespace declaration at the top of the file, and 
everything within the curly brackets after the declaration is inside 
the same namespace. One more thing: you can have more than one 
class in a file. And you can have more than one namespace in a file. 
You’ll learn a lot more about classes in the next few chapters.

Q: Let’s say I drag something onto my page, so the IDE 
generates a bunch of code automatically. What happens to that 
code if I click Undo?

A: The best way to answer this question is to try it! Give it a shot—
do something where the IDE generates some code for you. 
Drag a button on a page, change properties. Then try to undo it. 
What happens? For most simple things, you’ll see that the IDE is 
smart enough to undo it itself. (For some more complex things, like 
working with databases, you might be given a warning message that 
you’re about to make a change that the IDE can’t undo. You won’t 
see any of those in this book.)

Q: So exactly how careful do I have to be with the code that’s 
automatically generated by the IDE?

A: You should generally be pretty careful. It’s really useful to 
know what the IDE is doing to your code, and once in a while you’ll 
need to know what’s in there in order to solve a serious problem. But 
in almost all cases, you’ll be able to do everything you need to do 
through the IDE.

¢¢ You tell your program to perform actions using 
statements. Statements are always part of classes, and 
every class is in a namespace.

¢¢ Every statement ends with a semicolon (;).

¢¢ When you use the visual tools in the Visual Studio IDE, 
it automatically adds or changes code in your program.

¢¢ Code blocks are surrounded by curly braces { }. 
Classes, while loops, if/else statements, and lots of 
other kinds of statements use those blocks.

¢¢ A conditional test is either true or false. You use 
conditional tests to determine when a loop ends, and 
which block of code to execute in an if/else statement.

¢¢ Any time your program needs to store some data, you 
use a variable. Use = to assign a variable, and == to 
test if two variables are equal.

¢¢ A while loop runs everything within its block (defined 
by curly braces) as long as the conditional test is true.

¢¢ If the conditional test is false, the while loop code 
block won’t run, and execution will move down to the 
code immediately after the loop block. 
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Output:

This magnet didn’t fall off the fridge…

Answers on page 86.

your code…now in magnet form

Code Magnets
Part of a C# program is all scrambled up on the fridge. Can you rearrange 
the code snippets to make a working C# program that produces the 
output? Some of the curly braces fell on the floor and they were too small 
to pick up, so feel free to add as many of those as you need! (Hint: you’ll 
definitely need to add a couple. Just write them in!)

The “” is an empty string—it means the 
variable result has no characters in it yet.

string result = "";

output.Text = result;

int x = 3;

while (x > 0)

if (x > 2) {

 result = result 
+ "a";

}

x = x - 1;

result = result + "-";

if (x == 2) {

 result = result + "b c";

}

if (x == 1) {
 result = result + "d"; x = x - 1;

}

This is a 
TextBlock 
named “output” 
that the 
program updates 
by setting its 
Text property.
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Time to get some practice using if/else statements. Can you build this program?

Build this page.
It’s got a grid with two 
rows and two columns.

Add a TextBlock.
It’s almost identical to the one you 
added to the bottom of  the page in 
the last project. This time, name it 
labelToChange and set its Grid.
Row property to "1".

Add a Button and a CheckBox.
You can find the CheckBox control in the toolbox, 
just below the Button control. Set the Button’s name 
to  changeText and the CheckBox’s name to 
enableCheckbox. Use the Edit Text right-click 
menu option to set the text for both controls (hit 
Escape to finish editing the text). Right-click on each 
control and chose Reset Layout→All, then make 
sure both of  them have their VerticalAlignment and 
HorizontalAlignment set to Center.

Set the TextBlock to this message if the user clicks the button but the box IS 
NOT checked.
Here’s the conditional test to see if  the checkbox is checked:

        enableCheckbox.IsChecked == true

If  that test is NOT true, then your program should execute two statements:

        labelToChange.Text = "Text changing is disabled";
        labelToChange.HorizontalAlignment = HorizontalAlignment.Center;

If the user clicks the button and the box IS checked, change the TextBlock so it 
either shows  on the lefthand side or  on the righthand side.

If  the label’s Text property is currently equal to "Right" then the program should change the text to 
"Left" and set its HorizontalAlignment property to HorizontalAlignment.Left. Otherwise, set 
its text to "Right"and its HorizontalAlignment property to HorizontalAlignment.Right. This 
should cause the program to flip the label back and forth when the user presses the button—but only if  the 
checkbox is checked.

We’ll give you a lot of exercises like this throughout the book. We’ll give you the answer in a couple of pages. If you get stuck, don’t be afraid to peek at the answer—it’s not cheating!

You’ll be creating a lot of applications 
throughout this book, and you’ll need to give 
each one a different name. We recommend naming 
this one “PracticeUsingIfElse”. It helps to put 
programs from a chapter in the same folder.

Hint: you’ll put this 
code in the else block.

If you create two rows and set one row’s height to 1* in the IDE, it seems to disappear because it’s collapsed to a tiny size. Just set the other row to 1* and it’ll show up again.
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Pool Puzzle
Your job is to take code snippets from 

the pool and place them into 
the blank lines in the code. You 
may not use the same snippet 
more than once, and you won’t 
need to use all the snippets. 
Your goal is to make a class 

that will compile and run. Don’t 
be fooled—this one’s harder than it 
looks.

Note: each snippet 
from the pool can only 
be used once!

poem = poem + "  ";
poem = poem + "a";
poem = poem + "n";
poem = poem + "an";

x = x + 1;
x = x + 2;
x = x  - 2;
x = x  - 1;

x > 0
x < 1
x > 1
x > 3
x < 4

poem = poem + "noys  ";
poem = poem + "oise  ";
poem = poem + "  oyster ";
poem = poem + "annoys";
poem = poem + "noise";

int x = 0;
string poem = "";

while ( __________ ) {

  _____________________________
  if ( x < 1 ) {
    ___________________________
  }
  _____________________________

  if ( __________ ) {
    
    ____________________________
   
    ___________
  }
  if ( x == 1 ) {

    ____________________________
  }
  if ( ___________ ) {

    ____________________________
  }

  ____________
}
__________________

output.Text = poem;

Output

this puzzle’s tougher than it looks

We included these Pool Puzzle exercises throughout the book 
to give your brain an extra-tough workout. If you’re the kind 
of person who loves twisty little logic puzzles, then you’ll love 
this one. If you’re not, give it a shot anyway—but don’t be 
afraid to look at the answer to figure out what’s going on. 
And if you’re stumped by a pool puzzle, definitely move on.

Here’s another TextBlock, 
and we also gave it the 
name “output”.
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Time to get some practice using if/else statements. Can you build this program?

Here’s the XAML code for the grid:
<Grid Background="{StaticResource ApplicationPageBackgroundThemeBrush}">
    <Grid.RowDefinitions>
        <RowDefinition/>
        <RowDefinition/>
    </Grid.RowDefinitions>
    <Grid.ColumnDefinitions>
        <ColumnDefinition/>
        <ColumnDefinition/>
    </Grid.ColumnDefinitions>

    <Button x:Name="changeText" Content="Change the label if checked"
            HorizontalAlignment="Center" Click="changeText_Click"/>

    <CheckBox x:Name="enableCheckbox" Content="Enable label changing"
              HorizontalAlignment="Center" IsChecked="true" Grid.Column="1"/>

    <TextBlock x:Name="labelToChange" Grid.Row="1" TextWrapping="Wrap"
               Text="Press the button to set my text"
               HorizontalAlignment="Center" VerticalAlignment="Center"
               Grid.ColumnSpan="2"/>
</Grid>

And here’s the C# code for the button’s event handler method:
private void changeText_Click(object sender, RoutedEventArgs e)
{
    if (enableCheckbox.IsChecked == true)
    {
        if (labelToChange.Text == "Right")
        {
            labelToChange.Text = "Left";
            labelToChange.HorizontalAlignment = HorizontalAlignment.Left;
        }
        else
        {
            labelToChange.Text = "Right";
            labelToChange.HorizontalAlignment = HorizontalAlignment.Right;
        }
    }
    else
    {
    labelToChange.Text = "Text changing is disabled";
    labelToChange.HorizontalAlignment = HorizontalAlignment.Center;
    }
}

We added line breaks as usual to make it easier to read on the page.

If you double-clicked the button in the designer before you set its name, it may have created a Click event handler method called Button_Click_1() instead of changeText_Click().
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introducing a different kind of app

This magnet didn’t fall off the fridge…

Code Magnets 
Solution

string result = "";

output.Text = result;

int x = 3;

while (x > 0)

if (x > 2) {

 result = result 
+ "a";

}

x = x - 1;

result = result + "-";

if (x == 2) {

 result = result + "b c";

}

if (x == 1) {
 result = result + "d"; x = x - 1;

}

The first time through the 
loop, x is equal to 3, so this 
conditional test will be true.

This statement 
makes x equal 
to 2 the first 
time through 
the loop, and 
1 the second 
time through.

Pool Puzzle 
Solution

int x = 0;
string poem = "";

while ( x < 4 ) {

  poem = poem + "a";
  if ( x < 1 ) {
    poem = poem + " ";
  }
  poem = poem + "n";

  if ( x > 1 ) {
    
    poem = poem + " oyster";
   
    x = x + 2;
  }
  if ( x == 1 ) {

    poem = poem + "noys ";
  }
  if ( x < 1 ) {

    poem = poem + "oise ";
  }

  x = x + 1;
}
output.Text = poem;

Did you get a different solution? Type it into 
the IDE and see if it works! There’s more than 
one correct solution to the pool puzzle.

If you want a real challenge, see if you can figure out what that other solution is! Here’s a 
hint: there’s another solution that keeps the word fragments in order. If you came up with 
that solution instead of the one on this page, see if you can figure out why this one works too.
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Windows Desktop apps are easy to build
Windows 8 brought Windows Store apps, and that gave everyone a totally new way 
to use software on Windows. But that’s not the only kind of  program that you can 
create with Visual Studio. You can use Visual Studio for Windows Desktop to build 
Windows Desktop applications that run in windows on your Windows 8 desktop.

Windows Desktop apps are an effective learning tool

We’ll spend the next several chapters building programs using Visual Studio 
for Windows Desktop before coming back to Windows Store apps. The 
reason is that in many ways, Windows Desktop apps are simpler. They may 
not look as slick, and more importantly, they don’t integrate with Windows 
8 or provide the great, consistent user interface that you get with Windows 
Store apps. But there are a lot of  important, fundamental concepts that 
you need to understand in order to build Windows Store apps effectively. 
Windows Desktop programming is a great tool for exploring those 
fundamental concepts. We’ll return to programming Windows Store 
apps once we’ve laid down that foundation.

This sounds fishy. 

Why do I need to learn 

more than one way to 

build programs?

Another great reason to 
learn Windows Desktop 
programming is that you 
get to see the same thing done more than one way. That’s a really quick way to get concepts into your brain. Flip the page to 
see what we mean...

We’ll use Visual Studio 
for Windows Desktop 
to build programs that 
run in windows on your 
Windows 8 desktop.
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Rebuild your app for Windows Desktop
Start up Visual Studio 2012 for Windows Desktop and create a new project. This 
time, you’ll see different options than before. Click on Visual C# and Windows, 
and create a new Windows Forms Application project.

When you create a new 
project in Visual Studio 2012 
Express for Windows Desktop, 
you get these options. Choose 
Windows Forms Application.

Do this!

Windows Forms Apps start with a form that you can resize.
Your Windows Forms Application has a main window that you design using the designer in the IDE. 
Start by resizing it to 500×130. Find the handle on the form in the Designer window and drag to resize 
it. As you drag it, keep an eye on the changing numbers in the status bar in the IDE that show you the 
new size. Keep dragging until you see  in the status bar.

1

Keep dragging these handles 
until your form is the right size. 

Here’s what your 
form should look 
like after you 
resize it.

this looks oddly familiar

Normally you 
should choose 
a better name 
than “Chapter 
2 - Program 
4,” but we’re 
specifically using 
a name with 
spaces and a 
hyphen for this 
project so you 
can see what 
it does to the 
namespace.
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	        Make sure you’re 
using the right 
Visual Studio

If you’re using the 
Express edition of Visual Studio 
2012, you’ll need to install two 
versions. You’ve been using Visual 
Studio 2012 for Windows 8 to build 
Windows Store apps. Now you’ll 
need to use Visual Studio 2012 
for Windows Desktop. Luckily, 
both Express editions are available 
for free from Microsoft.

Change the title of your form.
Right now the form has the default title (“Form1”). You can 
change that by clicking on the form to select it, and then 
changing the Text property in the Properties window.

2

Add a button, checkbox, and label.
Open up the toolbox and drag a Button, CheckBox, and 
Label control onto your form.

3

You can expand the toolbox by choosing “Toolbox” from 
the View menu, or by clicking on the Toolbox tab on the 
side of  the IDE. You can keep it from disappearing by 
clicking the pushpin icon ( ) on the Toolbox window. You 
can also drag the window title so that it floats over the IDE.

On the next page you’ll use the Properties window 
to change the text on each control, and to set the 
CheckBox control’s state to checked. See if  you can 
figure out how to do that before you flip the page!

These spacer lines help you position your controls as you drag them around.

The IDE helps you align your controls by displaying alignment lines as you drag them around the form.

Hint: you’ll need to use the AutoSize property 
to get the Label control to look right.
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Add the event handler method for your button.
Double-click on the button to make the IDE add an event handler method. Here’s the code:

5

When you double-clicked on the 
button, the IDE generated this 
event handler and named it 
changeText_Click() to match your 
button’s name, changeText.

Here’s the code 
for the event 
handler method. 
Take a careful 
look—can you see 
what’s different 
from the similar 
code you added 
for the exercise?

Use the Properties window to set up the controls.
Click on the Button control to select it. Then go to the Properties window and set its Text property:

Change the Text property for the CheckBox control and the Label control so they match the screenshot on 
the next page, and set the CheckBox’s Checked property to True. Then select the Label control and set the 

TextAlign control to MiddleCenter. Use the Properties window to 
set the names of  your controls. Name the Button changeText, 
set the CheckBox control’s name to enableCheckbox, and 
name the Label control labelToChange. Look at the code below 
carefully and see if  you can see how those names are used in the code.

Change the AutoSize property on the Label control to False. 
Labels normally resize themselves based on their contents. Disabling 
AutoSize to true causes the drag handles to show up. Drag it so 
it’s the entire width of  the window.

4

déjà vu
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using System; 
using System.Linq; 
using System.Text; 
using System.Windows.Forms;

namespace SomeNamespace

{

	 class MyClass {

		  public static void DoSomething() {

			   MessageBox.Show("This is a message");

		  }

	 }

}

Fill in the annotations so they describe the lines in this C# file 
that they’re pointing to. We’ve filled in the first one for you. Can 
you guess what the last annotation should say?

C# classes have these “using” 
lines to add methods from 
other namespaces

Solution on page 95 

Here’s a hint. You haven’t seen MessageBox yet, but 
it’s something that a lot of  desktop apps use. Like 
most classes and methods, it has a sensible name.

Debug your program in the IDE.

When you do, the IDE will build your 
program and run it, which pops up the 
main window that you built. Try clicking 
the button and checkbox.

When label changing is 
enabled, the label shows 
either Left or Right 
with matching alignment. 
If it’s disabled, it shows 
a message that’s centered.

Click the 
checkbox to 
enable or 
disable label 
changing.



92    Chapter 2

Your desktop app knows 
where to start

using System;
using System.Collections.Generic;
using System.Linq;
using System.Threading.Tasks;
using System.Windows.Forms;

namespace Chapter_2___Program_4
{
    static class Program
    {
        /// <summary>
        /// The main entry point for the application.

        /// </summary>
        [STAThread]
        static void Main()
        {
            Application.EnableVisualStyles();

            Application.SetCompatibleTextRenderingDefault(false);

            Application.Run(new Form1());
        }
    }
}

When you created the new Windows Forms 
Application project, one of  the files the IDE added 
was called Program.cs. Go to the Solution Explorer and 
double-click on it. It’s got a class called Program, and 
inside that class is a method called Main(). That 
method is the entry point, which means that it’s the 
very first thing that’s run in your program.

This statement creates and 
displays the form, and ends the 
program when the form’s closed.

I do declare!
The first part of every class or method is called a declaration.

Remember, this is just a starting point for you to dig into the code. But before you do, you’ll need to know what you’re looking at.

a closer look

1

2

3

4

5

Your Code Up Close

The IDE generated this namespace based on 

the project name. We named ours “Chapter 

2 - Program 4,” so this is the namespace the 

IDE generated for us. We chose a name with 

spaces and a hyphen to show you how the IDE 

converts them to underscores in the namespace.

Every time you run your program, it starts here, at the entry point.

Here’s some code the IDE built for you 
automatically in the last chapter. You’ll 
find it in Program.cs.

Lines that begin with two or more slashes are comments, which you can add anywhere you want. The slashes tell C# to ignore them.

		  Desktop apps are different, 
and that’s good for learning.

Windows Desktop applications 
are a lot less slick than Windows 

Store apps because it’s much harder (but not 
impossible) to build the kinds of  advanced user 
interfaces that Windows Store apps give you. And 
that’s a good thing for now! Beacuse they’re simple 
and straightforward, desktop apps are a great 
tool for learning the core C# concepts, and that 
will make it much easier for you to understand 
Windows Store apps when we return to them later.
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Every desktop app must 
have exactly one method 
called Main. That method 
is the entry point for 
your code.
When you run your code, 
the code in your Main() 
method is executed FIRST.

Namespaces let you use the same name in different programs, as long as those programs aren’t also in the same namespace.

C# and .NET have lots of built-in features. 

You’ll find lines like this at the top of  almost every C# class file. 
System.Windows.Forms is a namespace. The using 
System.Windows.Forms line makes everything in that 
namespace available to your program. In this case, that namespace 
has lots of  visual elements in it, like buttons and forms.

1

The IDE chose a namespace for your code. 

Here’s the namespace the IDE created for you—it chose a 
namespace based on your project’s name. All of  the code in your 
program lives in this namespace.

2

Your code is stored in a class. 

This particular class is called Program. The IDE created it 
and added the code that starts the program and brings up the 
form called Form1.

3

This code has one method, and it  
contains several statements. 

A namespace has classes in it, and classes have methods. 
Inside each method is a set of  statements. In this 
program, the statements handle starting up the form. 
You already know that methods are where the action 
happens—every method does something.

4

Each desktop app has a special kind 
of method called the entry point. 

Every desktop app must have exactly one method 
called Main. Even though your program has a lot 
of  methods, only one can be the first one that gets 
executed, and that’s your Main method. C# checks 
every class in your code for a method that reads 
static void Main(). Then, when the program 
is run, the first statement in this method gets executed, 
and everything else follows from that first statement.

5

You can have multiple 
classes in a single namespace.

Your programs will use more and more 
namespaces like this one as you learn 
about C# and .NET’s other built-in 
features throughout the book.

Technically, a program can have more 
than one Main() method, and you can 

tell C# which one is the entry point…

but you won’t need to do that now.

If you didn’t specify the “using” line, 
you’d have to explicitly type out System.
Windows.Forms every time you use 
anything in that namespace.

These are some of  the “nuts and bolts” of  desktop apps. You’ll play with them on the next few pages 
so you can see what’s going on behind the scenes. But most of  the work you do on desktop apps will 
be done by dragging controls out of  the toolbox and onto a form—and, obviously, editing C# code.
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You can change your 
program’s entry point
As long as your program has an entry point, it doesn’t matter 
which class your entry point method is in, or what that method 
does. There’s nothing magical or mysterious about how it works, 
or how your desktop app runs. You can prove it to yourself  by 
changing your program’s entry point.

Now let’s create a new entry point. Add a new class called AnotherClass.cs. You add a 
class to your program by right-clicking on the project name in the Solution Explorer and 
selecting “Add→Class…”. Name your class file AnotherClass.cs. The IDE will add a class to 
your program called AnotherClass. Here’s the file the IDE added:

2

Add a new using line to the top of  the file: using System.Windows.Forms; 
Don’t forget to end the line with a semicolon!

3

class AnotherClass
{
    public static void Main()
    {
        MessageBox.Show("Pow!");   
    }
}

using System;

using System.Collections.Generic;

using System.Linq;

using System.Text;

using System.Threading.Tasks;

namespace Chapter_2___Program_4

{

    class AnotherClass

    {

    }

}

These four standard using lines 
were added to the file. 

The IDE automatically named the class based on the filename.

This class is in the same 
namespace that the IDE 
added when you first 
created the project.

Add this method to the AnotherClass class by typing it in between the curly brackets:4

MessageBox is a class that lives 
in the System.Windows.Forms 
namespace, which is why you had 
to add the using line in step #3. 
Show() is a method that’s part of 
the MessageBox class.

classy things

Do this!

Right-click on the 
project in Properties 
and select “Add” and 
“Class…”

C# is case-sensitive! Make sure your upper- and lowercase letters match the example code.

Go back to the program you just wrote. Edit Program.cs and change the 
name of  the Main() method to NotMain(). Now try to build and 
run your program. What happens? Can you guess why it happened?

1
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using System; 
using System.Linq; 
using System.Text; 
using System.Windows.Forms;

namespace SomeNamespace

{

	 class MyClass {

		  public static void DoSomething() {

			   MessageBox.Show("This is a message");

		  }

	 }

}

Now run it!

So what happened?
Instead of  popping up the app you wrote, your program 
now shows this message box. When you made the new 
Main() method, you gave your program a new entry 
point. Now the first thing the program does is run the 
statements in that method—which means running that 
MessageBox.Show() statement. There’s nothing else 
in that method, so once you click the OK button, the 
program runs out of  statements to execute and then it ends.

Figure out how to fix your program so it pops up the app again.5 Hint: you only have 
to change two lines in 
two files to do it.

Fill in the annotations so they describe the lines in this C# file 
that they’re pointing to. We’ve filled in the first one for you.

C# classes have these “using” 
lines to add methods from 
other namespaces.

All of the code lives in 
classes, so the program 
needs a class here.

This is a statement. 
When it’s executed, 
it pops up a little 
window with a 
message inside of it.

This class has one method. 
Its name is “DoSomething,” 
and when it’s called it pops 
up a MessageBox.

Solution

Desktop apps use MessageBox.Show() to 
pop up windows with messages and alerts.
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The IDE is great at writing visual code for you. But don’t 
take our word for it. Open up Visual Studio, create a new 
Windows Forms Application project, and see for yourself.

Open up the designer code.
Open the Form1.Designer.cs file in the IDE. But this time, instead of  opening it in the 
Form Designer, open up its code by right-clicking on it in the Solution Explorer and 
selecting View Code. Look for the Form1 class declaration:

1

partial class Form1
Notice how it’s a partial class? We’ll talk about that in a minute.

Find and expand the designer-generated code for the PictureBox.
Then go back to the Form1.Designer.cs tab in the IDE. Scroll down and look for this line in the code: 

Click on the + on the lefthand side of  the line to expand the code. Scroll down and find these lines:

3

// 

// pictureBox1

// 

this.pictureBox1.Image = ((System.Drawing.Image)(resources.GetObject("pictureBox1.Image")));

this.pictureBox1.Location = new System.Drawing.Point(416, 160);

this.pictureBox1.Name = "pictureBox1";

this.pictureBox1.Size = new System.Drawing.Size(141, 147);

this.pictureBox1.TabIndex = 0;

this.pictureBox1.TabStop = false;

Don’t worry if the numbers in 
your code for the Location and 
Size lines are a little different 
than these. They’ll vary depending 
on where you dragged your 
PictureBox control.

let’s dig in

When you change things in the IDE, 
you’re also changing your code

Do this!

Click on the plus sign.

Open up the Form designer and add a PictureBox to your form.
Get used to working with more than one tab. Go to the Solution Explorer and open up the Form designer 
by double-clicking on Form1.cs. Drag a new PictureBox control out of  the toolbox and onto the form. A 
PictureBox control displays a picture, which you can import from an image file.

2

You can choose the image for the PictureBox by selecting 
it and clicking the “Choose Image...” link in the Properties 
window to pop up a window that lets you select the image 
to load. Choose any image file on your computer!

Select “Local resource” and 
click the Import... button 
to pop up a dialog to find 
the image file to import.

If you double-click on Form1.resx in the Solution Explorer, you’ll see the image that you 
imported. The IDE imported our image and named it “pictureBox1.Image”—and here’s the 
code that it generated to load that image into the PictureBox control so it’s displayed.
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/// <summary> 
/// Required method for Designer support - do not modify 
/// the contents of this method with the code editor. 
/// </summary>

There’s nothing more attractive to a kid than a big sign that says, “Don’t touch 
this!” Come on, you know you’re tempted…let’s go modify the contents of  that 
method with the code editor! Add a button to your form called button1 
(you’ll need to switch back to the designer), and then go ahead and do this:

Change the code that sets the BUTTON1.TEXT 
property. What do you think it will do to the 
Properties window in the IDE?
Give it a shot—see what happens! Now go back to the form designer and 
check the Text property. Did it change?

Stay in the designer, and use the Properties 
window to change the NAME property to 
something else.
See if  you can find a way to get the IDE to change the Name property. It’s in 
the Properties window at the very top, under “(Name)”. What happened to 
the code? What about the comment in the code?

Go back to the designer, and change the button’s 
BACKCOLOR property to something else.
Look closely at the Form1.Designer.cs code. Were any lines added?

You don’t have to save the 
form or run the program 
to see the changes. Just 
make the change in the code 
editor, and then click on 
the tab labeled “Form1.cs 
[Design]” to flip over to the 
form designer—the changes 
should show up immediately.

It’s always easier to use the IDE to change your form’s designer‑generated 
code. But when you do, any change you make in the IDE ends up as a change 
to your project’s code.

Wait, wait ! What did that say?
Scroll back up for a minute. There it is, at the top of  the Windows 
Form Designer–generated code section: Most comments only start 

with two slashes (//). 
But the IDE sometimes 
adds these three-slash 
comments.

These are XML comments, 
and you can use them to 
document your code. Flip to 
“Leftovers” section #2 in the 
Appendix of this book to learn 
more about them.

Q: I don’t quite get what the entry point is. Can you 
explain it one more time?

A: Your program has a whole lot of statements in it, but 
they’re not all run at once. The program starts with the first 
statement in the program, executes it, and then goes on to the 

next one, and the next one, etc. Those statements are usually 
organized into a bunch of classes. So when you run your 
program, how does it know which statement to start with? 
 
That’s where the entry point comes in. The compiler will not build 
your code unless there is exactly one method called Main(), 
which we call the entry point. The program starts running with the 
first statement in Main().

1

2

4

Change the code that sets the LOCATION 
property to (0,0) and the Size property to make 
the button really big.
Did it work?

3
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this.BackColor = Color.FromArgb(c, 255 - c, c);

Application.DoEvents();

Here’s the form 
to build.

1

Make the form background go all 
psychedelic!
When the button’s clicked, make the form’s background 
color cycle through a whole lot of  colors! Create a loop that 
has a variable c go from 0 to 253. Here’s the block of  code 
that goes inside the curly brackets:

2

Make it slower.
Slow down the flashing by adding this line after the 
Application.DoEvents() line:

3

I’m tickled pink!
The .NET Framework has a bunc

h 

of predefined 
colors like Blue and 

Red, but it also
 lets you make 

your own colors using t
he Color.

FromArgb() method, by spec
ifying 

three numbers: a red valu
e, a 

green value, an
d a blue value.

This line tells the program to stop your loop momentarily and do the other things it needs to do, like refresh the form, check for mouse clicks, etc. Try taking out this line and see what happens. The form doesn’t redraw itself, because it’s waiting until the loop is done before it deals with those events.

System.Threading.Thread.Sleep(3); This statement inserts a 3 millisecond 

delay in the loop. It’s a part 
of the 

.NET Framework, and it’s in the 
System.Threading namespace.

Here’s a hint for this exercise: if you declar
e a variable inside 

a for loop—for (int c = 0; …)—then that variable’s only valid 

inside the loop’s curly brackets. So if you h
ave two for loops that 

both use the variable, you’ll either declare 
it in each loop or have 

one declaration outside the loop. And if the variable c is already 

declared outside of the loops, you can’t us
e it in either one.

ooh, pretty!

Desktop apps aren’t nearly as easy to animate as Windows Store apps, 
but it’s definitely possible! Let’s build something flashy to prove it. 
Start by creating a new Windows Forms Application.

For now, you’ll use Application.DoEvents() to make sure 
your form stays responsive while it’s in a loop, but it’s 
kind of a hack. You shouldn’t use this code outside of a 
toy program like this. Later on in the book, you’ll learn 
about a much better way to let your programs do more 
than one thing at a time!

Make the button bigger 
by clicking on a corner 
handle and dragging it.
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Make it smoother.
Let’s make the colors cycle back to where they started. Add another loop that has 
c go from 254 down to 0. Use the same block of  code inside the curly brackets.

4

Keep it going.
Surround your two loops with another loop that continuously executes and doesn’t 
stop, so that when the button is pressed, the background starts changing colors and 
then keeps doing it. (Hint: the while (true) loop will run forever!)

5 When one loop is inside another 
one, we call it a “nested” loop.

Make it stop.
Make the loop you added in step #5 stop when the program is 
closed. Change your outer loop to this:

      while (Visible)

Now run the program and click the X box in the corner. The 
window closes, and then the program stops! Except…there’s a 
delay of  a few seconds before the IDE goes back to edit mode.

6

Uh oh! The program doesn’t stop!
Run your program in the IDE. Start it looping. Now close the window. Wait a 
minute—the IDE didn’t go back into edit mode! It’s acting like the program 
is still running. You need to actually stop the program using the square stop 
button in the IDE (or select Stop Debugging from the Debug menu).

Can you figure out what’s causing that 
delay? Can you fix it so the program ends 
immediately when you close the window?

Hint: the && operator means “AND.” It’s how you string a bunch of conditional tests together into one big test that’s true only if the first test is true AND the second is true AND the third, etc. And it’ll come in handy to solve this problem.

When you’re checking a Boolean value like Visible in an if statement or a loop, sometimes it’s tempting to test for (Visible == true). You can leave off the “== true”—it’s enough to include the Boolean.

When you’re working with a 
form or control, Visible is 
true as long as the form or 
control is being displayed. If 
you set it to false, it makes 
the form or control disappear.

Remember, to create a Windows Forms 
Application you need to be using Visual 
Studio for Windows Desktop.
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private void button1_Click(object sender, EventArgs e) {

    while (Visible) {

        for (int c = 0; c < 254 && Visible; c++) {

            this.BackColor = Color.FromArgb(c, 255 - c, c);

            Application.DoEvents();

            System.Threading.Thread.Sleep(3);

        }

        for (int c = 254; c >= 0 && Visible; c--) {

            this.BackColor = Color.FromArgb(c, 255 - c, c);

            Application.DoEvents();

            System.Threading.Thread.Sleep(3);

        }

    }

}

Sometimes we won’t show you the entire code in the solution, just the bits that changed. All of the logic in the FlashyThing project is in this button1_Click() method that the IDE added when you double-clicked the button in the form designer.

Was your code a little different than ours? There’s more than one way to 
solve any programming problem (e.g., you could have used while loops instead 
of for loops). If your program works, then you got the exercise right!

We fixed the extra delay by 
using the && operator to make 
each of the for loops also check 
Visible. That way the loop ends 
as soon as Visible turns false.

The outer loop 
keeps running as 
long as the form 
is visible. As soon 
as it’s closed, 
Visible is false, 
and the while 
will stop looping.

The first for loop makes the colors cycle one way, and the second for loop reverses them so they look smooth.

When the IDE added this method, it added an extra 
return before the curly bracket. Sometimes we’ll put the 
bracket on the same line like this to save space—but C# 
doesn’t care about extra space, so this is perfectly valid.

Can you figure out what’s causing that 
delay? Can you fix it so the program ends 
immediately when you close the window?

The delay happens because the for loops need to finish before the 
while loop can check if  Visible is still true. You can fix it by 
adding && Visible to the conditional test in each for loop.

We used && 
Visible instead 
of && Visible 
== true. It’s 
just like saying 
“if it’s visible” 
instead of “if 
it’s true that 
it’s visible”—they 
mean the same 
thing.

Consistency is generally really important to make it easy 
for people to read code. But we’re purposefully showing you 
different ways, because you’ll need to get used to reading 
code from different people using different styles.

exercise solution
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Making code make sense

Every program you write solves a problem.� 
When you’re building a program, it’s always a good idea to start by thinking about what 

problem your program’s supposed to solve. That’s why objects are really useful. They 

let you structure your code based on the problem it’s solving, so that you can spend your 

time thinking about the problem you need to work on rather than getting bogged down in 

the mechanics of writing code. When you use objects right, you end up with code that’s 

intuitive to write, and easy to read and change.

...and that’s 
why my Husband 

class doesn’t have a 
HelpOutAroundTheHouse() 

method or a 
PullHisOwnWeight() 

method.
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How Mike thinks about his problems
Mike’s a programmer about to head out to a job 
interview. He can’t wait to show off  his C# skills, but 
first he has to get there—and he’s running late!

This is Frank Loudly 
with your eye-in-the-sky shadow 
traffic report. It looks like a 
three-car pileup on Liberty has 
traffic backed up all the way to 

32nd Street.

I’ll take the 
31st Street bridge, head 

up Liberty Avenue, and go 
through Bloomfield.

No problem. If 
I take Route 28 

instead, I’ll 
still be on time!

Mike figures out the route he’ll take to get to the interview.1

Good thing he had his radio on. There’s 
a huge traffic jam that’ll make him late!

2

Mike comes up with a new route to get 
to his interview on time.

3

Mike sets his destination, then comes up with a route.

Mike gets new 
information about a 

street he needs to
 avoid.

Now he can come up 
with a new route to 
the interview.

mike’s going places



you are here 4    103

objects: get oriented!

How Mike’s car navigat ion system thinks about his problems
Mike built his own GPS navigation system, which he 
uses to help him get around town.

Navigator

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

SetDestination("Fifth Ave & Penn Ave");

string route;

route = GetRoute();

"Take 31st Street Bridge to Liberty Avenue to Bloomfield"

string route;

route = GetRoute();

"Take Route 28 to the Highland Park Bridge to Washington Blvd"

ModifyRouteToAvoid("Liberty Ave");

The navigation system sets 
a destination and comes up 
with a route.

Mike’s navigation system solves the street 
navigation problem the same way he does.

The navigation system gets new information about a street it needs to avoid.

Now it can come up with a new 

route to the dest
ination.

Here’s the output from the 
GetRoute() method—it’s 
a string that contains the 
directions Mike should follow.

GetRoute() gives a new route that doesn’t include the 
street Mike wants to avoid.

Here’s a diagram of a class 
in Mike’s program. It shows 
the name on top, and the 
methods on the bottom.
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Some methods have a return value
Every method is made up of  statements that do things. Some methods just execute 
their statements and then exit. But other methods have a return value, or a value 
that’s calculated or generated inside the method, and sent back to the statement that 
called that method. The type of  the return value (like string or int) is called the 
return type.

The return statement tells the method to immediately exit. If  your method doesn’t 
have a return value—which means it’s declared with a return type of  void—then 
the return statement doesn’t need any values or variables (“return;”), and you 
don’t always have to have one in your method. But if  the method has a return type, 
then it must use the return statement.

Here’s a statement that calls a method to multiply two numbers. It returns an int:

Mike’s Navigator class has methods to set and modify routes
Mike’s Navigator class has methods, which are where the action happens. But unlike the 
button_Click() methods in the forms you’ve built, they’re all focused around a single 
problem: navigating a route through a city. That’s why Mike stuck them together into one 
class, and called that class Navigator.

Mike designed his Navigator class so that it’s easy to create and modify routes. To get a 
route, Mike’s program calls the SetDestination() method to set the destination, and 
then uses the GetRoute() method to put the route into a string. If  he needs to change the 
route, his program calls the ModifyRouteToAvoid() method to change the route so that 
it avoids a certain street, and then calls the GetRoute() method to get the new directions.

class Navigator {

   public void SetCurrentLocation(string locationName) { ... }

   public void SetDestination(string destinationName) { ... }

   public void ModifyRouteToAvoid(string streetName) { ... }

   public string GetRoute() { ... }

} This is the return type of the method. It means that the statement calling the GetRoute() method can use it to set a string variable that will contain the directions. When it’s void, that means the method doesn’t return anything.
string route =
       GetRoute();

Mike chose method 
names that would make 
sense to someone who 
was thinking about how 
to navigate a route 
through a city.

public int MultiplyTwoNumbers(int firstNumber, int secondNumber) {

    int result = firstNumber * secondNumber;

    return result;

}

int myResult = MultiplyTwoNumbers(3, 5);

Here’s an example of a method 
that has a return type—it 
returns an int. The method uses 
the two parameters to calculate 
the result.

Methods can take values 
like 3 and 

5. But you can also use var
iables to 

pass values to a method.

set methods and modify routes

This return statement passes the value back 
to the statement that called the method.



you are here 4    105

objects: get oriented!

Create a new Windows Forms Application project in the IDE. Then add a class file to it 
called Talker.cs by right-clicking on the project in the Solution Explorer and selecting “Class…” 
from the Add menu. When you name your new class file “Talker.cs,” the IDE will automatically 
name the class in the new file Talker. Then it’ll pop up the new class in a new tab inside the IDE.

1

Use what you’ve learned to build a program that uses a class
Let’s hook up a form to a class, and make its button call a method inside that class. Do this!

Add using System.Windows.Forms; to the top of  the class file. Then add code to the class:

class Talker {
    public static int BlahBlahBlah(string thingToSay, int numberOfTimes)
    {
        string finalString = "";
        for (int count = 0; count < numberOfTimes; count++) 
        {
            finalString = finalString + thingToSay + "\n";
        }
        MessageBox.Show(finalString);
        return finalString.Length;
    }
}

2

The BlahBlahBlah() method’s return value is an 
integer that has the total length of the message it 
displayed. You can add “.Length” to any string to 
figure out how long it is.

This line of code adds the 
contents of thingToSay and a line break (“\n”) onto the end of it to the finalString variable.

This is called a property. Every string 
has a property called Length. When it 
calculates the length of a string, a line 
break (“\n”) counts as one character.

This statement 
declares a finalString 
variable and sets it 
equal to an empty 
string.

Flip the page to keep going!

¢¢ Classes have methods that contain statements that perform actions. You can design a class that is easy to use by 
choosing methods that make sense. 

¢¢ Some methods have a return type. You set a method’s return type in its declaration. A method with a declaration that starts 
“public int” returns an int value. Here’s an example of a statement that returns an int value: return 37; 

¢¢ When a method has a return type, it must have a return statement that returns a value that matches a return type. So if 
you’ve got a method that’s declared “public string” then you need a return statement that returns a string.

¢¢ As soon as a return statement in a method executes, your program jumps back to the statement that called the method.

¢¢ Not all methods have a return type. A method with a declaration that starts “public void” doesn’t return anything at 
all. You can still use a return statement to exit a void method: if (finishedEarly) { return; }
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introducing objects

Make your project’s form look like this.

Then double-click on the button and have it run this code that calls BlahBlahBlah() and assigns its return 
value to an integer called len:

private void button1_Click(object sender, EventArgs e)
{
    int len = Talker.BlahBlahBlah(textBox1.Text, (int)numericUpDown1.Value);
    MessageBox.Show("The message length is " + len);
}

3

This is a NumericUpDown control. Set its Minimum property to 1, its Maximum property to 10, and its Value property to 3.

Set the default 
text of this 
TextBox control to 
“Hello!” using its Text 
property.

Now run your program! Click the button and watch it pop up two 
message boxes. The class pops up the first message box, and the 
form pops up the second one.

4

The BlahBlahBlah() method 
pops up this message box 
based on what’s in its 
parameters.

When the 
method returns 
a value, the form 
pops it up in this 
message box.

So what did you just build?
The new class has one method called BlahBlahBlah() that takes two parameters. The first 
parameter is a string that tells it something to say, and the second is the number of  times to say 
it. When it’s called, it pops up a message box with the message repeated a number of  times. 
Its return value is the length of  the string. The method needs a string for its thingToSay 
parameter and a number for its numberOfTimes parameter. It’ll get those parameters 
from a form that lets the user enter text using a TextBox control and a number using a 
NumericUpDown control.

Now add a form that uses your new class!

You can add a class to your project and share 
its methods with the other classes in the project.

To turn off  
the minimize 

and maximize 
buttons, set 
the form’s 

MaximizeBox 
and 

MinimizeBox 
properties to 

False.

The length is 21 because “Hello!” 
is six characters, plus the \n 
counts as another character, 
which gives 7 x 3 = 21.
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It’d be great if I 
could compare a few 

routes and figure out 
which is fastest....

Mike gets an idea
The interview went great! But the traffic 
jam this morning got Mike thinking about 
how he could improve his navigator.

Navigator

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

Navigator2

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

Navigator3

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

He could create three different Navigator classes…
Mike could copy the Navigator class code and paste it into two more 
classes. Then his program could store three routes at once.

Whoa, that can’t be right! 
What if I want to change a 
method? Then I need to go 

back and fix it in three places.

Right! Maintaining three copies of the same code 
is really messy. A lot of  problems you have to solve need a 
way to represent one thing a bunch of  different times. In this case, 
it’s a bunch of  routes. But it could be a bunch of  people, or aliens, 
or music files, or anything. All of  those programs have one thing in 
common: they always need to treat the same kind of  thing in the 
same way, no matter how many of  the thing they’re dealing with.

This box is a class diagram. It lists 
all of the methods in a class, and 
it’s an easy way to see everything 
that it does at a glance.
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for instance…

new Navigator()

new
 Na

vig
ato

r()

Navigator obj
e c

tnavigator3

Mike can use objects to solve his problem
Objects are C#’s tool that you use to work with 
a bunch of  similar things. Mike can use objects 
to program his Navigator class just once, but 
use it as many times as he wants in a program.

Navigator obj
e c

tnavigator1

Navigator obj
e c

t

navigator2

new Navigator()

Navigator

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

Navigator navigator1 = new Navigator();

navigator1.SetDestination("Fifth Ave & Penn Ave");

string route;

route = navigator1.GetRoute();

All you need to create an 
object is the new keyword 
and the name of a class.

Now you can use the object! When you 
create an object from a class, that object 
has all of the methods from that class.

This is the Navigator class 

in Mike’s program. It lists 

all of the methods that a 

Navigator object 
can use.

Mike needed to compare 
three different routes 
at once, so he used 
three Navigator objects 
at the same time.
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House object

House object

House object

A class is like a blueprint for an object. If  you wanted to build 
five identical houses in a suburban housing development, you 
wouldn’t ask an architect to draw up five identical sets of  
blueprints. You’d just use one blueprint to build five houses.

You use a class to build an object

When you define a class, you define 
its methods, just like a blueprint 
defines the layout of the house.

You can use one blueprint to 
make any number of houses, 
and you can use one class to 
make any number of objects.

House

GiveShelter() 
GrowLawn()
MailDelivered()
ClogDrainPipes()
AccruePropertyTaxes()
NeedRepairs()

An object gets its methods from its class
Once you build a class, you can create as many objects as you want from 
it using the new statement. When you do, every method in your class 
becomes part of  the object.

115 Maple 
Drive

38 Pine 
Street

26A Elm 
Lane
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House object

115 Maple 
Drive

When you create a new object from a class, 
i t’s called an instance of that class

Check it out for yourself!

Open any project that uses a button called button1, 
and use the IDE to search the entire project for the 
text “button1 = new”. You’ll find the code that 
the IDE added to the form designer to create the 
instance of  the Button class.

in-stance, noun.  
an example or one occurrence of  
something. The IDE search-and-
replace feature finds every instance 
of  a word and changes it to another.

Do this!

Guess what…you already know this stuff ! Everything in the toolbox 
is a class: there’s a Button class, a TextBox class, a Label 
class, etc. When you drag a button out of  the toolbox, the IDE 
automatically creates an instance of  the Button class and calls 
it button1. When you drag another button out of  the toolbox, 
it creates another instance called button2. Each instance of  
Button has its own properties and methods. But every button acts 
exactly the same way, because they’re all instances of  the same class.

Before: here’s a picture of your 
computer’s memory when your 
program starts.

After: now it’s 
got an instance 
of the House 
class in memory.

House mapleDrive115 = new House();

Your program executes a new statement.
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Navigator obj
e c

tnavigator3

4.2 miles

Navigator obj
e c

tnavigator1

3.5 miles

Navigator obj
e c

t

navigator2

3.8 miles

Navigator obj
e c

tnavigator1

3.5 miles

A better solut ion…brought to you by objects!
Mike came up with a new route comparison program that uses objects to find 
the shortest of  three different routes to the same destination. Here’s how he 
built his program.

string destination = textBox1.Text;

Navigator navigator1 = new Navigator();

navigator1.SetDestination(destination);

route = navigator1.GetRoute();

Navigator

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

He created a Navigator object and set its destination.2

Mike set up a GUI with a textbox—textBox1 contains the destination for the three routes. 
Then he added textBox2, which has a street that one of  the routes should avoid; and 
textBox3, which contains a different street that the third route has to include.

1

Then he added a second Navigator object called navigator2. He 
called its SetDestination() method to set the destination, and 
then he called its ModifyRouteToAvoid() method.

3

The third Navigator object is called navigator3. Mike set its 
destination, and then called its ModifyRouteToInclude() method.

4

The SetDestination(), 

ModifyRouteToAvoid(), and 

ModifyRouteToInclude() 

methods all take a st
ring as a 

parameter.

Now Mike can call each object’s TotalDistance() method to figure 
out which route is the shortest. And he only had to write the code once, 
not three times!

5

Any time you 
create a new 
object from a 
class, it’s called 
creating an 
instance of
that class.

GUI stands for Graphical User Interface, which is what you’re building when you make a form in the form designer.

The navigator1 
object is an 
instance of the 
Navigator class.
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a little head first secret sauce

Wait a minute! You 
didn’t give me nearly enough 

information to build the 
navigator program.

That’s right, we didn’t. A geographic navigation program is 
a really complicated thing to build. But complicated programs follow 
the same patterns as simple ones. Mike’s navigation program is an 
example of  how someone would use objects in real life.

Theory and pract ice
Speaking of  patterns, here’s a pattern that you’ll see over and over again 
throughout the book. We’ll introduce a concept or idea (like objects) over the 
course of  a few pages, using pictures and short code excerpts to demonstrate the 
idea. This is your opportunity to take a step back and try to understand what’s 
going on without having to worry about getting a program to work.

House object

115 Maple 
DriveWhen we’re introducing a new concept 

(like objects), keep your eyes open for 
pictures and code excerpts like this.

House mapleDrive115 = new House();

After we’ve introduced a concept, we’ll give you a chance to get it into your 
brain. Sometimes we’ll follow up the theory with a writing exercise—like the 
Sharpen your pencil exercise on the next page. Other times, we’ll jump straight 
into code. This combination of  theory and practice is an effective way to get 
these concepts off  of  the page and stuck in your brain.

A lit t le adv ice for the code exercises
If  you keep a few simple things in mind, it’ll make the code exercises go 
smoothly:

≥≥ It’s easy to get caught up in syntax problems, like missing parentheses 
or quotes. One missing bracket can cause many build errors.

≥≥ It’s much better to look at the solution than to get frustrated with a 
problem. When you’re frustrated, your brain doesn’t like to learn.

≥≥ All of  the code in this book is tested and definitely works in Visual 
Studio 2012! But it’s easy to accidentally type things wrong (like 
typing a one instead of  a lowercase L).

≥≥ If  your solution just won’t build, try downloading it from the Head 
First Labs website: http://www.headfirstlabs.com/hfcsharp

When you run into 
a problem with 
a coding exercise, 
don’t be afraid 
to peek at the 
solution. You can 
also download the 
solution from the 
Head First Labs 
website.
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Follow the same steps that Mike followed earlier in the chapter to write 
the code to create Navigator objects and call their methods.

string destination = textBox1.Text;

string route2StreetToAvoid = textBox2.Text;

string route3StreetToInclude = textBox3.Text; 

Navigator navigator1 = new Navigator();

navigator1.SetDestination(destination);

int distance1 = navigator1.TotalDistance();

1. Create the navigator2 object, set its destination, call its ModifyRouteToAvoid() method, and 
use its TotalDistance() method to set an integer variable called distance2.

We gave you a head start. Here’s the code Mike wrote to get the destination and street names from the text boxes.

int shortestDistance = Math.Min(distance1, Math.Min(distance2, distance3));

The Math.Min() method built into the .NET Framework compares two numbers and 
returns the smallest one. Mike used it to find the shortest distance to the destination.

2. Create the navigator3 object, set its destination, call its ModifyRouteToInclude() method, 
and use its TotalDistance() method to set an integer variable called distance3.

And here’s the code to create the 
navigator object, set its destination, 
and get the distance.

Navigator navigator2 = 

navigator2.

navigator2.

int distance2 = 
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string destination = textBox1.Text;

string route2StreetToAvoid = textBox2.Text;

string route3StreetToInclude = textBox3.Text; 

Navigator navigator1 = new Navigator();

navigator1.SetDestination(destination);

int distance1 = navigator1.TotalDistance();

Follow the same steps that Mike followed earlier in the chapter to write 
the code to create Navigator objects and call their methods.

1. Create the navigator2 object, set its destination, call its ModifyRouteToAvoid() method, and 
use its TotalDistance() method to set an integer variable called distance2.

int shortestDistance = Math.Min(distance1, Math.Min(distance2, distance3));

2. Create the navigator3 object, set its destination, call its ModifyRouteToInclude() method, 
and use its TotalDistance() method to set an integer variable called distance3.

Navigator navigator2 = 

navigator2.

navigator2.

int distance2 = 

new Navigator()

SetDestination(destination);

ModifyRouteToAvoid(route2StreetToAvoid);

navigator2.TotalDistance();

Navigator navigator3 = new Navigator()

navigator3.SetDestination(destination);

navigator3.ModifyRouteToInclude(route3StreetToInclude);

int distance3 = navigator3.TotalDistance();

The Math.Min() method built into the .NET Framework compares two numbers and 
returns the smallest one. Mike used it to find the shortest distance to the destination.

And here’s the code to create the 
navigator object, set its destination, 
and get the distance.

We gave you a head start. Here’s the code Mike wrote to get the destination and street names from the text boxes.
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Yes! That’s why you used the static keyword in your methods.

Take another look at the declaration for the Talker class you built a few pages ago:
 
  class Talker
  {
    public static int BlahBlahBlah(string thingToSay, int numberOfTimes)
    {
      string finalString = "";

When you called the method, you didn’t create a new instance of  Talker. You just did this:

   Talker.BlahBlahBlah("Hello hello hello", 5);

That’s how you call static methods, and you’ve been doing that all along. If  you take away 
the static keyword from the BlahBlahBlah() method declaration, then you’ll have to 
create an instance of  Talker in order to call the method. Other than that distinction, static 
methods are just like object methods. You can pass parameters, they can return values, and 
they live in classes.

There’s one more thing you can do with the static keyword. You can mark your whole 
class as static, and then all of  its methods must be static too. If  you try to add a nonstatic 
method to a static class, it won’t compile.

I’ve written a few classes now, but I 
haven’t used “new” to create an instance 
yet! So does that mean I can call methods 

without creating objects?

Q: When I think of something that’s “static,” I think of 
something that doesn’t change. Does that mean nonstatic 
methods can change, but static methods don’t? Do they 
behave differently?

A: No, both static and nonstatic methods act exactly the 
same. The only difference is that static methods don’t require 
an instance, while nonstatic methods do. A lot of people have 
trouble remembering that, because the word “static” isn’t really 
all that intuitive.

Q: So I can’t use my class until I create an instance of 
an object?

A: You can use its static methods. But if you have methods 
that aren’t static, then you need an instance before you can 
use them.

Q: Then why would I want a method that needs an 
instance? Why wouldn’t I make all my methods static?

A: Because if you have an object that’s keeping track of 
certain data—like Mike’s instances of his Navigator 
class that each kept track of a different route—then you can 
use each instance’s methods to work with that data. So when 
Mike called his ModifyRouteToAvoid() method 
in the navigator2 instance, it only affected the route 
that was stored in that particular instance. It didn’t affect the 
navigator1 or navigator3 objects. That’s how he 
was able to work with three different routes at the same time—
and his program could keep track of all of it.

Q: So how does an instance keep track of data?

A: Turn the page and find out!
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An instance uses f ie lds to keep track of things
You change the text on a button by setting its Text property in the 
IDE. When you do, the IDE adds code like this to the designer:

  button1.Text = "Text for the button";

Now you know that button1 is an instance of  the Button class. 
What that code does is modify a field for the button1 instance. 
You can add fields to a class diagram—just draw a horizontal line in 
the middle of  it. Fields go above the line, methods go underneath it.

Technically, it’s setting a property. A property is very similar to a field—but we’ll get into all that a little later on.

Class

Field1
Field2
Field3

Method1()
Method2()
Method3()

Methods are what an object does. Fields are what the object knows.
When Mike created three instances of  Navigator classes, his program created three objects. 
Each of  those objects was used to keep track of  a different route. When the program created the 
navigator2 instance and called its SetDestination() method, it set the destination for that 
one instance. But it didn’t affect the navigator1 instance or the navigator3 instance. 

An object’s behavior is defined by its methods, 
and it uses fields to keep track of its state.

This is where a class 
diagram shows the 
fields. Every instance 
of the class uses 
them to keep track 
of its state.

Add this line to 
separate the fields from the methods.

Navigator

Destination
Route

SetCurrentLocation()
SetDestination()
ModifyRouteToAvoid()
ModifyRouteToInclude()
GetRoute()
GetTimeToDestination()
TotalDistance()

Every instance of Navigator knows 
its destination and its route.

What a Navigator object does is let you set a destination, modify its route, and get information about that route.

an object’s state of affairs
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Clown

Name
Height

TalkAboutYourself()

Let’s create some instances!
It’s easy to add fields to your class. Just declare 
variables outside of  any methods. Now every 
instance gets its own copy of  those variables.

class Clown {

  public string Name;

  public int Height;

  public void TalkAboutYourself() {

    MessageBox.Show("My name is " 

       + Name + " and I’m "

       + Height + " inches tall.");

  }

}

Write down the contents of each message box that will be displayed 
after the statement next to it is executed.

Clown oneClown = new Clown();

oneClown.Name = "Boffo";

oneClown.Height = 14;

oneClown.TalkAboutYourself();

Clown anotherClown = new Clown();

anotherClown.Name = "Biff";

anotherClown.Height = 16;

anotherClown.TalkAboutYourself();

Clown clown3 = new Clown();

clown3.Name = anotherClown.Name;

clown3.Height = oneClown.Height - 3;

clown3.TalkAboutYourself();

anotherClown.Height *= 2;

anotherClown.TalkAboutYourself();

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

Remember, when you see “void” in front of a method, it means that it doesn’t return any value.

When you want to create instances 
of your class, don’t use the static 
keyword in either the class declaration or the method declaration.

Remember, the *= operator tells C# 
to take whatever’s on the left of the 
operator and multiply it by whatever’s 
on the right.
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Write down the contents of each message box that will be displayed 
after the statement next to it is executed.

Clown oneClown = new Clown();

oneClown.Name = "Boffo";

oneClown.Height = 14;

oneClown.TalkAboutYourself();

Clown anotherClown = new Clown();

anotherClown.Name = "Biff";

anotherClown.Height = 16;

anotherClown.TalkAboutYourself();

Clown clown3 = new Clown();

clown3.Name = anotherClown.Name;

clown3.Height = oneClown.Height - 3;

clown3.TalkAboutYourself();

anotherClown.Height *= 2;

anotherClown.TalkAboutYourself();

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

“My name is _______ and I’m ______ inches tall.”

Each of these new statements creates an instance of the Clown class by reserving a chunk of memory on the heap for that object and filling it up with the object’s data.

Boffo

Biff

Biff

Biff

14

16

11

32

Thanks for the memory
When your program creates an object, it lives in a part of  the 
computer’s memory called the heap. When your code creates an 
object with a new statement, C# immediately reserves space in the 
heap so it can store the data for that object.

Let’s take a closer look at what happened here

Here’s a picture of the heap before the 
project starts. Notice that it’s empty.

When your program creates a new object, it gets added to the heap.

toss it in the heap
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Clown object
 #

 3

“Biff”

11

Clown object
 #

 2

“Biff”

32

Clown object
 #

 1
“Boffo”

14

Clown object
 #

 3

“Biff”

11

Clown object
 #

 2

“Biff”

16

Clown object
 #

 1

“Boffo”

14

Clown object
 #

 2

“Biff”

16

Clown object
 #

 1

“Boffo”

14

Clown object
 #

 1

Clown oneClown = new Clown();

oneClown.Name = "Boffo";

oneClown.Height = 14;

oneClown.TalkAboutYourself();

1

Clown anotherClown = new Clown();

anotherClown.Name = "Biff";

anotherClown.Height = 16;

anotherClown.TalkAboutYourself();

2

Clown clown3 = new Clown();

clown3.Name = anotherClown.Name;

clown3.Height = oneClown.Height - 3;

clown3.TalkAboutYourself();

3

anotherClown.Height *= 2;

anotherClown.TalkAboutYourself();

4

What’s on your program’s mind
Here’s how your program creates a new instance of  the 
Clown class:

  Clown myInstance = new Clown();

That’s actually two statements combined into one. The 
first statement declares a variable of  type Clown (Clown 
myInstance;). The second statement creates a new 
object and assigns it to the variable that was just created 
(myInstance = new Clown();). Here’s what the heap 
looks like after each of  these statements:

The first objec
t 

is created, an
d its 

fields are set
.

These statements create 
the second object and fill it 
with data.

Then the third Clown object is 

created and populated.

There’s no “new” statement, which 
means these statements don’t create a 
new object. They’re just modifying one 
that’s already in memory.

This object is an instance of the 
Clown class.

“Boffo”

14
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You can use class and method 
names to make your code intuit i ve
When you put code in a method, you’re making a choice about how to structure 
your program. Do you use one method? Do you split it into more than one? Or do 
you even need a method at all? The choices you make about methods can make your 
code much more intuitive—or, if  you’re not careful, much more convoluted.

int t = m.chkTemp();

if (t > 160) {

   T tb = new T();

   tb.clsTrpV(2);

   ics.Fill();

   ics.Vent();

   m.airsyschk();

}

Here’s a nice, compact chunk of  code. It’s from a control program that 
runs a machine that makes candy bars.

1

Those statements don’t give you any hints about why the code’s doing what it’s doing. In this case, the 
programmer was happy with the results because she was able to get it all into one method. But making 
your code as compact as possible isn’t really useful! Let’s break it up into methods to make it easier to 
read, and make sure the classes are given names that make sense. But we’ll start by figuring out what the 
code is supposed to do.

2

General Electronics Type 5 Candy Bar Maker 

Specification Manual

The nougat temperature must be checked every 3 minutes by an 

automated system. If  the temperature exceeds 160°C, the candy 

is too hot, and the system must perform the candy isolation 

cooling system (CICS) vent procedure.

•	 Close the trip throttle valve on turbine #2.

•	 Fill the isolation cooling system with a solid stream of  water.

•	 Vent the water.

•	 Verify that there is no evidence of  air in the system.

How do you figure out what 

your code is supposed to
 do? 

Well, all code is written for 

a reason. So it’s up to y
ou to 

figure out that reason! 
In this 

case, we can look up the page 

in the specification manual 
that the programmer followed.

Take a second and look at that code. Can you figure out what it does?

The clsTrpV() 
method has one 
parameter, but we 
don’t know what 
it’s supposed to be.

The chkTemp() method returns an integer…but what does it do?

making methods make sense

“tb”, “ics”, and “m” 
are terrible names! 
We have no idea 
what they do. And 
what’s that T class 
for?

Great developers 
write code 
that’s easy to 
understand. 
Comments can 
help, but nothing 
beats choosing 
intuitive names 
for your methods, 
classes, variables, 
and fields.
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public void DoCICSVentProcedure() {

   Turbine turbineController = new Turbine();

   turbineController.CloseTripValve(2);

   IsolationCoolingSystem.Fill();

   IsolationCoolingSystem.Vent();

   Maker.CheckAirSystem();

}

public boolean IsNougatTooHot() {

   int temp = Maker.CheckNougatTemperature();

   if (temp > 160) {

     return true;

   } else {

     return false;

   }

}

That page from the manual made it a lot easier to understand the code. It also gave us some great 
hints about how to make our code easier to understand. Now we know why the conditional test checks 
the variable t against 160—the manual says that any temperature above 160°C means the nougat 
is too hot. And it turns out that m was a class that controlled the candy maker, with static methods 
to check the nougat temperature and check the air system. So let’s put the temperature check into a 
method, and choose names for the class and the methods that make the purpose obvious.

3

You can make your code easier to read and write by thinking about 
the problem your code was built to solve. If you choose names for your
methods that make sense to someone who understands that problem, 
then your code will be a lot easier to decipher...and develop!

What does the specification say to do if  the nougat is too hot? It tells us to perform the candy isolation 
cooling system (or CICS) vent procedure. So let’s make another method, and choose an obvious name 
for the T class (which turns out to control the turbine) and the ics class (which controls the isolation 
cooling system, and has two static methods to fill and vent the system):

4

Now the code’s a lot more intuitive! Even if  you don’t know that the CICS vent procedure needs to 
be run if  the nougat is too hot, it’s a lot more obvious what this code is doing:

5

if (IsNougatTooHot() == true) {

   DoCICSVentProcedure();

}

This method’s return type is 
Boolean, which means it returns a 
true or false value.

A void return type means the method doesn’t return any value at all.

The IsNougatTooHot() 
method’s return type By naming the class “Maker” and the 

method “CheckNougatTemperature”, 
we make the code a lot easier to 
understand.
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Give your classes a natural structure
Take a second and remind yourself  why you want to make your methods intuitive: 
because every program solves a problem or has a purpose. It might not 
be a business problem—sometimes a program’s purpose (like FlashyThing) is just to 
be cool or fun! But no matter what your program does, the more you can make your 
code resemble the problem you’re trying to solve, the easier your program will be to 
write (and read, and repair, and maintain…).

CandyController

DoMaintenanceTests()
DoCICSVentProcedure()
IsNougatTooHot()

Let’s build a class diagram
Take another look at the if statement in #5 on the previous page. You already know that statements 
always live inside methods, which always live inside classes, right? In this case, that if statement was 
in a method called DoMaintenanceTests(), which is part of  the CandyController class. 
Now take a look at the code and the class diagram. See how they relate to each other?

class CandyController { 

  public void DoMaintenanceTests() {

    ...

    if (IsNougatTooHot() == true) {

       DoCICSVentProcedure();

    }

    ...

  } 

  public void DoCICSVentProcedure() ... 

  public boolean IsNougatTooHot() ... 

}

Use class diagrams to plan out your classes
A class diagram is a simple way to draw your 
classes out on paper. It’s a really valuable tool 
for designing your code BEFORE you start 
writing it.
Write the name of the class at the top of 
the diagram. Then write each method in the 
box at the bottom. Now you can see all of the 
parts of the class at a glance!

ClassName

Method()

Method()

Method()

.

.

.

classes au naturale
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t

Turbine

The code for the candy control system we built on the previous 
page called three other classes. Flip back and look through the 
code, and fill in their class diagrams.

Fill()

We filled in the class name for this one. What method goes here?

One of the classes had 
a method called Fill(). 
Fill in its class name 
and its other method.

There was one other class in the code on the previous page. Fill in its name and method.
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t

Turbine

CloseTripValve()
Fill()

IsolationCoolingSystem

Vent()

Maker

CheckNougatTemperature()

CheckAirSystem()

picture your classes

The code for the candy control system we built on the 
previous page called three other classes. Flip back and 
look through the code, and fill in their class diagrams.

Class diagrams help you organize your 
classes so they make sense
Writing out class diagrams makes it a lot easier to spot potential problems in your 
classes before you write code. Thinking about your classes from a high level before 
you get into the details can help you come up with a class structure that will make 
sure your code addresses the problems it solves. It lets you step back and make sure 
that you’re not planning on writing unnecessary or poorly structured classes or 
methods, and that the ones you do write will be intuitive and easy to use.

Dishwasher

CleanDishes()
AddDetergent()
SetWaterTemperature()
ParkTheCar()

Dishwasher

CleanDishes()
AddDetergent()
SetWaterTemperature()

The class is called 
Dishwasher, so all the 

methods should be about 
washing dishes. But one 

method—ParkTheCar()—
has nothing to do with dishes, 
so it should be taken out and 

put in another class.

You could figure out that 
Maker is a class because it 
appears in front of a dot in 
Maker.CheckAirSystem().
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v

DeliveryGuy

AddAPizza()
PizzaDelivered()
TotalCash()
ReturnTime()

Each of these classes has a serious design flaw. Write down what 
you think is wrong with each class, and how you’d fix it.

Class23

CandyBarWeight()
PrintWrapper()
GenerateReport()
Go()

These two classes are part of a system that a pizza parlor uses to 
track the pizzas that are out for delivery.

This class is part of the candy manufacturing system from earlier.

CashRegister

MakeSale()
NoSale()
PumpGas()
Refund()
TotalCashInRegister()
GetTransactionList()
AddCash()
RemoveCash()

The CashRegister class is part of a program that’s used by an 
automated convenience store checkout system.

DeliveryGirl

AddAPizza()
PizzaDelivered()
TotalCash()
ReturnTime()
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Here’s how we corrected the classes. We show just one 
possible way to fix the problems—but there are plenty of other ways 
you could design these classes depending on how they’ll be used.

create a class

CandyMaker

CandyBarWeight()
PrintWrapper()
GenerateReport()
MakeTheCandy()

These two classes are part of a system that a pizza parlor uses to 
track the pizzas that are out for delivery.

This class is part of the candy manufacturing system from earlier.

CashRegister

MakeSale()
NoSale()
Refund()
TotalCashInRegister()
GetTransactionList()
AddCash()
RemoveCash()

The CashRegister class is part of a program that’s used by an 
automated convenience store checkout system.

DeliveryPerson

Gender

AddAPizza()
PizzaDelivered()
TotalCash()
ReturnTime()

The class name doesn’t describe what the class does. A programmer 

who sees a line of code that calls Class23.Go() will have no idea what 

that line does. We’d also rename the method to something that’s more 

descriptive—we chose MakeTheCandy(), but it could be anything.

It looks like the DeliveryGuy class and the DeliveryGirl class 

both do the same thing—they track a delivery person who’s out 

delivering pizzas to customers. A better design would replace 

them with a single class that adds a field for gender.

All of the methods in the class do stuff that has to do with 

a cash register—making a sale, getting a list of transactions, 

adding cash…except for one: pumping gas. It’s a good idea to pull 

that method out and stick it in another class.

We added the Gender field because we 
assumed there was a reason to track delivery 
guys and girls separately, and that’s why 
there were two classes for them.
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x == 3
x == 4

x < 4
x < 5
x > 0
x > 1

public partial class Form1 : Form {
  public Form1() {
    InitializeComponent();
  }
  private void button1_Click(object sender, EventArgs e) {
    string result = "";

    Echo e1 = new Echo();

    _________________________

    int x = 0;

    while ( ___________ ) {

      result = result + e1.Hello() + "\n";

      __________________________

      if ( ____________ ) {

        e2.count = e2.count + 1;

      }

      if ( ____________ ) {

        e2.count = e2.count + e1.count;

      }

      x = x + 1;

    }
    MessageBox.Show(result + "Count: " + e2.count);
  }
}
class ____________ {
  public int _________ = 0;

    public string ___________ {

      return "helloooo...";
  }
}

Output

e1 = e1 + 1;
e1 = count + 1;
e1.count = count + 1;
e1.count = e1.count + 1;

e2 = e1;
Echo e2;
Echo e2 = e1;
Echo e2 = new Echo( );

x
y
e2
count

Echo
Tester
Echo( )
Count( )
Hello( )

Bonus Question!

If the last line of output was 
24 instead of 10, how would 
you complete the puzzle? 
You can do it by changing 
just one statement.

Answers on page 138.

Pool 
Puzzle
Your job is to take 
code snippets 

from the pool and 
place them into the blank 

lines in the code. You may use the same 
snippet more than once, and you won’t 
need to use all the snippets. Your goal is to 
make classes that will compile and run and 
produce the output listed. 

Note: each 
snippet from the 
pool can be used 
more than once!

There are two possible solutions to this puzzle. Can you find them both?
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Build a class to work with some guys
Joe and Bob lend each other money all the time. Let’s create a class to 
keep track of  them. We’ll start with an overview of  what we’ll build.

Guy object #
 2

Guy object #
 1

Guy

Name
Cash

GiveCash()
ReceiveCash()

The new statements 
that create the two 
instances live in the 
code that gets run as 
soon as the form is 
created. Here’s what 
the heap looks like 
after the form is 
loaded.

We’ll create a Guy class and add two instances of it to a form.
The form will have two fields, one called joe (to keep track of  the first object), 
and the other called bob (to keep track of  the second object).

1

We’ll set each Guy object’s cash and name fields.
The two objects represent different guys, each with his own name and a 
different amount of  cash in his pocket.

2

Guy object #
 2

“Bob”

50

Guy object #
 1

“Joe”

100

We’ll give cash to the guys and take cash from them.
We’ll use each guy’s ReceiveCash() method to increase a guy’s cash, 
and we’ll use his GiveCash() method to reduce it.

3

Guy object #
2

“Bob”

75

Each guy has a Name 
field that keeps track of 
his name, and a Cash field 
that has the number of 
bucks in his pocket.

When you take an instance 
of Guy and call its 
ReceiveCash() method, you 
pass the amount of cash 
the guy will take as a 
parameter. So calling bob. 
ReceiveCash(25) tells Bob 
to receive 25 bucks and 
add them to his wallet.

The form calls the object’s ReceiveCash() 
method. It’s called ReceiveCash() because 
he’s receiving the cash.

The method returns the 
number of bucks that the guy 
added to his Cash field.

working class guys

Guy object #
2

“Bob”

50 bob.ReceiveCash(25);

We chose names for the 
methods that make sense. 
You call a Guy object’s 
GiveCash() method to tell 
him to give up some of his 
cash, and his ReceiveCash() 
method when you want him 
to take some cash back. 
We could have called them 
GiveCashToSomeone() and 
ReceiveCashFromSomeone(), 
but that would have been 
very long!
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Do this!

class Guy {
    public string Name;
    public int Cash;

    public int GiveCash(int amount) {
        if (amount <= Cash && amount > 0) {
            Cash -= amount;
            return amount;
        } else {
            MessageBox.Show(
             "I don’t have enough cash to give you " + amount,
             Name + " says...");
            return 0;
        }
    }

    public int ReceiveCash(int amount) {
        if (amount > 0) {
            Cash += amount;
            return amount;
        } else {
            MessageBox.Show(amount + " isn’t an amount I’ll take",
                  Name + " says...");
            return 0;
        }
    }

}

Create a project for your guys
Create a new Windows Forms Application project (because we’ll 
be using a form). Then use the Solution Explorer to add a new 
class to it called Guy. Make sure to add “using System.
Windows.Forms;” to the top of  the Guy class file. Then fill 
in the Guy class. Here’s the code for it:

The Guy class has two fields. The Name field is 
a string, and it’ll contain the guy’s name (“Joe”). 
And the Cash field is an int, which will keep 
track of how many bucks are in his pocket.

The GiveCash() method has one parameter 
called amount that you’ll use to tell the 
guy how much cash to give you. 

He uses an if statement to check 
whether he has enough cash—if he 
does, he takes it out of his pocket and 
returns it as the return value.

The guy makes 
sure that you’re 
asking him for a 
positive amount of 
cash—otherwise, 
he’d add to his 
cash instead of 
taking away from 
it.

If the guy doesn’t have enough cash, he’ll tell you so with a message box, and then he’ll make GiveCash() return 0.

Be careful with your curly brackets. It’s easy to have the wrong number—make sure that every opening bracket has a matching closing bracket. When they’re all balanced, the IDE will automatically indent them for you when you type the last closing bracket.

The ReceiveCash() method works just like 
the GiveCash() method. It’s passed an 
amount as a parameter, checks to make 
sure that amount is greater than zero, 
and then adds it to his cash.

If the amount was positive, then the 
ReceiveCash() method returns the amount 
added. If it was zero or negative, the guy 
shows a message box and then returns 0.

What happens if you pass a 
negative amount to a Guy object’s 
ReceiveCash() or GiveCash() method?
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Build a form to interact with the guys
The Guy class is great, but it’s just a start. Now put together a form that uses two 
instances of  the Guy class. It’s got labels that show you their names and how much cash 
they have, and buttons to give and take cash from them. They have to get their money 
from somewhere before they can lend it to each other, so we’ll also need to add a bank. Build this!

Add two buttons and three labels to your form.
The top two labels show how much cash each guy has. We’ll also add a field called bank to the 
form—the third label shows how much cash is in it. We’re going to have you name some of  the 
labels that you drag onto the forms. You can do that by clicking on each label that you want 
to name and changing its “(Name)” row in the Properties window. That’ll make your code a 
lot easier to read, because you’ll be able to use “joesCashLabel” and “bobsCashLabel” instead of  

“label1” and “label2”.

1

Add fields to your form.
Your form will need to keep track of  the two guys, so you’ll need a field for each of  them. Call 
them joe and bob. Then add a field to the form called bank to keep track of  how much money 
the form has to give to and receive from the guys.

namespace Your_Project_Name {

    public partial class Form1 : Form {

 
        Guy joe;

        Guy bob;

        int bank = 100;

 
        public Form1() {

            InitializeComponent();

        }

2

Since we’re using 
Guy objects to 
keep track of 
Joe and Bob, 
you declare 
their fields in 
the form using 
the Guy class.

The amount of cash in the form’s bank 
field goes up and down depending on how much money the form gave to and received from the Guy objects.

Name the top label 
joesCashLabel, the label 
underneath it bobsCashLabel, and the bottom label 
bankCashLabel. You can 
leave their Text properties 
alone; we’ll add a method to 
the form to set them.

This button will call 
the Joe object’s 
ReceiveCash() method, 
passing it 10 as 
the amount, and 
subtracting from the 
form’s bank field the 
cash that Joe receives.

This button will call the Bob 
object’s GiveCash() method, 
passing it 5 as the amount, and 
adding the cash that Bob gives 
to the form’s bank field.

joe says, “where’s my money?”
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Add a method to the form to update the labels.
The labels on the righthand side of  the form show how much cash each guy has and how much 
is in the bank field. So add the UpdateForm() method to keep them up to date—make sure 
the return type is void to tell C# that the method doesn’t return a value. Type this method 
into the form right underneath where you added the bank field:

    public void UpdateForm() {

        joesCashLabel.Text = joe.Name + " has $" + joe.Cash;

        bobsCashLabel.Text = bob.Name + " has $" + bob.Cash;

        bankCashLabel.Text = "The bank has $" + bank;

    }

3

Double-click on each button and add the code to interact with the objects.
Make sure the lefthand button is called button1, and the righthand button is called button2. 
Then double-click each of  the buttons—when you do, the IDE will add two methods called 
button1_Click() and button2_Click() to the form. Add this code to each of  them:

    private void button1_Click(object sender, EventArgs e) {

        if (bank >= 10) {

            bank -= joe.ReceiveCash(10);

            UpdateForm();

        } else {

            MessageBox.Show("The bank is out of money.");

        }

    }

    private void button2_Click(object sender, EventArgs e) {

        bank += bob.GiveCash(5);

        UpdateForm();

    }

4

The “Receive $5 from Bob” button 
doesn’t need to check how much is 
in the bank, because it’ll just add 
whatever Bob gives back. If Bob’s out of money, 

GiveCash() will return zero.

When the user clicks the “Give $10 to Joe” button, the form calls the Joe object’s ReceiveCash() method—but only if the bank has enough money.

The bank needs at least $10 to give to 
Joe. If there’s not enough, it’ll pop up 
this message box.

This new method 
is simple. It just 
updates the three 
labels by setting 
their Text properties. 
You’ll have each 
button call it to keep 
the labels up to date.

Start Joe out with $50 and start Bob out with $100.
It’s up to you to figure out how to get Joe and Bob to start out with their Cash and 
Name fields set properly. Put it right underneath InitializeComponent() in the form. 
That’s part of  that designer-generated method that gets run once, when the form is first initialized.
Once you’ve done that, click both buttons a number of  times—make sure that one button takes 
$10 from the bank and adds it to Joe, and the other takes $5 from Bob and adds it to the bank.

    public Form1() {
         InitializeComponent();

         // Initialize joe and bob here!

     }

5

Add the lines of code here to create the two objects and set their Name and Cash fields.

Notice how the labels
are updated using the
Guy objects’ Name and
Cash fields.

You already 
know that 
you can 
choose 

names for 
controls. 

Are 
button1 

and 
button2 
really the 

best names 
we can find? 
What names 
would you 

choose 
for these 
buttons?
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Make sure you save the 
project now—we’ll come 
back to it in a few pages.

It’s up to you to figure out how to get Joe and Bob to start out with their Cash and 
Name fields set properly. Put it right underneath InitializeComponent() in the 
form.

public Form1() {
    InitializeComponent();

    bob = new Guy();
    bob.Name = "Bob";
    bob.Cash = 100;

    joe = new Guy();
    joe.Name = "Joe";
    joe.Cash = 50;

    UpdateForm();
}

Here’s where we set up the first 
instance of Guy. The first line 
creates the object, and the next 
two set its fields.

Q: Why doesn’t the solution start with “Guy bob = new 
Guy()”? Why did you leave off the first “Guy”?

A: Because you already declared the bob field at the top of the 
form. Remember how the statement “int i = 5;” is the same 
as the two statements “int i” and “i = 5;”? This is the same 
thing. You could try to declare the bob field in one line like this: 

“Guy bob = new Guy();”. But you already have the first 
part of that statement (“Guy bob;”) at the top of your form. So 
you only need the second half of the line, the part that sets the bob 
field to create a new instance of Guy().

Q: OK, so then why not get rid of the “Guy bob;” line at 
the top of the form?

A: Then a variable called bob will only exist inside that special 
“public Form1()” method. When you declare a variable 
inside a method, it’s only valid inside the method—you can’t access 
it from any other method. But when you declare it outside of your 
method but inside the form or a class that you added, then you’ve 
added a field accessible from any other method inside the form.

Q: What happens if I don’t leave off that first “Guy”? What if 
it’s Guy bob = new Guy() instead of bob = new Guy()?

A: You’ll run into problems—your form won’t work, because it 
won’t ever set the form’s bob variable. If you have this code at the 
top of your form: 
 
   public partial class Form1 : Form { 
      Guy bob; 
 
and then you have this code later on, inside a method: 
 
   Guy bob = new Guy(); 
 
then you’ve declared two variables. It’s a little confusing, because 
they both have the same name. But one of them is valid throughout 
the entire form, and the other one—the new one you added—is only 
valid inside the method. The next line (bob.Name = "Bob";) 
only updates that local variable, and doesn’t touch the one in the 
form. So when you try to run your code, it’ll give you a nasty error 
message (“NullReferenceException not handled”), which just means 
you tried to use an object before you created it with new.

Then we do the same for the 
second instance of the Guy class.

Make sure you call UpdateForm() so 
the labels look right when the form 
first pops up.

exercise solution
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There’s an easier way to init ialize objects
Almost every object that you create needs to be initialized in some way. 
And the Guy object is no exception—it’s useless until you set its Name 
and Cash fields. It’s so common to have to initialize fields that C# gives 
you a shortcut for doing it called an object initializer. And the IDE’s 
IntelliSense will help you do it.

joe = new Guy();
joe.Name = "Joe";
joe.Cash = 50;

joe = new Guy() { Cash = 50, Name = "Joe" };

joe = new Guy() { 

joe = new Guy() { Cash = 50,

Delete the second two lines and the semicolon after “Guy(),” and add a right curly bracket.2

Here’s the original code that you 
wrote to initialize Joe’s Guy object.

1

Press space. As soon as you do, the IDE pops up an IntelliSense window that shows you all of  
the fields that you’re able to initialize.

3

joe = new Guy() { Cash = 50
Press Tab to tell it to add the Cash field. Then set it equal to 50.4

Type in a comma. As soon as you do, the other field shows up.5

Finish the object initializer. Now you’ve saved yourself  two lines of  code!6

Object initializers 
save you time and 
make your code 
more compact 
and easier to 
read…and the 
IDE helps you 
write them.

This new declaration does exactly the same 
thing as the three lines of code you wrote 
originally. It’s just shorter and easier to read.

joe = new Guy() { 

You used an object 
initializer in your 

“Save the Humans” 
game. Flip back and 

see if  you can spot it!
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Navigator obj
e c

tbestRoute

obj Object

myInst

±  �You’re building your program to solve a problem.  
Spend some time thinking about that problem. Does it break down into pieces 
easily? How would you explain that problem to someone else? These are good 
things to think about when designing your classes.

A few ideas for designing intuitive classes

±  �What real-world things will your program use? 
A program to help a zookeeper track her animals’ feeding schedules might have 
classes for different kinds of food and types of animals.

±  �Use descriptive names for classes and methods. 
Someone should be able to figure out what your classes and methods do just by 
looking at their names.

±  �Look for similarities between classes. 
Sometimes two classes can be combined into one if they’re really similar. The candy 
manufacturing system might have three or four turbines, but there’s only one 
method for closing the trip valve that takes the turbine number as a parameter.

It’d be great if I 
could compare a few 

routes and figure out 
which is fastest...

BlockedRoad
Name
Duration

FindDetour()

ClosedRoad
StreetName
ReasonItsClosed

CalculateDelay()

Detour
Name
Duration
ReasonItsClosed

FindDetour()
CalculateDelay()

a few helpful tips
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Use an object initializer to initialize Bob’s 
instance of Guy.
You’ve already done it with Joe. Now make Bob’s instance work with an object 
initializer too.

1

Add two more buttons to your form.
The first button tells Joe to give 10 bucks to Bob, and the second tells Bob to give 5 
bucks back to Joe. Before you double-click on the button, go to the Properties 
window and change each button’s name using the “(Name)” row—it’s at the top of  
the list of  properties. Name the first button joeGivesToBob, and the second one 
bobGivesToJoe.

2

This button tells Joe to 
give 10 bucks to Bob, so 
you should use the “(Name)” 
row in the Properties 
window to name it 
joeGivesToBob.

This button tells Bob to give 5 bucks to Joe. Name it bobGivesToJoe.

Make the buttons work.
Double-click on the joeGivesToBob button in the designer. The IDE will add a 
method to the form called joeGivesToBob_Click() that gets run any time the 
button’s clicked. Fill in that method to make Joe give 10 bucks to Bob. Then double-
click on the other button and fill in the new bobGivesToJoe_Click() method 
that the IDE creates so that Bob gives 5 bucks to Joe. Make sure the form updates itself  
after the cash changes hands.

3

Add buttons to the “Fun with Joe and Bob” program to make the guys give each other cash.

If you already clicked the button, just delete it, add it back to your form, and rename it. Then delete the old button3_Click() method that the IDE added before, and use the new method it adds now.

Here’s a tip for designing your forms. You can use these buttons on the IDE’s 
toolbar in the form designer to align controls, make them equal sizes, space 

them evenly, and bring them to the front or back.
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exercise solution

Add buttons to the “Fun with Joe and Bob” program to make the guys give each other cash.

public partial class Form1 : Form {
    Guy joe;
    Guy bob;
    int bank = 100;

    public Form1() {
        InitializeComponent();
         bob = new Guy() { Cash = 100, Name = "Bob" };
        joe = new Guy() { Cash = 50, Name = "Joe" };
         UpdateForm();
    }

    public void UpdateForm() {
        joesCashLabel.Text = joe.Name + " has $" + joe.Cash;
        bobsCashLabel.Text = bob.Name + " has $" + bob.Cash;
        bankCashLabel.Text = "The bank has $" + bank;
    }

    private void button1_Click(object sender, EventArgs e) {
        if (bank >= 10) {
            bank -= joe.ReceiveCash(10);
            UpdateForm();
        } else {
            MessageBox.Show("The bank is out of money.");
        }
    }

    private void button2_Click(object sender, EventArgs e) {
        bank += bob.GiveCash(5);
        UpdateForm();
    }

    private void joeGivesToBob_Click(object sender, EventArgs e) {
        bob.ReceiveCash(joe.GiveCash(10));
        UpdateForm();
    }

    private void bobGivesToJoe_Click(object sender, EventArgs e) {
        joe.ReceiveCash(bob.GiveCash(5));
        UpdateForm();
    }

}

Here are the object initializers for the two instances of the Guy class. Bob gets initialized with 100 bucks and his name.

The trick here is 
thinking through 
who’s giving the 
cash and who’s 
receiving it.

Take a close look at 
how the Guy methods 
are being called. The 
results returned 
by GiveCash() are 
pumped right into 
ReceiveCash() as its 
parameter.

To make Joe give cash 
to Bob, we call Joe’s 
GiveCash() method and 
send its results into 
Bob’s ReceiveCash() 
method.

Before you go on, take a minute and flip to #2 in the “Leftovers” appendix, 
because there’s some basic syntax that we haven’t covered yet. You won’t 
need it to move forward, but it’s a good idea to see what’s there.
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Objectcross
It’s time to give your left brain a break, and put that 
right brain to work: all the words are object‑related 
and from this chapter.

1

2 3 4 5 6

7

8 9

10

11

12

13

14 15

Across

2. If a method's return type is _____, it doesn't return 
anything.
7. An object's fields define its _______
9. A good method __________ makes it clear what the 
method does.
10. Where objects live
11. What you use to build an object
13. What you use to pass information into a method
14. The statement you use to create an object
15. A special kind of field that's used by the form 
controls

Down

1. This form control lets the user choose a number 
from a range you set.
3. It's a great idea to create a class ________ on paper 
before you start writing code
4. What an object uses to keep track of what it knows
5. These define what an object does
6. An object's methods define its ________
7. Don't use this keyword in your class declaration if 
you want to be able to create instances of it
8. An object is an ______________ of a class
12. This statement tells a method to immediately exit, 
and specifies the value that should be passed back to 
the statement that called the method.

Across 

2. If a method’s return type is _____, it doesn’t return anything

7. An object’s fields define its _______ 

9. A good method __________ makes it clear what the method 
does

10. Where objects live 

11. What you use to build an object 

13. What you use to pass information into a method 

14. The statement you use to create an object 

15. Used to set an attribute on controls and other classes 

Down 

1. This form control lets the user choose a number from a range 
you set

3. It’s a great idea to create a class ________ on paper before 
you start writing code 

4. An object uses this to keep track of what it knows 

5. These define what an object does 

6. An object’s methods define its ________ 

7. Don’t use this keyword in your class declaration if you want to 
be able to create instances of it 

8. An object is an ______________ of a class 

12. This statement tells a method to immediately exit, and can 
specify the value that should be passed back to the statement 
that called the method
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public partial class Form1 : Form {
  public Form1() {
    InitializeComponent();
  }
  private void button1_Click(object sender, EventArgs e) {
    string result = "";

    Echo e1 = new Echo();

    _________________________

    int x = 0;

    while ( ___________ ) {

      result = result + e1.Hello() + "\n";

      __________________________

      if ( ____________ ) {

        e2.count = e2.count + 1;

      }

      if ( ____________ ) {

        e2.count = e2.count + e1.count;

      }

      x = x + 1;

    }
    MessageBox.Show(result + "Count: " + e2.count);
  }
}
class ____________ {
  public int _________ = 0;

    public string ___________ {

      return "helloooo...";
  }
}

puzzle solutions

That’s the correct answer.

And here’s the bonus answer!

Pool Puzzle Solution
Your job was to take code snippets from 

the pool and place them into the 
blank lines in the code. Your goal 
was to make classes that will 
compile and run and produce the 
output listed. 

Echo e2 = new Echo();

x < 4

e1.count = e1.count + 1;

x > 0

x ==3

Echo
count

Echo e2 = e1;

Hello()

The alternate solution has 
this in the fourth blank:

x == 4
and this in the fifth:

x < 4
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N
1

U

M V
2

O I D
3

F
4

M
5

B
6

E I I E S
7

T A T E

R I
8

N
9

A M E T T H

I N G L H
10

E A P A

C
11

L A S S R D O T V

U T A R
12

D I I

P P
13

A R A M E T E R S C O

D N T R

O C U

W N
14

E W P
15

R O P E R T Y

N N

Across

2. If a method's return type is _____, it doesn't return 
anything. [void] 
7. An object's fields define its _______ [state] 
9. A good method __________ makes it clear what the 
method does. [name] 
10. Where objects live [heap] 
11. What you use to build an object [class] 
13. What you use to pass information into a method 
[parameters] 
14. The statement you use to create an object [new] 
15. A special kind of field that's used by the form 
controls [property] 

Down

1. This form control lets the user choose a number 
from a range you set. [numericupdown] 
3. It's a great idea to create a class ________ on paper 
before you start writing code [diagram] 
4. What an object uses to keep track of what it knows 
[field] 
5. These define what an object does [methods] 
6. An object's methods define its ________ [behavior] 
7. Don't use this keyword in your class declaration if 
you want to be able to create instances of it [static] 
8. An object is an ______________ of a class 
[instance] 
12. This statement tells a method to immediately exit, 
and specifies the value that should be passed back to 
the statement that called the method. [return] 

Objectcross Solution
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